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General Information

Welcome

Thank you for choosing a WAVECOM decoder product. The product that you have purchased includes the
latest technology in data decoding, together with the latest software release available at the time of ship-
ment.

Please check our website at http://www.wavecom.ch for software updates.

Before you install the product, please also check the latest documentation on the installation DVD or on
our website.

Wavecom Elektronik AG develops and sells products for wireless (HF/VHF/UHF/SHF) data decoding and
monitoring in all frequency bands.

Two decoder families are currently available:
e W-PCI and W-PClIe are decoder hardwares with two physically independent channels.

W74PC is a hardware decoder with four physically independent channels. The decoder software W-
CODE supports all these three hardwares.

W-CODE works also as a stand-alone application with native host hardware, like the built-in
soundcard or other audio devices.

e W61PC/W61LAN consists of hardware (e.g., W61PC, W61LAN) and corresponding, integral soft-
ware (no additional order of the software required).

Revisions
Version Date Changes
Beta 20-Dec-2005 Initial draft.
6.3.00 15-Jan-2006 CMH files, index, installation.
6.4.00 15-Jul-2006 New protocols:
- PSK-AM
- MIL-188-110-16Tone
- CIs-12
- PACTOR-III
- CLOVER-2
- CLOVER-2000
- CODAN-9001
Improvements and modifications:
HF PSK CODE CHECK.
HF MFSK CODE CHECK.
HF CLASSIFIER CODE CHECK.
Tuning FFT.
Installation for PACTOR-III/CODAN/CLOVER Modes.
6.4.00 25-Aug-2006 W51PC added.
6.4.01 4-Oct-2006 W61LAN added.
6.4.02 4-Oct-2006 ServerControl.
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http://www.wavecom.ch/

Version Date b

6.5.00 27-Apr-2007 New protocols:

- PACTOR-FEC

- Cv-786

- MD-674

- MIL-M-55529a

- MOBITEX-1200

- VISEL

- STANAG-5066
Improvements and modifications:
Inputs added (streaming and user inputs).

Passband tuning added.

6.6.00 23-Jan-2008 New protocols:

-  CHU

- DZVEI

- MIL-188-110-39Tone

- MOBITEX-1200

- MODAT

- NWR-SAME

- PCCIR

- PDZVEI

- PZVEI

- SAT-AERO (Aero-I)

- ZVEI-3

- Stanag-5065-FSK
Improvements and modifications:
WS51PC removed.
ATIS changed.
New chapter: WAVECOM TCP/IP Data File Format.
WiNRADIO Setup.
Time cursors in sonagram.

New manual layout.

6.6.5.0 2-Jul-2008 New protocols:
- OLIVIA
- BIIS-1200
Improvements and modifications:

Chapter: Professional version removed, as in the feature only one version is availa-
ble.

Phase plane “Sync/Async” replaced with “IQ demodulator”.

"BITS" replaced by "BINARY" in ALF-RDS, CODAN 9001, INMARSAT-A, MIL188-
110A, -B, -16Tone, -39Tone, MIL 188-141B, STANAG 4285, -4415, -4529.

"RAW" replaced by "HEX" in CIS36-50, CIS50-50,GW-FSK, GW-PSK, VISEL.
STANAG4529 default center frequency changed to 1700 Hz.
W-CODE added.
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Version Date b

CodeMeter added.

6.6.60 22-Jan-2009 New protocols:
- SAT-B-C-TFC
- Robust Packet Radio
- ORBCOMM
Improvements and modifications:
User Manual split into a W-CODE and W-61 Manual.
FAX and Modem added.
SAT-AERO improved.
User defined alphabets added.

Sample Rate Fine tuning added.

6.6.70 14-Mai-2009 New protocols:

- FAX-G3-V.17

- FAX-G3-V.27ter
- FAX-G3-V.29

- FAX-G3-V34hdx
- V.21, BELL103
- V.22 /V.22bis, BELL212A
- V.23

- V.26 / V.26bis

- V.32 /V.32bis

- V.34

- V.90

- V.92

- ALE-400 added

- Alternative Modes for CODAN-9001 (W-CODAN-9001), CLOVER-2 (W-
CLOVER-2) and CLOVER-2000 (W-CLOVER-2000).

Improvements and modifications:

“Modems” modes added (incl. new “Modem Settings...” and “*Modem Input File...”
options):

OSI-Level removed.

MIL-STD mode tuning changed.

OLIVIA changed.

PACTOR-II: AFC £ 50 Hz, additional frame type detection, HEX (Binary output).
Sonagram added to FFT tuning window.

FFT and Sonagram tuning parameter moved from options to the new context menu.
“Pause Graphic” option for the sonagram tuning view.

Passband display shows additional tuning information (shift mark, space frequency)
in a tooltip box, if the mouse is move over the cursors.

Number of “Custom Alphabets” and “Custom Inputs” limited to 16.

“Message Type” dialog box. New parameter for Parity (MARK and SPACE).

“Message Type” dialog box. Display format ™ ITA5” and “"ASCII” merged to “ITA5
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(ASCII)".

WAVECOM Data File Format, additional information added.
Added: List of checked modes with FSK Code Check.

Name of ROBUST-PACKET-RADIO changed to ROBUST-PACKET.

Changed license manager.

6.8.00 15-Nov-2009 New protocols:

- VDL-M2
NMT-450 Center in the documentation changed to 1500 Hz.
BIIS-1200 renamed to BIIS.
CODAN-9001: LSR initialization changed from binary to hex.
CLOVER-2 and CLOVER-2000, “CRC Recognition” added.
Binary Output of PACTOR-I and PACTOR-II enhanced.
MIL-39T enhanced.
CIS-36-50, CIS-50-50 enhanced.
AIS enhanced.
CW improved.
New installation software.

XML: customer inputs configuration improved.

6.8.1 17-Mar-2010 New protocols:
- DMR: New digital, TDMA based mobile radio mode.

- W-CODE: Media Player/Recorder: This tool records signals directly to WAV-
files from the host sound card inputs. During playback of WAV files the sig-
nal is sent unprocessed to the W-CODE and a monitoring signal is played
through the sound card.

- PSK-63, -125: Now independent amateur radio modes implementing the
FLARQ emergency messaging protocol.

- PSK-250: New amateur radio modes implementing the FLARQ protocol.
- VDL-M2: New digital, aeronautical data link mode.

- W-PACTOR-III: Initial release of WAVECOM'’s implementation of PACTOR-
III.

- IP-PXGF TCP/IP streaming data format added.
Improvements and modifications:

- Installation: The procedure has been greatly improved and simplified, an
option to delete all settings before re- or new installation added.

- CHU: Polarity now manually selected.
- CW: New, much improved demodulator will decode speeds up to 90 wpm.

- AIS: New “Inland AIS” interpretations of standard AIS message fields add-
ed. Standard AIS, Inland AIS, St. Lawrence Seaway and PAWSS AIS binary
message decoding added.

- Baudot: Reworked decoder with improved polarity detection and enhanced
performance.

- PACTOR-I, PACTOR-II: ASCII Ox1E (idle) removed from hex output.

- W-CODAN-9001: Output of demodulated multichannel symbols, de-
randomization of secure and unsecure modes, user selectable key for de-
randomization of secure modes, output of recognized key in secure mode,
output of status information, output of recognized frame type, decoding of
chat messages into readable output, decoding of text files into readable
output, decoding of data into hex output.

- W-CLOVER-2, -2000: “CRC recognition” changed to “Display Mode” for se-
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lection of error-free frames or all frames. Option for user defined table of
CRC added.

- MIL-141A, CODAN-9001: Improved performance for Golay (24, 12) decod-
er.

- MIL-39T: Display formats "ASCII” and “ITA-5" merged.

- CIS-36-50, CIS-50-50: More fault-tolerant start and stop criteria, automat-
ic default to Letter Shift after idle or a longer sequence of invalid data, syn-
chronization to valid 3:4 characters without need for preamble.

- DTMF: Character set changed (“*” and “#"” replaces “E” and “F").

- COQUELET-S8, -13, -80: Bar graph range corrected.

- STANAG, MIL modes: ITA-2 “U” character now printed.

- FMS-BOS settings added to documentation.

7.0.00 24-Nov-2010 New protocols:

- dPMR

- X.25

- TETRA

Improvements and modifications

- GUI, toolbars, menus etc. changed.

- Wideband classifier (bandwidth 96 kHz).

- Adjustable “Classifier Code Check” with XML table lookup.

- Classifier Code Check Table Editor.

- CODAN-9001 extended with "Compressed Data” and “Secure Interactive
Packets” decoding. CODAN-9001 documentation extended.

- SR Calibration added.

- “SAT Translation Frequency Tuning Bar” changed to “SAT Frequency Tuning
Bar” and new functions added.

- PSK-mode tuning window cursors are now merged into one, single cursor.

- Application notes removed from the user manual into separate documents
(available from www.wavecom.ch).

- BR-6028 is now a mode and no longer a demodulator.

- CRC tables are changed from “\Config\CRCTABLE.TXT" to
"\Config\CRCTable.xml".

- Source code chapter removed (as the source is no longer available).

- INMARSAT-A and METEOSAT removed.

- Notation of "Translation frequency” changed to “Offset frequency”.

- Notation of "INDIR” changed to “"SUB".

- VDL-M2, "Display-Mode” added.

- AMSAT-P3D: The file "famsatp3d.raw” is no longer available.

- Translation frequency replaced with offset frequency.

- CW AFC: ON/OFF.

- Automatic detection of the “Display Mode” for MIL-STD and STANAG sig-
nals.

7.1.00 13-Apri-2011 - New WAVECOM install tool.

- License Key no longer required for W61PC Professional version (but still
requiered for the SAT and Classifier options).

- W-CODE no longer supports MEDAV PACTOR-3, CLOVER-2000, CLOVER-2

and CODAN-9001.
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- APCO25 added.
- W-CODE: Name of SAT-Option and Classifier-Option changed.

7.2.00 27-Jul-2011 - GW-OFDM protocol added.
- LINK-11 protocol added.

- SAT protocols, CLOVER2/2000, CODAN9001, PACTOR-III require no longer
an additional optional license. All functions are now contained in the W-
CODE or W61PC license.

- Better support of russian Windows (custom inputs).

- Wideband-Classifier works with VHF/UHF SUB Signals.
- Wideband-Classifier works with VHF/UHF DIR Signals.
- PxGF float support.

- FSK Code Check SUB uses always the FM demodulator.
- Classifier Code Check (CCC) VHF/UHF Direct added.

- Classifier Code Check (CCC) VHF/UHF Sub added.

- W-CODE: “"Modem and Fax input file settings” removed. Direct support for
two analog input channels (stereo) added.

- W-Sat-email-Decoder requres a dedicated license.

7.3.00 12-Sept-2011 - VHF/UHF Classifier Codecheck DIR and SUB merged into one.
7.4.00 11-Nov-2011 - Incorporate W-PCI and W-PCIe hardware into W-CODE.
8.0.00 06-Dec-2011 - Enable voice classification in VHF/UHF Classifier Codecheck.

- Official launch of W-PCI and W-PCle.

8.1.00 23-Apr-2012 - New mode: NXDN (demodulated symbol).

- Add a switch “output-demod-symbol” with “on” and “off” to output the bit-
stream directly after the demodulator. This parameter also added into XML
interface.

- STANAG-4285 has a demodulated symbol output for further analyze in W-
BitView Tool.

- STANAG-4285 center frequency search extended to +/- 160 Hz and various
improvements.

- Rename “IAS Bitstream Output” to “"Demodulated Bitstream Output”.
- Rename “translation” to “offset” in XML interface.
- Add “display-mode” to Pactor in XML interface.

- Various improvements and bug-fixes.

8.2.00 01-Jan-2013 - New modes: CHINESE 4+4.

- New option W-CLOUD: Signal monitoring and decoding based on genuine,
encrypted IQ signal over large geographical distance.

- Classifier narrowband (CL-NB) extended to BW 48 kHz for VHF/UHF and
SAT bands.

8.3.00 01-Jun-2013 - W-CLOUD supports streaming IQ signal over VSC (Virtual Sound Card) of
WINRADIO.

- GW-OFDM mode totally revised and improved.
- NXDN live voice output.

- New FFT and Sonagram display settings with “Base level”, "Range” and
“FFT length”.

- XML interface extension regarding W-CLOUD devices.
- Correction in ORBCOMM decoding position and speed data.
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8.4.00 15-Nov-2013 - Wavecom Virtual Audio Cable (W-VAC) introduced into Media Player / Re-
corder, to record signal from a Wavecom hardware input device (W-PCI, W-
PCle and W-CLOUD).

- Dedicated phase plane for MIL/STANAG modes to show the PSK signal be-
fore and after the equalizer.

- MIL-188-110A can now be synchronized on the probe: on-going synchroni-
zation.

- DMR has a bit-transparent output (Options -> Message Type).
- XML RCI extension: add commands to retrieve CCC mode table.

- XML RCI extension: classifer result message is delivered in a better struc-
ture. Details refer to XML RCI Manual.

8.5.0 15-March-2014 - New mode MIL-188-110A-MOD.
- New modes THROB and THROBX.

- Significant enhancement of DMR: both slots are decoded. Full monitoring
especially of communication with a base station.

- Bit transparent output for dPMR (Options -> Message Type).

- XMLTestGUI.exe is released in XML RCI SDK for user to run W-CODE with-
out Wavecom GUI.

- General improvements and bug fixes.

8.5.1 03-June-2014 - New identity for Wavecom hardware decoders. W74PC, W-PCI and W-PCIe
appear with their own logo. W74PC, W-PCI and W-PClIe run with an in-card
license. The USB dongle license is no longer necessary.

8.6.0 03-Nov-2014 - TETRA SNDCP output.
- New mode CLOVER-2500.

- INMARSAT-MINI-M now supports HSD (M4): SAT-B-C-HSD and SAT-mM-C-
HSD.

- Enhancement of PACTOR-I: all connect frames and free signals are decod-
ed.

- Enhancement of PACTOR-II and PACTOR-III: able to decode encrypted
connections.

8.7.0 16-May-2015 - SAT-Aero modes: SAT-AERO-P, SAT-AERO-C, SAT-AERO-R and SAT-AERO-
T.

- DMR revisited: two new SYNC types according to ETSI TS 102 361-1 vV2.1.1
(2012-4). Protocol Tier I, II and III update according to ETSI TS.

- Improve the “Device Selector” GUI for HW decoder. Add “License Edit” but-
ton.

- Add “live-sound-mute” parameter (for DMR, dPMR modes etc.) into XML
RCI interface.

- Custom input supports VITA-49 protocol.

- General improvements and bug fixes.

8.8.0 10-Feb-2016 - Revision MIL-188-141B.

- General revision of most MIL / STANAG modes.

- Soft decision in MFSK-8 and MFSK-16 modes. Display “Confidence”.

- Phase Plane extension: display trace between two neighbour symbols.
- Voice session saved in NXDN mode.

- Enhanced ACARS protocol interpreter.

- New XML message indicating the release version number, e.g., 8.8.0.

- New XML message “License error: Selected mode is not licensed for the se-
lected device” when calling VHF/UHF CCC without proper license. This is on-
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ly available in W-CODE.
Wibu SD card as new license carrier. USB dongle (CmStick/C) still available.

9.0.0 03-Oct-2016 New mode PACTOR-4.
New mode TETRAPOL.
70 MHz IF input of Wavecom hardware decoders W-PCI, W-PCIe and
W74PC also available for HF/VHF/UHF mode groups.
Input bits to vocoder saved in a separate file for TETRA, DMR, dPMR, APCO-
25 and NXDN decoders.
Implement power efficiency for Wavecom hardware decoders.

9.1.0 04-Aug-2017 Release compatible to Windows 10.
New mode CODAN-3212.
Significant extension of TETRAPOL protocol interpreter.
Significant improvement in TETRAPOL demodulation, using soft-decision.
The demodulated symbols are visualized in the phase plane.
TETRAPOL signal can be detected by the Classifier Codecheck (CCC).
Additional tuning cursor (with 8 cursors) in FFT and sonagram for multi-
tone signal analysis.

9.2.0 08-Jan-2018 Simultaneous dual channel decoding on the hardware decoder W-PCI and
W-PCle.
New mode CODAN-CHIRP.
CODAN-9001 extended with CODAN-3212 compatibility mode.
CODAN-CHIRP can be classified and recognized by the Classifier-
Codecheck.

9.3.0 20-March-2018 TETRAPOL voice decoding with live voice output to the speaker for real-time
monitoring purpose. Each voice session is additionally saved in a wav file.
TETRAPOL voice frame bits saved in a txt file, for further analysis when the
voice is encrypted.
TETRAPOL overall decoding significantly improved, using optimal soft de-
coding.
Phase plane available for CODAN-9001.
Extension in DMR: Idle data is displayed.
Message Type “Data Frames Only”, “Voice Frames Only” and “Data & Voice
Frames” for TETRAPOL.

10.0.0 06-March-2019 Substantial improvement of TETRAPOL, using optimal soft ML decoding for
data and voice frames. Improve the voice quality.
Significant improvement of the equalizer in Codan-9001 (Codan compatibil-
ity mode).
Significant improvement of QAM decoding in MIL-188-110B and Codan-
3212.
Integrate the Spectrum Analysis tool into FFT and FFT/Sonagram display.
This option finds signals in the display bandwidth with the key parameters
and delivers the results on XML interface. The result can be saved in an
XML file as well.
CHN4+4 has the default center 1800 Hz.

10.1.0 11-Feb-2020 New mode FT8.

Display time stamp resolution extended to 1 ms.
Improve anti-disperse filter in MIL-188-110A and STANAG-4285 decoders.
Add "MUAN - SOUTH KOREA" station into HF-ACARS table.
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- Improvement in TETRAPOL and DMR.

- Improve Spectrum Analysis (W-SA) module.

10.2.0 04-March-2021 - Dual instance decoding is running for W74PC card.
- DMR with “Symbol Plane Display”.

- TETRAPOL: each frame is displayed with a time-stamp at the time of decod-
ing. With this method we can verify that 50 frames are decoded each sec-
ond.

11.0.0 12-May-2022 - Decryption capability in NXDN (Scrambling, DES and AES).

- Decryption capability in DMR based on Motorola MOTOTRBO series (Basic,
Enhanced ARC-4 and Advanced AES-256).

- Phase plane display implemented in APCO-25.

- Symbol plane display implemented in dPMR and NXDN.

- Real timestamp display in DMR and TETRAPOL can be switched on / off.
- Revision Wavecom Classifier.

- Improve DMR decoding and extend its protocol implementation.

11.1.0 23-Feb-2023 - Complete DMR decryption capability with Basic, ARC-4 and AES-256.
- Extend DMR data protocol decoding.

- Revise TETRA demodulator, using soft decision demodulation.

- Add “Phase Plane” display in TETRA decoder.

- Extend Classifier Codecheck (CCC) Table Editor.

- Extend wideband classifier (W-CL-WB): classify DMR, dPMR and NXDN sig-
nals as 4-Level FSK. These signals can also be detected in Classifier Co-
decheck (CCC).

- General review on TETRAPOL. Improve voice decoding.

- TETRA and TETRAPOL signals can be detected by the wideband classifier
(W-CL-WB) and Classifier Codecheck (CCC).

12.0.0 30-Jan-2024 - General review on the wideband classifier (W-CL-WB).

- Improve AM, FM, USB and LSB voice classification. Output the demodulated
voice live to the speaker when the signal is detected.

14.0.0 18-March-2025 - New mode LINK-11-SLEW (Serial Tone Link Eleven Waveform).

- Review HFDL (HF-ACARS): Add Confidence, Center and Phase Plane Dis-
play. "Data Rate” and “Slot Length” move to one GUI display. Display frame
with CRC error - dump all bytes.

- Display details (airline name, airport name and country code, name etc.) on
Airline Code, Airport and Aircraft Registration in the modes HFDL (HF-
ACARS), VDL-M2 and ACARS.

- Add Confidence, Carrier Frequency in VDL-M2 mode.
- Display “Data Rate” in ROBUST-PACKET as in MIL-188-110A.

Recommended WAVECOM Products and Services
W-BV BitView Tool

The highly sophisticated BitView Tool is an external off-line, stand-alone .NET application for analysis of
unknown signals.

BitView has a number of features:
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Bit manipulation tools

Bit display tools (text, graphics)

Simultaneous processing of multiple analysis sessions
Auto-update functionality

Report generator (parameters, data, ASCII, XML)

Drag and drop of functions

Re-arrangement of functions in a tree view

Nested docking

Auto hide

Drag and drop of windows

Application and modification of alphabets

Persistent-to-XML file (screen layout is restored at start-up time)
.NET technology

No installation required, just run the executable

Data stream and data file import from W61PC/LAN, W74PC, W-PCI, W-PCle and W-CODE

MatLab and C# user defined functions

YV V.V V V ¥V V V V V V V V V V VY

W-Sat-email-Decoder

The W-Sat-email-Decoder takes as its input a session file and the corresponding text files, as produced by
a WAVECOM decoder, or any text file from an external source containing emails. It does protocol decoding
and decompression, the email(s) and possible attachment(s) are output as files. The following email sys-
tems will be recognized and decoded respectively.

Email system Recognize Decode
AMOS Y Y
Blast Y N
Dualog Y Y
GlobeWireless Y Y
GTMail Y Y
MS-RAS PPP Y Y
MS-RAS TCP/IP Y N
Rydex Y Y
se@comm Y Partially
SkyFile Y Y
uucp Y Y
UUPlus Y Y
Xdatos Y Partially
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Setup

W-PCI/W-PCle

The WAVECOM hardware decoder series W-PCI and W-PCIe have two physically independent 16-bit A/D
converters. Each card has five inputs in two groups: AFIF#1, IF70#1a and IF70#1b for the group#1 and
AFIF#2 and IF70#2 for the group#2. These two cards are suitable for protocols and systems which re-
quire two concurrent channels (e.g., the FAX/modem protocols, INMARSAT protocols etc.)

W-PCI/W-PCle Hardware Installation

Before unpacking the W-PCI or W-PCle card or installing it into your PC please make sure that you are at-
tached to the electric ground to avoid damaging static sensitive components on the card or in the comput-
er.

Power off your computer, unplug it from its power source and disconnect or turn off all peripherals. Care-
fully remove the cover of the computer and locate a free PCI or PCI express slot. Firmly insert the card in-
to the slot. Close the computer cover and switch on the power.

WARNING: THE A/D CONVERTER ON THE W-PCI AND W-PCIe CARD MAY DEVELOPE ENOUGH
HEAT TO PRODUCE BURNS OR START A FIRE IF PLACED NEAR FLAMMABLE OBJECTS. WAVECOM
WILL NOT BE RESPONSIBLE FOR ANY DAMAGES RESULTING FROM NON-COMPLIANCE WITH
THIS WARNING.

IF70#1a

ot
~

IF70#1b 5
-
AFIF#2

.,-

IF70#2

0

AFIF#1

!
i

W-PClI card.
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W-PCle card.

Both W-PCI and W-PClIe cards have five SMA signal inputs. The following table is a technical hardware
specification.

Specification

Card type Half-size PCI card (W-PCI),
Half-size PCIe x1 card (W-PCI Express)

Inputs AFIF#1 and AFIF#2 IF70#1a, IF70#1b and IF70#2
Frequency range 50 Hz - 25 MHz 52.5 MHz - 87.5 MHz (SAW filter)
Signal level 2 mVrms - 0.5 Vrms 20 mVrms - 2.5 Vrms

20 mVrms - 2.5 Vrms
(with 20 dB attenuator)

Input impedance > 1 kOhm 50 Ohm
Bandwidth 5 kHz - 500 kHz

Frequency raster DDC 1.0 Hz

Input max sampling rate 92.16 MHz

Sampling rate jitter 1 ps

Connector SMA female

Two simultaneously active inputs AFIF#1 or IF70#1a or IF70#1b — with — AFIF#2 or IF70#2
Dimensions (LxWxH) 168x106x22 mm

Weight 150 g

Power requirement (typical values) 10A@ +3.3V,04A@ +12V

Bus interface 32-bit PCI, 3.3V, 132 MB/sec (W-PCI)

PCIe x 1, 250 MB/s (W-PCIe)

Operating temperature range 0 °Cto 50 °C
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Specification

Case temperature range 0°Cto55°C

Storage temperature range 0°Cto 70 °C

Relatively humidity (non-condensing) 10 to 90%

A/D converter 16-bit

Digital down converter (DDC) FPGA

License key In-card license, no external license key necessary
Conformity ce @ @m ?.,/.«

W-PCI/W-PCle Software Installation
(please refer to Software Installation W-CODE, W74PC, W-PCI and W-PCle.)

W74PC

The WAVECOM decoder hardware W74PC has four physically independent channels with two 16-bit A/D
converters. There are four SMA input connectors for input signal. Each SMA connector can be switched to
AFIF (50 Hz - 25 MHz) and IF70 (52.5 MHz - 87.5 MHz) by a signal relay. W74PC is suitable for decoding
signals and protocols which require multiple concurrent channels (e.g., the FAX/modem protocols, INMAR-
SAT protocols etc.)

W74PC Hardware Installation

Before unpacking the W74PC card or installing it into your PC please make sure that you are attached to
the electric ground to avoid damaging static sensitive components on the card or in the computer.

Power off your computer, unplug it from its power source and disconnect or turn off all peripherals. Care-
fully remove the cover of the computer and locate a free PCI express x4 (or above) slot. Firmly insert the
card into the slot. Close the computer cover and switch on the power.

WARNING: THE A/D CONVERTER ON THE W74PC CARD MAY DEVELOPE ENOUGH HEAT TO PRO-
DUCE BURNS OR START A FIRE IF PLACED NEAR FLAMMABLE OBJECTS. WAVECOM WILL NOT BE
RESPONSIBLE FOR ANY DAMAGES RESULTING FROM NON-COMPLIANCE WITH THIS WARNING.

W74PC card.
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W74PC has four SMA signal inputs. The following table is the technical hardware specification.

Specification

Card type

Half-size PCle x4 card

Inputs

AFIF#1 - AFIF#4 IF70#1 - IF70#4

Frequency range

50 Hz - 25 MHz

52.5 MHz - 87.5 MHz (SAW filter)

Signal level

2 mVrms - 0.5 Vrms 20 mVrms - 2.5 Vrms

Input impedance

> 1 kOhm 50 Ohm

Bandwidth 5 kHz - 500 kHz
Frequency raster DDC <1.0Hz
Input max sampling rate 98.304 MHz

Sampling rate jitter

< 1 ps (RMS 12 kHz to 20 MHz)

Connector

SMA female

Number of concurrent, independent inputs

Four SMA connectors: AFIF/IF70#1 - AFIF/IF70#4, each switch-

able by a mini signal relay

Dimensions (LxWxH)

168x106x22 mm

Weight

150 g

Power requirement (typical values)

< 25W

Bus interface

PCle x4 link, 2 Gbit/s

Operating temperature range 0°Cto 50 °C
Case temperature range 0°Cto55°C
Storage temperature range 0°Cto 70 °C
Relatively humidity (non-condensing) 10 to 90%

A/D converter

2 x AD9268 dual 16-bit ADC

Dynamic range

> 60 dB

Digital down converter (DDC)

FPGA Cyclone IV

Oscillator and clock

High stability temperatur compensated crystal oscillator.

phase noise clock distribution

Low

Watchdog for on-board generated voltage

Yes

License key

In-card license, no external license key necessary

Conformity

(€ O\ O .
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W74PC Software Installation
(please refer to Software Installation W-CODE, W74PC, W-PCI and W-PCle.)

Wavecom Hardware Decoder License

Wavecom hardware decoders W-PCI, W-PCIe and W74PC use a 25-alphanumeric-digit key as license. The
license key is bound to the card serial no. Details please refer to “License...”.

The hardware cards W-PCI and W-PCle are capable of simultaneous dual channel decoding. For the second
decoder instance a different 25-alphanumeric-digit license key is necessary.

Simultaneous Dual Channel Decoding on Hardware De-
coder

Wavecom hardware decoders W-PCI and W-PCIe have two separate A/D and channel down converters.
With this hardware design W-PCI and W-PCle can be used for simultaneous dual channel decoding. For
every card installed in the PC, two decoder instances are available for independent use. They are listed in
the device selector (via the menu Configuration -> W-PCle Device ...) with two different but continuous
serial numbers (SN#).

W Devices @
Server
Loca Host address or name Port Speed limit (Baud) W
Remote | 127.0.0.1 33273 No PCle

Disconnect |

Server Devices
D Mo device

Mame Connections Device Serial number  Key Key

@ DeviceA 1 WPCle V1.2 0343937400 Edit |

DeviceB WPCle V1.2 0343937401

DeviceC

W-CLOUD Networking

Index Remote host Port Auto connect Encryption Sound Status
WloudHest 52000 ¥ | o (=]

Add || Delete Restart |
Close |I

= — — >

One W-PCle card is listed with two instances for simultaneous decoding.

With this feature the user can wire two totally different signals from the receiver to the two inputs of dif-
ferent channels, e.g., AFIF#1, IF70#1a, IF70#1b of the channel 1 and AFIF#2 and IF70#2 of the channel
2 for simultaneous decoding. The two decoding instances don’t interfere with each other. This simultane-
ous feature enables a compact decoding and signal analysis setup.
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0383684413
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0383684

702!
7242020
DATA 9914898 0381684,
DATA 4861340 0384684,
DATA 3536428 0384684
DATA 3308822 0384684413

Demodulstor. BPSK PB Bandwidth: 4300 H Offset: 67535000 Hr Input: F07Lb

NUM

Simultaneous decoding on one W-PCle card: the 1% instance is decoding STANAG-4285 on AFIF#2 (input channel 2) and the 2"
instance is decoding SAT-C-TDM on IF70#1b (input channel 1).

W-CODE

The W-CODE application takes existing equipment of the customer, e.g., a soundcard or virtual soundcard
(VSC) as input device and works under a CmStick USB license key. This feature allows seamless integra-
tion with SDR (Software Defined Radio) receivers with IQ data, TCP/IP outputs or digital audio outputs via
virtual sound cards. Decoding from PC soundcards with sampling rates up to 192 kHz is also supported.
One client license is provided with each software package (multiple licenses on request). W-CODE pro-
vides all functions required to analyze, decode and process radio data communications over the entire fre-
quency spectrum.

W-CODE Hardware Installation
Insert the USB licence key(s) in any USB socket.

Software Installation W-CODE, W74PC, W-PCIl and W-PCle

Insert the WAVECOM installation DVD in the drive. When requested, point the auto start wizard to the disc
drive and start installation.

Note: After installation, you can run the corresponding application W-CODE, W74PC, W-PCI and W-PCle if
you are a member of the Administrators, Power Users or Users group.

Before the installation of a software update, the old version must be uninstalled (see “Software Uninstall”
on page 23). After uninstallation has completed, insert the WAVECOM installation disc in the drive; the in-
staller will start automatically. Otherwise, it can be started with Windows Explorer by double-clicking
Installation.exe.

Without loosing generality we show the installation steps on the example W-CODE.
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The selection dialogue

2 WAVECOM Installation ==
Main Products Addiional Saftware

qy WSPECTRA 32800 N T
SPECTRA /- SPECTRA 648t VB.0.0 M i)
REC 324 Install | [Broch
WIaPE 32601400 [[Instal | (Brochure] g'!e WHREC S2BitV3.00
W WREC 64BitY3.00

[[nsat |
] (i) s
FE WIaPCE4BIVIA00
A2 L ROl sDK V1400
[inea

s
w WPLle 328tV14.00 Install 1 <7

W-Cloud Server
Pole w-PCle B4-8t V1400 Instal ,ﬂs e

w-Cloud Server
w W-PCI 3281400 B4 BiRVA0.0
PCl wWPCIB4-BIEV1400 -rvsla -anua\ EasySAT System
(insn)[tenet]) o WAPClfe, WIFCI V200
W WABTRE SEENATD G4/ Classiier Codecheck Editor
CODE  \.CODE 648it¥120.0 @ze vE
- % Recodings /300 sl

¥T10
Uy wBiviewz5a install | [Manual
o v Wiecona o
> Cable (W AAC]VA00 nstal

2

of the installation program is displayed:

1] W-CODE - InstallShield Wizard [E5

Welcome to the InstallShield Wizard for
W-CODE

The InstallShield(R) Wizard will allow you to modify, repair, or
remove W-CODE. To continue, dick Next.

[ Release Notes | [t#4VECOM ELEKTRONIK AG |

Click the “W-CODE" button to install the W-CODE
and W-CLOUD application.

- ~
2] WAVECOM W-CODE - InstallShield Wizard =5

Destination Folder
Click Next to install to this folder, or dick Change to install to a different

D Install WAVECOM W-CODE to:

C:\Program Files\WAVECOM\WCODEY

InstallShield

[ <gack  FhHext= )| cancel |

%

Change the destination folder and click “"Next” to
continue the installation.

B

Please wait while the InstallShield Wizard installs WAVECOM W-CODE. This
may take several minutes,

-
ﬁ! WAVECOM W-CODE - InstallShield Wizard

Installing WAVECOM W-CODE
The program features you selected are being installed.

Status:

Installshield

%

Wait until the installation is finished.

First, you will see the welcome screen. Click
“Next” to continue the installation.

- <
1) WAVECOM W-CODE - InstaliShield Wizard ==

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield

[ =pack [Tl ) [ cancel |

Click “Next” to continue the installation.

_
1) WAVECOM W-CODE - InstallShield Wizard =)

InstaliShield Wizard Completed

The InstallShield Wizard has successfully installed WAVECOM
W-CODE. Click Finish to exit the wizard.

2]
< Back Finish Cancel

If the installation was successful, click Finish
to complete the process.

L

Note: If a firewall is enabled on your system, depending on its security level settings, various components
of W-CODE may ask to access the Internet or the trusted zone of the firewall. You will have to manually

grant access to these components.

Check for hidden windows if the installation process seems to “hang” (this can be done by pressing the
Alt+Tab keys). Sometimes windows in the background are waiting for a button to be pressed to allow the

installation to proceed.

WAVECOM Decoder W74PC, W-PCl/e, W-CODE, W-CLOUD Manual V14.0.0

Setup ¢ 19



W-CODE Server Control

The WAVECOM Server and the WAVECOM Server Control applications are used to setup and monitor the
connections between devices (clients) and the server, respectively. The server is responsible for managing
the devices (e.g., soundcards) in the computer as well as all the connections made to those devices. The
WAVECOM Server is started by the GUI for a local connection (GUI and devices on the same machine) or
by the Server Control for a remote connection. The WAVECOM Server is started as a Windows Service.

W-CODE Device Serial Number

The serial number of the audio device (soundcard or virtual audio cable VAC) is generated from part of the
active MAC address of the computer network interface and a counter.

W-CODE recognizes sound devices in the computer as its input devices. The serial number of a sound de-
vice comes from the built-in network card of the computer. The serial humber is used as a reference for
custom inputs ans default settings. You will lose some settings if you switch to a different LAN adaptor,
e.g., switching from a LAN to a WLAN connection.

WAVECOM hardware W74PC, W-PCI and W-PCle are detected by their corresponding application, they are
also listed in the Device dialog window with the device name and serial number. The serial number is
used as a reference for custom inputs and default settings. It is from the decoder hardware and will never
change.

Devic
Server
Loca Host address or name Port Speed limit (Baud) w
Remote (127,001 33243 No CODE
Disconnect |
Server Devices
D Mo device
Mame Connecticns Device Serial number
soundcard 1 Line In (Realtek High Definitio V1.1 1927840122
G39ddc Line 1 (WiNRADIO Virtual Sound V1.1 1927840222
@ DeviceC 1 W-CLOUD G33DDC (Wavecomn) V2.0 0343973651

—

W-CLOUD Metworking

Index Remote host Port Auto connect Encryption Sound Status
weloudT3651 sa001 v | o (g
Add || Delete | Restart |
Close |

W-CODE Device dialog window.

W-CLOUD Networking

A W-CLOUD device is like a local W-CODE device, e.g., soundcard, W-PCI or W-PCle cards. The only dif-
ference is a W-CLOUD device is physically at a remote site (over the internet) where the antenna and re-
ceiver are located. W-CLOUD device sends genuine and encrypted IQ signal to W-CODE for decoding.

In the W-CODE Device dialog window you can enter a W-CLOUD device by name (or IP address) and port
number. The connection can be made automatically upon restarting W-CODE (by pressing the “Restart”
button). The connection between W-CLOUD and W-CODE can be encrypted by checking the “Encryption”
box. Because the signal is received at a remote site, it is a big help to hear the signal at W-CODE site. This
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is done by activate the “"Sound” button. By pressing the “Check” button you may know the instantanuous
status of a W-CLOUD device.

A W-CLOUD device may have the following “Status”:
e Available: W-CLOUD device is reachable, W-CODE can connect to it by restarting.
e Offline: W-CLOUD device is unreachable.
e Busy: W-CLOUD device is used by another W-CODE.
e Connected: W-CLOUD device is connected by this W-CODE.

e Denied: W-CLOUD device is reachable, but this W-CODE can not connect to it because this W-
CODE does not have the access right.

As W-CLOUD is a networking device, it should be accessable to different W-CODE decoder instances. Con-
sidering this W-CLOUD will terminate the connection to a W-CODE when W-CODE does not use this W-
CLOUD actively for ca. 7 minutes, i.e., no mode is running. After the 7 minutes time-out W-CLOUD device
is free for any new connection requests. The previous W-CODE can do decoding as usual by opening a
mode. The connection to the W-CLOUD device will be established automatically, if the W-CLOUD device is
not busy by another W-CODE instance. It may be that the re-established connection does not work
properly, the user just need to open a mode and change the device input to “wake-up” the connection.

W-CODE Licensing

By default, W-CODE is licensed using a USB CmStick. An update option for a period of 12, 24, 36, 48, 60
months is available.

Optional additions to the basic W-CODE application are available from WAVECOM.
On request, different licensing models are available:
» Single-user licenses

» Network licenses with floating licenses (sharing of W-CODE and options between different comput-
ers)

» Licenses for other WAVECOM software products and third party products may also be stored on
the CmStick

Software Updates

Software released during the maintenance (update) period can be installed at any time.

New licenses can be loaded to the CmStick without sending the key to WAVECOM. Just click License Up-
date on the CodeMeter Control Center and follow the information provided by the assistant.

@ CodeMeter Kontrollzentrum L&J
Datei  Aktion  Ansicht Hilfe

Lizenz Ereignisse Augleihe

CmStick

@ Name:
1-1186722

Serien-Nr.: 1-1185722

Version: CmStick 1.15

SHEEN

Kapazitdt: 97 % frei (58184 Bytes)

Status: @ Deaktiviert
(&) Aktiviert solange angeschlossen

C) @ Aktiviert

Lizenzakmalisierung| Auzwerfen | [Kennwort dndern
|

|| CodeMeter ist gestartet. WebAdmin
h

How to update a license.
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Software Options

Additional functions may be enabled and licensed to work with your decoder (see “License System, Soft-
ware and Options” on page 331).

Options are marked with (Option) in the manual.

Follow this procedure to order options:
» The serial number of your CmStick must be provided and the desired options listed
» WAVECOM will process your order and forward an invoice.

> After the payment has been received, a new key or license file will be forwarded.

To process an order for options, the following information is required:
» Complete address
» Ordered items
» Email or mail delivery
» Serial number of CmStick
» Remote context file of CmStick to be updated, if applicable
W-CODE License Checking
To check the license(s) on the CmStick follow these steps:

Open the CodeMeter WebAdmin interface from the CodeMeter tray icon.

4 C'- | I- CodeMeter WebAdmin C\/J

Anzeigen
- - Avallable Licenses at 'rolf_haenggl'
el WebAdmin
ﬁ ) Product| Neme Feature Licenses Status
Code Map
o User Mo Exclu Shared Free
W CmDongle deaktivieren s e
100003 | Bundling Articles
H I |.FE 1 ‘5-:.'L::;-:‘ Oxl 1 0 0 0 0 1 Details
Customize.| Uber o
L o
Beenden . R

Press the “WebAdmin”.

Licenses available on the CmStick are listed in
this screen.
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Item RENEITS

Product Displays the product code

Code

Name Displays the name of the product item, normally the name of the product
Feature Displays the feature map. WAVECOM uses the feature map to control the software update
Map period

Licenses Displays the total number of network licenses

User Limit Displays the number of licenses, which are currently used in the user limit mode
No User Displays the number of licences that are currently used in the no user limit mode
Limit

Exclusive Displays the number of licences that are currently used in the exclusive mode
Shared Displays the number of licences that are currently used in the shared mode

Free Displays the number of licences that are currently free

Details Displays detailed information about the respective network licences in use

Important: If you have multiple CmSticks plugged into computers to the same local network, refer to

“License System, Software and Options” on page 331.

Software Uninstall

In certain situations, e.g., when updating the application, it is necessary to uninstall the software. Use the
following commands:

VISTA XP
» Click on Start, go to » Click on Start, go to the
the Computers menu Settings menu and open
and click the Unin- Control Panel
stall or change a

program button

» Select WAVECOM W-
[XX] from the list

> Click Uninstall

> Select the Add/Remove
Programs icon

» Select Install/Uninstall

Choose WAVECOM W-
[XX] from the list

> Click Add/Remove

Windows 7

» Click on Start and open the
Control Panel

» Select the Programs icon
Select Programs and Fea-
tures

» Choose WAVECOM W-[xx]
from the list

» Click Uninstall in the menu

The application has now been removed from the PC - it is possible, however, that the shortcut icons may
have to be removed manually.
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First start

W-CODE First Start

v' After the software and the CmStick have been successfully installed, the decoder program can be
started either from the Windows Start menu or by double-clicking the program icon on your desk-

top.

v" Proper operation of the decoder is indicated by the WAVECOM Server Control icon in the Windows
system tray. If the traffic light in the icon is green, then the server is operating normally. You may
also move the mouse over the icon and check that you get this status message: WAVECOM
Server — W-CODE (running).

C1 S O B SR a0 )
File HF-Modes VHF/UHF-DIR VHF/UHF-SUB Satellite Fax8 Modems Options Demodulator Favorites Configurstion View Window Help

NO MODE

1512557

D550 a @ B8 © | [Mde [Anaysis) « - = Higgr & BMABRE 2 0 %4 © —+ @mmm

0Hz | OHz

__wm )

» The first time the software is used after the installation, you will have to set the decoder device
manually. From the menu bar, go to Configuration. A drop-down menu will appear. Click on the

W-CODE Device... menu item. A setup window appears.
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Server
Local Host address or name Port Speed limit (Baud) w
Remate |127.001 33242 No CODE
Server Devices
[] reo deviee
Mame Connections. Device Serial number
soundcard 1 Line In {Realtek High Definitio V1.1 1927840122
G35ddc Line 1 {(WiNRADIO Virtual Sound V1.1 1927840222
@ DeviceC 1 W-CLOUD G33DDC (Wavecom) V20 0343973651
DeviceD No Device
DeviceE No Device
DeviceF MNo Device
DeviceG
DeviceH No Device
W-CLOUD Metworking
Index Remote host Port Auto connect Encryption Sound Status
1 weloudT3651 [+]
L = |
» Select a device number and click Close to save the entry. If you require more details regarding
remote connections and connection parameters see "W-CODE Device...” on page 55.
» The decoder is now ready for use. Apply a signal to the selected input or use the Media Player
Recorder to play back a WAV file.
>

PACTOR-II if a PACTOR-II signal is played back.

From the HF-Modes, VHF/UHF-Modes or Satellite menus a mode may be selected, e.g.,

% WAVECOM W-CODE - W-CODE Text - Card &

[ i
[EieHF-Modes VHFUHE-OR VHFAUMF-SUB Sueite Modems Options Demodulator Favortes Configuraion View Window _Help
PACTOR-HAM (CRCH000]  Bsudrte: 10000 NOR. Traffic Displey Mode Erorfree Frames 161023
DFRA-S8 Ha ? Mode| [analysis| = - = Wi S EMEE 2 L0 1k 0 gy, | ~+ T
3 W-CODETen - Card4 { Mecin Cad4 = )
Input Device icrophone (High Defindion fud lrou Dupst “
— —
4| input Sonnce
OuuDavcs | Spsshers ioh Dt Aua
SmchRse 11025
s per Sarle |15
Chmet .
sis die Tage.. de ool L @l e
L [ € =@ 40 W A A0 0
203 He Fle  [C'\Piogiam Fles\WaVECOM R scordngs vt Hi Modes F - [(Cemin
(48) S (
. 1213 1314 1416 to % 1
| o (mn)(m c) [Morwar| Chas.
-20 11025H2 168, 1 Charel
30
o
-s0-f i’ I
/
0 20 sho 7do wobo 1250 asho ko 2cbe  2Z5e  adn 20 aoon  adka asho  arsn  4obo [Em
Cemoduiator: DSP Shift 202 H Centes 1314 Hz Offset 0z Input; AF (LEFT)
[y

» Tune the demodulator to the correct center frequency and set the correct input level.

GUI

The user interface of the application conforms to standard WINDOWS interface guidelines. The main pro-
gram window is shown in this section. This is the window you will see after setup has been completed as

described in the preceding paragraphs.

WAVECOM Decoder W74PC, W-PCl/e, W-CODE, W-CLOUD Manual V14.0.0

First start o 25



The WINDOWS elements TOOLBAR, WAVECOM TOOLBAR, LEVEL INDICATOR and SPECTRUM INDI-
CATOR may be moved anywhere in the screen as required. In the View menu the user may show or hide
all window elements. By default, all elements are visible.

Please be aware that the appearance of the GUI will vary depending on the product, software version and
operating system.

Command Line Parameters

You can pass information to the application by adding command line parameters.
The following commands are valid:
/i <ini file name>

The name of the INI file that is located in the same directory as the decoder application. Alternatively a
path may be entered.

/n <card number>

The number of the card to be connected (a value between 1 and 8).
/c <computer>

The name of the computer to be used for the connection

> localhost (nhot case sensitive) or 127.0.0.1 means that you work with cards on the local comput-
er.

» Computer name or the IP address plus the port humber to connect to another computer. The port
number must be entered on the WAVECOM Server Control screen. If a port number is not provid-
ed, then default port 33233 is used.

/1 <speedlimit>

> Speed limit of the connection to the server. This attribute is a choice of *9600”, *14400”, *19200",
“56k”, “64k”, “128k"”, *512k”, “1M”, “2M”, “5M"”or “10M”. If no /I option is used, the speed is un-
limited.

Examples (for W-CODE):

WCODE.EXE /i configl.ini

WCODE.EXE /i "\configuration\setupAB.ini"
WCODE.EXE /n 2 /c WCODEServer:5800
WCODE.EXE /n 1 /c 192.168.1.12:8080
WCODE.EXE /n 3 /c 192.168.2.5
WCODE.EXE /n 3 /c 192.168.2.5 /I 56k

vV V V V V

Default Data and Program Folders (Paths)

To see all folders, select Folder Options in the Control Panel
» Enable Show all folders.

> Enable Show hidden files, folders and drives
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N
Folder Options =]

Folder Options

il o B

General | View | Search

General | View | Search

Browse folders
(@) Open each folder in the same window
== ) Open sach foldsr in ts own window

Click tems as follows

“ (@ Single-click to open an item {point to select)
ﬂ Underine icon titles consistent with my browser
@ Underline icon titles only when | point at them
@ Double-click to open an item {single<lick to select)

Navigation pane
a ) [F)8how al folders
& )0 [ Automatically expand to current folder

Folder views

Advanced ssitings

You can apply the view (such as Details or lcons) that
you are using for this folder to all folders of this type

Applyto Folders Reset Folders |

| Files and

Folders

>

[C] Mways show icons, never thumbnails
[C] Aways shaw menus
Display file icon on thumbnails
Display file size information in folder tips
[ Display the full path in the title bar (Classic theme only)
| Hidden files and folders
(@) Dont show hidden files, folders, or drives

m

@ Show hidden files, folders, and drives
Hide empty drives in the Computer folder
Hide extensions for known file types
Hide protected operating system files (Recommended) ~
How do | change folder options?
[0k J[ cance | [ sootr [ ok J[ cancel |[ mooy |

Path names can vary if you use a non- English language operating system or if you are not using the Mi-
crosoft “Windows Explorer”.

Folder

Program Fold-
er (RO)

‘XP

C:\Program Files\WAVECOM\<Product>\

Vista

C:\Program Files\WAVECOM\<Product>\

Global Data
(RO)

C:\Documents and Settings\All Us-
ers\Application Data\WAVECOM\<Product>\

C:\ProgramData\WAVECOM\<Product>\

Global Data
(RW)

C:\Documents and Settings\All Us-
ers\Documents\WAVECOM\<Product>\

C:\Users\Public\Public Documents\
WAVECOM\<Product>\

User Specific
Roaming Data

C:\Documents and Set-
tings\\<Username>\\Application Data\
WAVECOM\<Product>\

C:\Users\<Username>\AppData\Roaming\
WAVECOM\<Product>\

User Specific
Non-Roaming
Data

C:\Documents and Set-
tings\<Username>\Local Settings\Application
Data\WAVECOM\<Product>\

C:\Users\<Username>\AppData\Local\
WAVECOM\<Product>\
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Program Folder

Py Computer
4, 05(C)
L. MSOCache

4 || Program Files

I Jy Adobe
4 || WAVECOM
L. CCC Editor
4 || Recordings
P Wav
4 || WBLPC
L. amd6d
4 livg
b vg
& @6
4 |, WCODE
4 || VG
4 VG
I . Clover2Demod
b1 Clover2000Dernod
I . PactoMDemod
b | Western Digital

Global Data (RO)

Py Computer
& 05(C)
|| MS0OCache
I |, Program Files
4 || ProgramData

b ) Adobe
bl TEMP

I |0 Ulead Systems

4 | WAVECOM

L. WELPC
|\ WCODE
b1 WindowsSearch

Global Data (RW)

4 M Computer
4, 05(C)
4 | Users
| Administrator
. Default
4 || Public
| Favorites
b Libraries
|| Public Desktop
4 | Public Docurnents

4 || WAVECOM

|| CCC Code Tables
4 || W6EIPC
. Alphabets
| Config
| Data-Input
| Data-Output
4 |, WCODE
| Alphabets
| Config
| Data-Input
i | Data-Output
. Public Downloads

Main Menu

The main menu includes all submenus relating to operating modes, as well as analysis and setup func-
tions.

The WINDOWS operating system is based on a multitasking kernel and can handle several tasks simulta-
neously, and therefore interaction with the menu system will not interrupt the execution of an active func-
tion. This allows, for example, the shift and center frequency to be set in the Demodulator submenu
without disrupting the currently active operating mode.

Main Menu Screen Display

This window is displayed without any mode started.

B4 wavecom
File HF-Modes VHF/UHFDIR VHF/UHF-SUB Satelite Fax&Modems QOptions Demodulator Favorites Configuration View Window Help

NO MODE

DEdaGE B D (M o) ~ -~ Bir - BMER

L |

As a standard WINDOWS procedure a left-click on a menu item will display the corresponding drop-down
menu.

File  HF-Modes VHF/UH]R VHF/UHF-SUB  Satellite FAX & Modems Options Demodulator Favorites Configuration View Window Help
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The functions of the File, View and Window menus are general system functions in accordance with the

WINDOWS standard.

File Menu

Open...

Close

Save

Save As...

Save As Text..

Save As Picture...
Save As Bitstrearn..,

Save Selection As...

1)

Save continuous

Find...
Find MNext

Clear Screen

Print...

Print Continuously
Print Preview

Print Setup...

Recent File

Exit

Media Player/Recorder...

HF-Modes  VHF/UHF-DIR  VHF/UHF-

Ctrl+0

Ctrl+5

Ctrl+F
F3

Ctrl+P

Using the File menu, files may be saved and opened. Other functions such as the Media Player/Recorder,
find, printing, print preview and printer setup are also available.

Open...

Save

Save As...

Save As Text...

Save As Bit-
stream...

Save As Picture...

Save Selection as...

Save Continuously

Media Play-
er/Recorder

Find

Find Next
Clear Screen
Print

Print Continuously

Open previously saved files

Save received text to an already open text file. If no file is open “Save As...” will be started
to ask for a valid path and file name

You can specify a path and file name and save the received text to this file

Save received text as an ASCI or Unicode file

File name: -

Save as type: [UnlcodeTeﬁt Files (".txt) ']

Text Files (*.txt)
Unicode Text Files (*.txt)
“ Hide Folders

Save a bit stream e.g., from an auto-correlation session as a text file of ASCII 0's and 1's

Save the main window as a JPEG, a BMP or a PNG file
Select a block of text and save it to a text file
Save continuously all output to a file

Record and play back WAV files

Search for every occurrence of a specific word or phrase in the received text
Find the next occurrence of a specific word or phrase in the received text
Prompts the user to clear the screen

Send the received text to a printer

Send continuously all output to a printer

WAVECOM Decoder W74PC, W-PCl/e, W-CODE, W-CLOUD Manual V14.0.0

First start o 29



Print Preview Preview the output before sending it to the printer
Print Setup... Open the printer setup dialog

Recent File Displays a list of recently opened files

Note: Files that are saved with Save and Save as... are stored in the WAVECOM *.WDA format. This
format is used to save decoded text together with time stamps in a text file. The import of old *.W40
(W40PC), *.W41 (W41PC) and *.W51 (W51PC) files is also supported. For more details see “WAVECOM
Data File Format” on page 347.

Media Player/Recorder

The Media Player/Recorder enables the user to record and save audio signals as WAV files for later play-
back to the W-CODE decoder.

Audio signals are recorded directly from the local sound card and saved as WAV files on the host comput-
er. The input can be a physical device (a soundcard) or a virtual device (a virtual audio cable VAC). During
playback, the audio signal is sent directly to the W-CODE decoder in digital format without any further
processing or conversion - the sound card is completely bypassed. To enable the user to monitor the sig-
nal, the signal is also routed to the local host sound card output.

The Media Player/Recorder is controlled from the Media Player/Recorder dialog:

Input Device: Microphone [Realtek High Defini Input  Output

Input Source:
Qutput Device: |Speakers [Realtek High Definiti
Sample Rate: 43000 |

Bits per Sample: |16

Channel: AF Mute [ 0

,

[dE] -60 -50 -40 -30 -20 -10 0

File: RUM-FEC, 164.5 BD, SCRAMBLED, INVERTED POLARITY. WAV C~| [clear List
Time: 0:06 D 20:15

o)) (u] (a] o) (e ]

458000 Hz, 16 Bits, 1 Channel

The Media Player/Recorder dialog can be opened from either the File->Media Player/Recorder...
menu, or from a toolbar button:

#r| The Media Player/Recorder dialog can be closed and reopened at any time. Any playback or record-
REC| . . - i X . ! X .
ing operation that is in progress when the dialog is closed will continue uninterrupted in the back-
ground.
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Signal Routing: Media Player Recording

- — J Output [

Ouput Device Windows Audio System

— Input
— j _ WAVECOM Media Player/ Disk
L/’_' > Recorder File Recording
Mute
Windows Audio System

Decoder Gain

Input
T y) »

Windows Audio System W-CODE

Signal Routing: Media Player Playback

Playback

— Output
e e V) e
Mute —
Output Device Windows Audio System
Disk WAVECOM Media Player/
Recorded Files Recorder

Decoder Gain

W-CODE

Main Control Buttons

The Media Player/Recorder is controlled primarily using the main control buttons:

Record
0
I
Pause
||
B Stop
Loop

Press the Record button to start recording and the Stop button to stop recording. Press the Play button
to start playback and the Stop button to stop playback. Playback and recording can be paused and re-
sumed at any time by pressing the Pause button. When the Loop button is toggled on, playback will au-
tomatically restart from the beginning when the end of the file is reached. If the Loop button is not
pressed, playback will stop at the end of the recording.

WAV File

Before starting a playback or recording operation, the user must specify the WAV file to read from or write
to in the Media Player/Recorder dialog:

Filz C:ATransfer\BEL CODANACODAN-BEL-Demonstration'Signals\Signal = |23+ Clear ligt

The name of the file can either be specified by typing the full file path into the text box, or by pressing the
folder button to browse for the required file. A list of the 10 most recently used files is also available by
pressing the down arrow on the right of the text box.
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Clear List clears the list of previously used files.
Time Display

During the recording process, the current length of the recording (in minutes and seconds) is displayed at
the left side and the total time of the recording (in minutes and seconds) is displayed at the right side.
During playback, the current position is shown in the time display along with a slider that shows the rela-
tive position in the file:

Time: ooz || 20:15
The user can fast-forward or rewind by dragging the slider with the mouse.

Level Indicator

| |
[dB] -B0 A0 -40 -30 -20 -10 0
A level indicator is provided to monitor the sound level. While playing a WAV file, the level indicator shows
the level of the file being played. At all other times (during recording or while stopped), the level indicator
shows the level of the sound present on the selected host sound card input.

For stereo audio, the level indicator displays two bars, one for each of the left and right channels. For
mono audio, a single bar is displayed.

The average signal power and peak signal power is calculated every 50ms. The average signal power is
displayed as a green bar in the level indicator, while the peak level is displayed as a black line. Both of
these power levels are expressed in dB, with reference to 0dB Full Scale. When adjusting the sound level
for recording it is important to ensure that the peak signal power (the black line) is as high as possible,
yet never touches the 0 dB mark. Failure to keep the peak signal power below the 0dB mark will result in
a clipped or distorted recording.

Mixer Control
Access to the Windows Mixer is provided directly from the Media Player/Recorder:

Input  Output
= [

Mute
@) (<]
E To open the recording mixer press the 'Recording Level' button

| @ To open the playback mixer press the 'Playback Level' button

The functionality provided by the Windows Mixer depends on the host sound card and the version of the
operating system installed. For more information, see the documentation provided by your host sound
card manufacturer.

Quick access to the most commonly used functionality in the Windows Mixer is provided via a gain slider
and mute button. These controls are linked directly to their counterparts in the Windows Mixer. Adjusting
one will also adjust the other. On Windows XP, the output slider and mute button will control the “*Wave”
mixer control. On Windows Vista and later, it controls the “Volume” for the W-CODE application.

Recording Controls

Most sound cards are equipped with more than one input source, e.g., Line-In 1, Line-In 2, S/PDIF-In, etc.
Additionally, some computers are fitted with more than one sound card. Before a recording can be made,
the user needs to choose the sound card device and sound card input that will be used for the recording.

To select the sound card use the Input Device control:

Input Device |Micr0phone [High D efinition Aud v|
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To select the source use the Input Source control:

Input Source ILine-In 1/Mic j

Note: On Windows Vista and later, all input sources from all sound cards are listed under the 'Input De-
vice' control, and the 'Input Source' control is not available.

Various combinations of sampling rate and bits per sample can be chosen when recording WAV files, and
the output file can be either mono or stereo. To set the WAV file recording format use the following con-
trols:

Sample Rate: 43000 -
Bits per Sample: |16 -

Channel: AF -

Sample Rate needs to be set to twice the required signal bandwidth. The following sample rates are sup-
ported:

Sample Rate Signal Bandwidth REINES

8 kHz 4 kHz

11.025 kHz 5.5 kHz

16 kHz 8 kHz

22.05 kHz 11 kHz

44.1 kHz 22 kHz

48 kHz 24 kHz Recommended
96 kHz 48 kHz

192 kHz 96 kHz

Note: Not all sound cards will support all of these sample rates. For further details see the documentation
provided by your host sound card manufacturer.

Bits per Sample can be set to either 8 bits or 16 bits depending on the required dynamic range:

Bits per Sample H Dynamic Range
8 bits 48 dB
16 bits 96 dB

Audio can be recorded in stereo or mono. When recording in mono, either the left or right channel can be
recorded. The Channel control provides the following options:

Channels H Recording Source ‘
AF Left Records left channel only
AF Right Records right channel only

IQ (Left & Right)

Records both channels

On sound cards that are not capable of stereo sound, only one option (namely 'AF') is available.
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The WAV file format supports files up to a maximum size of 4 GB. The maximum length of recording that
can be made depends on the sample rate, humber of channels and bits per sample. The table below lists
the maximum recording lengths for a few common formats:

Format H Max recording length
8kHz, 8-bit, AF 149 hours, 7 min
8kHz, 16-bit, AF 74 hours, 33 min
48kHz, 16-bit, AF 12 hours, 25 min
48kHz, 16-bit, IQ 6 hours, 12 min
192kHz, 16-bit, IQ 1 hour, 33 min

Playback Controls

Sound playback can be routed to the output of any installed sound card. To select the sound card that will
be used for playback, use the Output Device control:

Output Device [Speakers [High Drefinition Audio V]

Monitor Function

b anitar | The monitor function allows the user to listen to the audio signal connected to the sound card input.
Press the Monitor button toggle this function on and off.

The monitor function works by playing back the recorded signal in real time. A circular buffer is used re-
sulting in a small delay between the input and output signal.

A problem may occur when monitoring an input from one sound card to an output on another sound card,
where the sampling clocks used for the input and output will not be synchronized. On some sound cards
different clocks are used for input and output, resulting in the same problem. In these cases the monitor
function may produce sound with occasional skips and interruptions - this is normal, and will not affect the
integrity of recorded sound.

Some sound cards have an input labelled something like "What You Hear” or "Wave Out” allowing the re-
cording of sound produced by other applications on the computer. When these inputs are selected, the
monitor function should not be used as it will create a feedback loop.

Record a Signal from Wavecom Hardware Devices

Media Player/Recorder can also be used to record a signal on a Wavecom hardware device, including W-
CLOUD. This is done via Wavecom Virtual Audio Cable (W-VAC). User can select W-VAC as the “Input De-
vice”, the signal on a Wavecom hardware device is redirected to the W-VAC and thus can be recorded by
pressing the “Record” button. The signal format is IQ in general; for audio signal one channel (Left or
Right) is just of zero value.
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F ~
Media Player/Recorder - Card 6 (W-CLOUD) C=mEel X
Input Device: Line 1 (2- Wavecom Virtual Audi Input  Output I
(I
Input Source:
[
Output Device: |Speakers (Realtek High Definiti
Sample Rate: 45000
Bits per Sample: |16
Channel: I} (Left & Right) Mute [ &
| | Left
Right
[dE] -60 -50 -40 -50 =20 -10 0
File: RedQ 01.wav C~| | Clear List
Time: 0:05
> (1) (] o] [
48000 Hz, 16 Bits, 2 Channels
ke F = -

HF-Modes Menu

The various HF protocols are displayed in the HF-Modes menus and are divided into different groups. To
select the modes of a group, left-click or let the mouse rest briefly on the group item to be selected. Now,
the modes of the group are displayed in a separate menu. Start decoding the desired mode by another
left-click.

It may be difficult to guess or remember to which group a particular mode belongs. To facilitate an over-
view, a full-screen menu may be opened by clicking the menu item Mode Selector. To start a mode, click
on the appropriate menu field. Leaving the full-screen menu will not terminate an active mode.

The various analysis tools available are displayed in the Analysis menus.

Descriptions of the operating modes in a separate section of this manual are arranged in alphabetical or-
der.

The Mode Selector is available from the HF-Modes menu and from the WAVECOM Toolbar.
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HF-Modes are organized as follows:

HF-Modes | Analysis HF-Modes | FSK
[HF-Modes | VHF/UHF-DIR  WHF/UHF-SUB  Satellite Fax 8 Modems Options -
- FSK Code Check
= ’ AT VHF/UHF-DIR  VHF/UHF-
Esk b Sonagram Analysis , ALTS
MESK b FFT & Sonagram | = ARQ-E
»
PSK & OFDM » =l — ARQ-E3
il »
MIL-STANAG & HF-ACARS 3 ce=cobe ARQ-M2-242
PSK & QFDM 3
Graphic-Modes & CW 3 FSK Analysis ARQ-M2-342
- - »
— FSK Code Check MIL-STANAG & HF-ACARS ARQ-M4-242
ode selectar... Graphic-Modes & CW , g
PSK Symbol Rate
PSK Phase Plane Mode Selector... ARQ-MN
PSK Code Check ARQE-90
MIL-STANAG Code Check ARQ6-98
ASCH
MFSK Analysis
AUTOSPEC
MFSK Code Check
BAUDOT
Classifier BR-G028
Classifier Code Check BULG-ASCT
Autocorrelation CHU
Bit Correlation CI5-11
Bit Length Analysis CIs-14
Demod. Bitstream Output CI5-36-50
CI5-50-50
Analysis Selector... CODAN-SELCAL
CV-786
DGPS
DUP-ARQ

nHn ADA Y

HF-Modes | MFSK HF-Modes | PSK & OFDM
MrsR "
VHF/UHF-DIR VHF/UHF-SUB Satellite Fax & Modems Of
. PSK&OFDM » PSK Code Check
Analysis »
MIL-STANAG & HF-ACARS »
e e v s Graphic-Modes & CW » ALFeRDS
F5K 4 raphic-Modes CHN 4+4
MFSK » MFSK Code Check e Taim
PSK & OFDM » A CLOVER-2
MIL-STANAG & HF-ACARS » . CLOVER-2000
Graphic-Modes & CW 3 AUM-13 CLOVER-2500
Mode Selector... CIS-36 SRR
CODAN-9001
COQUELET-8
GW-OFDM
COQUELET-13
GW-PSK
COQUELET-80 —
A PACTOR-I-AUTO
ICAQ-SELCAL PACTOR-I-FEC
MFSK-8 PACTOR-I
MF5K-16 PACTOR-4
MFSK-20 PSK-AM
OLIVIA PSK-10
PICCOLO-MK6 PSK-31
PICCOLO-MK12 PSK-31-FEC
sP-14 PSK-63
THROE PSK-63F
THROBX HEE
TWINPLEX PSK-L25F
PSK-220F
PSK-250
ROBUST-PACKET
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HF-Modes | MIL-STANAG & HF-ACARS

HF-Modes | VHF/UHF-DIR  WVHF/UHF-SUB  Satellite Fax & Moderns  Options

q Analysis

9 FSK
MFSK
PSK & OFDM
MIL-5TANAG & HF-ACARS
Graphic-Modes & C\W

Mede Selector...

»

»
b
L3
.
L3

De

El Analysis| & ~ o

MIL-STANAG Code Check

HF-ACARS / ARINC-635
LINK-11 (CLEW)

LINK-11 (SLEWY)
MIL-188-1104
MIL-188-110A-MOD
MIL-188-110B / STANAG-4539
MIL-188-110-16TONE
MIL-188-110-39TONE
MIL-188-1414

MIL-188-141B

MIL-M-555294

STANAG-4285

STANAG-4415
STANAG-4481-FSK
STANAG-4481-PSK
STANAG-4529
STANAG-5065-FSK

HF-Modes | Mode Selector...

See “Mode Selector” on page 76.

HF-Modes | Graphic Modes and CW

VHF/UHF-DIR

Analysis

FSK

MFSK

PSK & OFDM

MIL-STANAG 8 HF-ACARS
Graphic-Modes 8 CW

Mode Selector...

»

3

-

VHF/UHF-5UB

Satellite

Analysis| &

|

-

Fax & Modems

E
\

CW-MORSE
FELD-HELL
FM-HELL
PRESS-FAX
S5TV
WEATHER-FAX

VHF/UHF-DIR Menu

DIRECT modes can only be demodulated at the intermediate frequency level IF (analogue or IQ). The
various VHF/UHF-DIR protocols are displayed in the VHF/UHF-DIR menu. To start decoding of the de-

sired mode, click on it.

The various analysis tools are displayed in the Analysis menus.

The descriptions of the operating modes in a separate section of this manual are arranged in alphabetical

order.

The Mode Selector is available from the VHF/UHF-DIR menu and from the WAVECOM Toolbar.

VHF/UHF-DIR | Analysis

VHF/UHF-DIR | VHF/UHF-SUB Satellite Fax & Modems Options

Analysis 3

AIS

APCO-25
DCS-SELCAL
DMR

dPMR

ERMES

FLEX

GOLAY / GSC
MOBITEX-8000
NXDN
PACKET-9600
POCSAG
TETRA
TETRAPOL
VDL-M2

Mode Selector...

FFT

Sonagram

FFT & Sonagram
Waterfall

Oscilloscope

FSK Analysis
FSK Code Check

PSK Symbol Rate
PSK Phase Plane

Classifier
Classifier Code Check

Autocorrelation
Bit Correlation

Bit Length Analysis
Demod. Bitstream OQutput

Analysis Selector...

VHF/UHF-DIR | Mode Selector...

See “Mode Selector” on page 76.

VHF/UHF-DIR | Modes

VHF/UHF-DIR | VHF/UHF-SUB

Analysis 3

AIS

APCO-25
DCS-SELCAL
DMR

dPMR

ERMES

FLEX

GOLAY / GSC
MOBITEX-8000
NXDMN
PACKET-9600
POCSAG
TETRA
TETRAPOL
VDL-M2

Mode Selector...
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VHF/UHF-SUB Menu

INDIRECT modes require additional AM or FM demodulation in the receiver. If the signal is demodulated
from an IF-IQ signal (offset frequency <> 0), then a standard AM or FM software demodulator is automat-
ically added to the signal processing path.

The various VHF/UHF-SUB protocols are displayed in the VHF/UHF-SUB menu. To start decoding of the
desired mode, click on it.

The various analysis tools are displayed in the Analysis menus.

The descriptions of the operating modes in a separate section of this manual are arranged in alphabetical
order.

The Mode Selector is available from the VHF/UHF-DIR menu and from the WAVECOM Toolbar.

VHF/UHF-SUB | Analysis VHF/UHF-SUB | Modes
Satellite  Fax & Modems Options  Demodulator  Far VHF/UHF-SUB | Satellite  Mode
Analysis 4 FFT Analysis R
ACARS Sonagram ]
ATIS FFT & Sonagram 1 ACARS
BIIS Waterfall ATIS
FMS-BOS Oscilloscope _ BIS
GMDSS / DSC-VHF FSK Analysis FMS-BOS
MOBITEX-1200 FSK Code Check GMDSS/DSC-VHE
LPTRERD PSK Symbol Rate i
NMT-450 PSK Phase Plane MOBITEX-1200
NWR-SAME MPT-1327
PACKET-1200 SELCAL Analysis NMT-450
X25 Classifier NWR-SAME
ZVEI-VDEW Classifier Code Check
SELCAL Analog ' Autecorrelation PACKET-1200
Mode Selector... Bit Correlation x35
Bit Length Analysis ZVEI-VDEW
Demod. Bitstream Output ahalallarz '
Analysis Selector... Mode Selector...
VHF/UHF-SUB | Selcal Analog VHF/UHF-SUB | Mode Selector...
ZVEL-VDEW | See “Mode Selector” on page 76.
SELCAL Analog 3 CCIR-1
Mode Selector... SCR
CCIR-7
canmT
CTCSS
DTMF
DZVE
EEA
EIA
EURD
MODAT
MATEL
PCCIR
PDZVEI
PZVEL
VDEW
ZVEL-1
ZVEL-2
ZVE-3
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Satellite Menu

The various satellite protocols are displayed in the Satellite menu. To start decoding of the desired mode,
click on it or to select the modes of a group, left-click or let the mouse rest briefly on the group item to be
selected. Now, the modes of the group are displayed in a separate menu. Start decoding the desired mode
by another left-click.

The various analysis tools are displayed in the Analysis menus.

The descriptions of the operating modes in a separate section of this manual are arranged in alphabetical
order.

The Mode Selector is available from the Satellite menu and from the WAVECOM Toolbar.

Satellite | Analysis Satellite | Modes
Fax & Modems Options  Demedulator  Favorites  Configu Satellite | Fax & Modems Optic
Analysis b FFT Anal}rsis »
INMARSAT-AERO STmEZE L
- L
INMARSAT-B y FFT & Senagram INMARSAT-AERD 4
INMARSAT-C v Waterfall INMARSAT-B ’ ﬁ
INMARSAT-M 5 Oscilloscope INMARSAT-C y E
INMARSAT-mM 2 FSK Analysis INMARSAT-M »
AMSAT-P3D PSK Symbol Rate INMARSAT-mM »
NOAA-GEOSAT PSK Phase Plane
ORBCOMM - AMSAT-P3D [
Classifier
Mode Selector... . MNOAA-GEOSAT
Autocorrelation
Bit Correlation ORBCOMM
Bit Length Analysis Mode Selector
Demod. Bitstream Output
Analysis Selector...

Satellite | INMARSAT-AERO Satellite | INMARSAT-B
Fax 8 Modems Options  Demodulater Favorites Fax & Modems Options  Demedulator  Favorites
Analysis 3 l Analysis 3
1 s ey m H L1
L ot REC
INMARSAT-AERO v INMARSAT-AERO-P INMARSAT-AERO gl d
INMARSAT-B 3 SAT-B
INMARSAT-B 3 INMARSAT-AERO-R
INMARSAT-C 3 SAT-B-C-TFC
INMARSAT-C 3 INMARSAT-AERO-T
INMARSAT-M 3 SAT-B-DATA
INMARSAT-M » INMARSAT-AERO-C INMARSAT-mi 5 SAT-B-FAX
INMARSAT-mM 3 e
AMSAT-P3D SAEHD
AMSAT-P3D NOAA-GEOSAT iy
NOAA-GEOSAT QORBCOMM SAT-B-TELEX-5M
SAT-B-TELEX-MM
ORBCOMM Meode Selector... SAT-B-C-HSD

Mode Selector...
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Satellite | INMARSAT-C Satellite | INMARSAT-M

Fax 8 Modems Options  Demodulater Favorites Fax 8 Modems Options  Demodulator  Faverite

Analysis [ | NOR 5 Analysis LN | NOR
Fry - ]

DIMARSAERERD | MEE 2 1 INMARSAT-AERO mHE 2
INMARSAT-B 4 ] INMARSAT-B 3
INMARSAT-C 3 SAT-C-TDM INMARSAT-C b
INMARSAT-M v SAT-C-TDM-EGC INMARSAT-M 5 SAT-M
Il g TG INMARSAT-mM ’ SAT-M-DATA
AMSAT-P3D AMSAT-P3D SAT-M-FAX
NOAA-GEOSAT NOAA-GEOSAT i SAT-M-TEL
OREBCOMM ORECOMM

Mode Selector...
ode Selector. Mode Selector...

Satellite | INMARSAT-mM

Satellite | Fax & Modems Options Demodulator  Favorites

Analysis 3 l

INMARSAT-AERO (53 A H M o

INMARSAT-B ,

INMARSAT-C ,

INMARSAT-M ,

INMARSAT-mM , SAT-mM

T SAT-mM-DATA

NOAA-GEOSAT SATR ML

——— SAT-mM-TEL
SAT-mM-HSD

Mode Selector... SAT-mM-C-HSD

Satellite | Mode Selector...

See “"Mode Selector” on page 76.

FAX & Modems Menu

The various modem protocols are displayed in the FAX & Modems menu. To start decoding of the desired
mode, click on it or to select the modes of a group, left-click or let the mouse rest briefly on the group
item to be selected. Now, the modes of the group are displayed in a separate menu. Start decoding the
desired mode by another left-click.

The various analysis tools are displayed in the Analysis menus.

The descriptions of the operating modes in a separate section of this manual are arranged in alphabetical
order.

The Mode Selector is available from the FAX & Modems menu and from the WAVECOM Toolbar.
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FAX & Modems | Analysis FAX & Modems | Modes
Fax & Modems | Options  Demodulator Favorites  Configuration  View FAX & Modems | Options  Demodul
Analysis b FFT Analysis 3
Half-Duplex Auto Mode SomgEm Half-Duplex Auto Mode
FFT & Sonagram

FAX-G3-VT

P Waterfall FAX-G3-V.2Tt
- V. er
FAX-G3-V.2 ter Oscilloscope PR
FAX-G3-V.29 ’
i FAX-G3-V.34hd

FAX-G3-V.34hdk FSK Analysis e

BELL103
BELL102 PSK Symbol Rate BELLI12A
BELL212A PSK Phase Plane V.ol
V.21 Classifier V.22/V.22bis
V.22 / V.22bis V.23

Autocerrelation
W Bit Correlation Full-Duplex Auto Mode
Full-Duplex Auto Mode Bit Length Analysis V.26/V.26bis
i 2 V.32/V.32bis

LG Demod. Bitstream Cutput o
V.32 /V.32bis :
V.34 Analysis Selector... V.90

Va2
V.90
V.92 Maode Selector...

Mode Selector...

Fax & Modems | Mode Selector...

See “"Mode Selector” on page 76.

Options Menu

Options
Alphabet... |

; Code Statistic }
i Letters/Figures... l

Demodulator  Favor

Toeggle

v Msl
¥ IAS

Cycle...

Time Starnp...
v ErrorIndication

Clear Screen

Resync Mode

In the Options menu all supported functions for a particular mode or functionality are collected - the
menu is adapted to each individual mode. The Options menu will therefore appear with different contents
depending on the mode or functionality selected.

Alphabet...

The Alphabet menu has options for transparent and normal output. The normal output includes fonts for
e.g., Latin, Greek, Cyrillic, Hebrew, Arabic alphabets.

The ASCII character sets for output in German, Bulgarian, US, Swedish, Danish-Norwegian, Chinese
or other alphabets may also be selected.

Skyper, an alphabet which is used in POCSAG mode in Germany, is also available.

The transparent alphabet includes output of non-printable characters of a data transmission, e.g., ITA-2
control characters like Letter Shift and Figure Shift, or undefined upper case characters. In normal alpha-
bets these characters are not output.

Auto Decrypt

Decryption can be switched on/off with Options | Auto Decrypt. If enabled, the key is displayed in the
status bar.
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Bit Inversion Mask
One or several data bits may be inverted by using the Bit Inversion Mask item in the Options menu.
The Bit Inversion Mask can be entered in three different ways:

» In the top input box a decimal number between 0 and 31 may be entered

» In the center input box the same number may be entered in binary format with the least signifi-
cant bit to the right

» In the bottom check boxes a logical "1" is entered with the mouse by clicking in the check box
rBit Inversion Mask @1

The bit inversion mask can be entered in any of the three formats:

Decimal (0-31)

1 =

Einary [LSE to the right]
00000

Bitwise (a check indicates a logical 17}

| o i

[ OK ][ Cancel ]

S

Bit Inversion is only implemented for ITA-2 (Baudot) based bit streams.

CRC Recognition

An automatic detection of the CRC can be switched on/off with Options | CRC Recognition. The detect-
ed CRC is displayed in the decoder status bar.

Demodulator  Favor
Alphabet...

v MSI

Time Stamp...

v ErrorIndication
CRC Table...

v CRC Recognition

Clear Screen

Resync Mode
CRC Table
Using Option | CRC Table a certain CRC mask can be defined.
CRC Table =)
CRC Code (Hex) CRC Description OK
oo ________ram |
4345 ICRC
4649 IFR
4244
534d
4244 7
5243 8
0216 9
CRC Code (Hex) CRC ﬂ]
0000 HAM

A table of CRC's is stored in \Config\CRCTable.xml.
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Clear Screen

This function will clear the screen contents. All data will be lost.

Code Statistics

For five bit alphabets a code statistics window can be shown below the text window. In the Options menu
chose Code Statistics to switch the statistic window on or off.

The bottom row shows the decimal value of the characters. The row above displays the number of charac-
ters as a percentage.

The statistics are displayed as a 3D bar graph, with the height of the bars proportional to the number of
instances of a given character.

Click on the Reset button to reset all counters to zero.

Press the Enabled button to toggle sampling of the received characters for the statistics on and off.

Using the Statistics button the data can be showed ordered by quantity.

| WAVECOM W-CODE - Text - — — — - - - o o]
File  HF-Modes WHF/UHF-DR  VHF/UMF-SUB Seteline FoxGModems Options Demcdulator Favortes Configuration View Window Help ]
aauor Bausiote 5100 Siphabet Ta2-Latin my Tefc Bt v, s 00000 152302 |
DS mdd BE @ [Mode) [Anayss) & « "w S BEMEARE 2 S8R + [ omke 0 [T

3 Ten - Cand2 =3 E=R <=

Reset Enabled Statistic | Valuesin%  Maximum sbsolute value: 155

00 1 0 7 0 0 0 1 0 1 1 4 3 14 3 1 0 3 0 2 0 2 4 1 1 4 3 8 9 41 0 %
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

Demodulator: DS? Shift: 450 He Center: 1560 He Offset: 0 Hz Input AF (LEFT)

HUM

Cycle...

In some modes, the character repetition cycle may be manually selected.

Error Indication

If Error Indication is switched on, then characters containing errors are marked in red color. If possible,
the error correction will correct the erroneous data.

FAX & Modems Settings
( Fax & Modems Settings ﬁ‘

Data output paths
Server: C:\Users\Public\Do cuments \WAVEC...\Modem[1927840123]

Client: ChUsers\Public\Documents\WAVEC...\Modem[1927540122] Browse...

[ Close ][ Apply ]

For the FAX & Modems modes, additional parameters regarding the output location can be set in the Op-
tions | FAX & Modem Settings dialog box.

These settings are:
» Server: The path to the specific output directory has to be specified

> Client: The path to the specific output directory has to be specified. This option is only enabled in
remote mode
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Frame Format...

.
Frame Format e £5
600 bps / Short ~ o
300 bps / Short
150 bps / Short
75 bps / Short =
2400 bps / Long _
1200 bps / Long oK
600 bps / Long | |
300 bos / Lona 2 Cancel

IAS is the abbreviation for ISO-ASYNCHRONOUS and SYNCHRONOUS modes. Iso-asynchronous modes
have start and stop elements like Baudot, but the code words have an integer number of elements. The
IAS function is used for the extremely accurate baud rate estimation of a synchronous or iso-
asynchronous bit stream.

The automatic phase correction for the ideal bit center sampling (bit synchronism) is completely inde-
pendent of the IAS function and is always active. The extremely accurate baud rate determination uses
the number of necessary phase correction steps for the baud rate determination.

In modes working with an interrupted data stream such as PACKET-300, it may be advantageous to be
able to switch off the baud rate correction to prevent drifting of the pre-selected baud rate. When the IAS
function is disabled, any pre-selected variable baud rate will be treated in the same way as a fixed baud
rate.

In most of the VHF/UHF modes the IAS is permanently disabled. This is due to the lack of phase coher-
ence between successive data blocks. An exact measurement of the phase shift is not possible for an ex-
tended period of time.

In the event of adverse HF reception conditions (fading), enabling IAS may offer substantial advantages.
The software will decrease the size of the phase correction steps in accordance with the verified, reduced
phase errors, and thus prevent bit glitches and the resulting loss of synchronism. It is therefore recom-
mended to enable IAS as a default.

Tick the IAS menu item to enable IAS.

Letters/Figures...

This option is only available for ITA-2 based modes.

The Letters/Figures dialog box contains the options Normal, Letters Only, Figures Only and Unshift
on Space (UOS). Letters and Figures designates the ITA-2 lower (letters) and upper (figures) cases.

For reception under normal conditions the selection of one case or the other is controlled by the reception
of the shift characters.

Special alphabets, e.g., Chinese, comprise only letters so forcing a shift into lower case mode may be an
advantage (Letters Only). Selecting this function may also be advantageous when searching for a bit in-
version pattern, as the pattern may be more easily recognized.

In weather code transmissions five figure groups are used - in this case one may force a shift into upper
case (Figures Only).

The Unshift on Space (UOS) function forces a shift into lower case after a space character has been re-
ceived. In this manner the readability of the transmission may be enhanced under poor conditions (weak
signals or interference).

Compared to the Letters Only mode, UOS has the advantage that single, upper case characters like peri-
ods/full-stops and commas are correctly printed. The drawback is that the software will incorrectly shift to
lower case when receiving figure groups separated by space characters.

Message Type...

These are mode specific parameters.
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r ~
Message Type E Message Type @

|

_ = 1.3 ASCIL 0:BIN

Data format

Number of data bits:

Number of stop bits: |1

Parity bit: NONE -

Bit sequence order

@ LSB ) M3SB
Data polarity

@ NOR 1INV
Display

Display format: ITAS [ASCI) -

Auto Detect

Start Idle

[ oK ][ Cancel ][ Apply

Message Type is used to apply terminal specific settings like:
» SYNC/ASYNC
» Number of databits
> Parity bits
- NONE
- EVEN
- 0ODD
- MARK
- SPACE
» Number of stop bits
> Bit Sequence order
- MSB
- LSB
> Display format
- ITAS5 (ASCII)
- ITA2
- HEX
- BINARY

- S5066: The STANAG5066 parser can be used with the NATO and MIL-STD modems (like
STANAG4285, STANAG4539, MIL-STD-110...)

- Display format
» If you press the Activate Button, the software tries to evaluate the following parameters:
- SYNC/ASYNC
- Number of databits
- Parity bits
- Number of stop bits

- Display format
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Modem Settings...

Modem Settings [&J

Path server  C:tlJserstPublic\Documents\WAVECOM WWCODEDATA. [ ]

Path client | C:4UserstPublichD ocuments\wWEYE COM YW CODENDAT A-

| Close ‘ [ appy

For the modem modes additional parameters can be set in the Options | Modem Settings... dialog box.
These settings are:
> Path server: Set the Windows directory for the output files on the server.

> Path client: Set the Windows directory for the output files on the client computer. This setting is
only enabled on a remote GUI.

MSI

MSI (Multiple Scroll Inhibit) is a function which will suppress multiple linefeeds (LF). In addition, a
software generated Line Feed (LF) is inserted when a carriage return is received.

Using this menu item, the function may be separately toggled on and off for the video output.

Using the MSI function has several advantages. During disturbances in reception a carriage return charac-
ter may be lost - using MSI prevents lines being overwritten and text being lost. It should also be consid-
ered that some stations do not transmit carriage returns: in this case the MSI function will automatically
generate the missing carriage return. To clearly divide a message into paragraphs, many carriage returns
are often transmitted.

Resync Mode

This function forces a re-synchronization of the current mode.

Signal Polarity

If you select a FSK or PSK demodulator in Bitstream Output or Autocorrelation mode, then signal po-
larity definition is available.

Signal Polarity {-J&-J

oK

| cancel |

| Defauttst |

[change Ordel|

Pressing Change Order will reverse the polarity of the signal and pressing Default ST will restore the de-
fault value.

Symbol Definition

If you select a PSK demodulator in Bitstream Output or Autocorrelation mode, then a symbol defini-
tion is available.
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Symbal Definition

Cancel

| Defaut 5T

Edit List
@ Edit Nurber
Change Order

Pressing Change Order will reverse the polarity of the signal and pressing Default ST will restore the de-
fault value.

By right-clicking on the display a menu appears.

]
Edit List 25

W= s WS

.
SAT Settings...
SAT Settings I.éL
Services
Select service(s) to monitor.  [V|FaX [J]DATA  [V]TEL ISDN TELEX SM TELEX MM
Data output paths
Server: C\Users\Publicy Browse...
Client: C\Users\Public
‘Watchlist
All MES IDs | Individual MES IDs /| MES ID Ranges
12 ‘ Add | Enabled  StartID End ID Enabled  startID End ID
4 _—
42 \Remu\,e| 7 &0 to 100 0 to o
5 501 to 520 0 to 0
6
7 0 to 0 0 to 0
g
89 0 to 0 0 to 0
9
0 to g 0 to g
[ ok || cancel | [ Appy |

L 4

For the SAT Modes, additional parameters can be set in the Options | SAT Settings dialog box.

These settings are:
> Service: Select the service to monitor. Choose between:

FAX/DATA/TEL/HSD/TELX_SM/TELX_MM. There are two different possibilities for monitoring
telex:
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- TELX_SM: Single message monitoring: only the telex of the MES found in the Control Channel
will be recorded.

- TELX_MM: Multi message monitoring, the mode stays on the TDM channel until there are no
more Telex transmissions on this channel.

Server: Set the Windows directory for the output files on the server.

Client: Set the Windows directory for the output files on the client computer. This setting is only
enabled on a remotely-connected GUI.

> Watchlist: Click the All MES IDs box, if all MESs must be monitored; leave this box empty if only
specific MESs should be monitored. Enter these MES IDs into the combo box. If ranges of MES IDs
should be monitored, enter and enable each range.

See “"SAT System” on page 312.

Toggle

Clicking the Toggle function will immediately switch from the current case to its opposite - i.e., from Let-
ters to Figures or vice-versa. Thus an incorrect case shift caused by a character received in error may be
corrected at once and the proper case restored.

Time Stamp...

Clicking Time stamp offers a selection of different time zones for time stamping text output. Time stamp-

ing has a resolution of 1 millisecond (ms). Time stamp can be switched off at a later time through this
menu.

f Time Stamp &11

oca
Univerzal Time Coordinated [UTC)

To display the time stamp a new window is opened on the left hand side of the screen. When a text line
has been displayed, date and time is displayed in this window. This function is available for all text output
modes.

1. WAVECOM W-CODE - T -Cordd e
Fle [-Modes \MAME-OR VE/UMFSUB Seichit Factbodems Qplions Demodstor Fvortes Sonfguntion Yiew Wmdow e
m Doudrte 625 o = s

JGdudd BA @ | [Mede [Analysis) ¢ ~ o BMERE ¢ GO & + [ AWz 30Hz

5 Text - Card1 E=mEen o |

Demodulster. 1 Shift: 50 Hz Center: 1969 Hr Offse 0 He Input: AF (LEFT)
M
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Demodulator Menu

Demodulator | Favorites  Conf

Auto |

Mode... %
PB Center... I
PE Bandwidth...

Center...

Shift...

Baudrate...

Offset...

Input...

Gain...

Using the Demodulator menu all parameters for decoding may be edited. In addition to baud rate, the
options and values for mode, shift, center frequency, offset frequency, input and input gain may be man-
ually entered.

The availability of the functions depends on the active mode.

Auto

Click on the Auto button to enable a mode. Shift, center frequency and baud rate is automatically calcu-
lated and adjusted. The new value is selected by double-clicking on the preset value or by clicking OK.

Mode...

In the Mode menu the demodulator mode may be selected.

Most HF, VHF or UHF modes feature a pre-selected demodulator mode for optimum performance, but
sometimes different demodulators may be chosen.

AM

Satellite weather charts are transmitted using AM. This demodulator uses the quadrature I/Q demodula-
tion method.

The level displayed by the level indicator corresponds to the AM modulation depth of the signal. The gain
and the amplitude offset may be set using the Demodulator menu.

BPSK

BPSK shifts the carrier phase £180 degrees. For carrier recovery a Costas loop is used - this is a PLL with
a special phase comparator, which removes the payload data from the PLL loop. The input signal is then
down-converted to base band by mixing the carrier in a complex mixer, and the resulting signal is the da-
ta signal.

BPSK is almost exclusively used for satellite data links.
Ccw

The CW demodulator utilizes a steep, adaptive band pass filter and automatic amplitude control. The AGC
attack time may be adjusted according to the propagation conditions. The filter response may be set to
Slow, Normal or Fast. This demodulator produces high quality CW decoding. It is important to select the
appropriate receiver AGC response (normal or slow).

DSP

The DSP mode utilizes an I/Q demodulator (Hilbert transformation). The received signal is split into an in-
phase component and a quadrature component. Next, amplitude normalization takes place and the result-
ant signal is used for the frequency conversion. This method is characterized by a linear relationship be-
tween the received frequency and the output voltage of the demodulator.

The DSP demodulator has a good signal-to-noise ratio and yields very good results under most conditions.
DPSK

In differential PSK the absolute carrier phase cannot be used for data recovery as is the case with BPSK
and QPSK. To decode multiphase DPSK (up to 16DPSK) the input signal is mixed with a complex, phase
regulated reference signal. The resulting data reduced signal is then filtered in a low pass filter. The fol-
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lowing phase comparator calculates the phase difference between the signal from the integrator and the
delayed signal.

A variant of DPSK is used almost exclusively when phase modulation is employed on short wave data
links.

DBPSK

Similar to DPSK, but has two phase shifts at £ 180 degrees.

DQPSK

Similar to DPSK, but has four phase shifts at £ 90 and £ 180 degrees.
DTMF

This demodulator handles multi-frequency signals. Filters are switched in on the various frequencies of the
signal and the amplitude is then calculated for each frequency. Next the amplitudes are evaluated. Two
simultaneous tones are demodulated. The SNR is the same as for the mark-space demodulator.

DXPSK

Adaptive DPSK demodulator for PACTOR-II. This demodulator will automatically adapt itself to DBPSK,
DQPSK, D8PSK or D16PSK.

D8PSK
Similar to DPSK, but has eight phase shifts at £45, £90, £135 and + 180 degrees.
D16PSK

Similar to DPSK, but has sixteen phase shifts at £22.5, £45, £67.5, £90, £112.5, £135, £157.5 and
+180 degrees.

FFSK and GFSK

Depending on the mode, the FFSK (Fast Frequency Shift Keying) and GFSK (Gaussian Frequency Shift
Keying) demodulator is automatically selected. Basically this demodulator utilizes the I/Q principle (Hil-
bert). However, filters are adjusted to accommodate the special demands of these modes.

MFSK

This demodulator handles multi-frequency signals. Filters are switched in on the various frequencies of the
signal and the amplitude is then calculated for each frequency. Next the amplitudes are evaluated. De-
pending on the number of tones used, the filters are configured as phase linear FIR filters or as IIR filters.
The SNR is the same as for the mark-space demodulator. Simultaneous multi-tone decoding (e.g., DTMF)
is not possible with this demodulator.

MS (Mark-Space)

The mark-space demodulator processes the two keying frequencies of a FSK signal. These are fed to two
phase linear FIR filters and the amplitude is then calculated. The mark-space demodulator exhibits an ex-
tremely good noise distance and should be used for all FSK modes utilizing a speed of less than 300 Baud.

O0QPSK

Carrier recovery is mandatory to demodulate OQPSK. As OQPSK has phase shifts at £90 degrees, the sig-
nal must be squared two times to produce a carrier at four times the original frequency. A PLL recovers
the carrier in frequency and phase with ambiguities at £90 and £180 degrees. A complex mixer down
converts the signal to base band and the resulting signal is the data signal. In contrast to QPSK, OQPSK
has only phase steps of £90 degrees in one step. First the in-phase part is switched, then after half a
symbol duration the quadrature part is switched. The advantage of this process is a smaller amplitude var-
iation.

OQPSK is used almost exclusively for satellite data links.
QPSK

Carrier recovery is mandatory to demodulate QPSK. As QPSK has phase shifts at £90 and £180 degrees,
the signal must be squared two times to produce a carrier at four times the original frequency. A PLL re-
covers the carrier in frequency and phase with ambiguities at £90 and £180 degrees. A complex mixer
down converts the signal to base band, and the resulting signal is the data signal.

QPSK is almost exclusively used for satellite data links.
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SUBTONE

The same as DSP, but the parameters are optimized for low frequencies.

PB Center...

Click on the PB Center menu item to adjust the center frequency of the passband filter.

For more details see “Passband Filter Support” on page 81.

PB Bandwidth...
Click on the PB Bandwidth menu item to adjust the bandwidth of the passband filter.

For more details see “Passband Filter Support” on page 81.

Center...

Click on the Center menu item to adjust the demodulator center frequency within 1 Hz accuracy. For
modes utilizing direct FSK this button is not available: in this case the offset frequency is equal to the ef-
fective center frequency.

Shift...

Click on the Shift menu item to adjust the frequency shift in 1Hz steps. In HF modes the range is 50 Hz -
3500 Hz, and in VHF-UHF modes using direct FSK the range is 50 Hz - 16000 Hz.

Baudrate...

Click on the Baudrate menu item to enter a new value. Depending on the mode, the baud rate dialog box
contains preset values which may be directly selected. The new value is selected by double-clicking on the
preset value or clicking on OK.

Polarity...

Click the Polarity menu item to toggle between normal and inverse polarity.

Offset...

Adjusting the offset frequency and the center frequency will adapt the decoder input to a receiver IF out-
put.

The minimum offset frequency resolution available with the decoder is 1 Hz. The effective center frequen-
cy is the sum of the offset frequency and the center frequency. The function is similar to the mixing of the
signal frequency and BFO of a receiver.

An exception is the FFSK demodulator for direct frequency modulation: in this case the indicated offset
frequency is equal to the effective center frequency.

An example for an HF receiver and ARQ-E mode:

» Receiver IF 455,000 Hz

> Offset 453,300 Hz

» Center 1700 Hz
The advantage of this method is that the user only needs to know the center frequency.
Another example for a VHF-UHF receiver and POCSAG mode:

» Receiver IF 455,000 Hz

» Offset 455,000 Hz

» Center O Hz

In this case the offset frequency is equal to the center frequency.
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Input...
W-PCI and W-PCle cards support a humber of inputs:

F |
Signal Input @
AFIF#1
IF70=1a
IF70#1b
AFIF#2
PxGF 12001
DMR
Cancel

> AFIF#1, AFIF#2 are two physically independent inputs. They have a range of 50 Hz-25 MHz.
These inputs should be used when the source is an AF output (line or speaker), or an IF output of
a communication receiver or digital recorder.

> IF70#1a, IF70#1b, IF70#2 are IF inputs at 70 MHz with a bandwidth of 35 MHz (52.5 MHz -
87.5 MHz). This IF is common for satellite equipment. The first two (IF70#1a and IF70#1b) and
the third (IF70#2) are of two independent channels.

> PXGF 12001 is an example of “Custom Input” with PxGF format.
> DMR is an example of "Custom Input” in .wav file format.

For details regarding “"Custom Inputs...” see on page 59.

For a soundcard device following inputs are available:

Signal Input

» AF(xxx) These inputs are used when you work with the sound card. The frequency range depends
on the sound card specification. You can also apply IF to this input, as long as your signal is within
the supported bandwidth of the selected sound card input.

» 1IQ is used for analogue IQ signals, with the I and Q channels sent to the left and right channel of
the soundcard respectively.

» STANAGA4285 is an example of "Custom Input” in .wav format.
» PXGF1 is an example of “Custom Input” with PxGF format.

For details regarding “"Custom Inputs...” see on page 59.

Gain...

When you choose a WAVECOM hardware W-PCI or W-PCle as device and connect a signal to an input for
the first time, you should use the Automatic Level Setting to adjust the hardware to the input signal level.
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[ Gain &11

ALS Status

ALS off

U

0 20 40 &0 80 100

ALS - Automatic Level Setting

h

ALS for W-PCl and W-PCle device.

Click the “Autoset” button, after the adjustment is finished you can adjust the signal level by moving the
level slider. The gain parameters are saved in the system, i.e., it is not necessary to do ALS when the
same signal is connected to one input.

For other audio devices, e.g., soundcards only manual gain adjustment by the slider is available. The input
gain can be adjusted between 0 and 100% of the nominal input sensitivity of the selected input. When the
gain has been adjusted to the desired level, press OK to save the setting.

The adjustment is valid only for the selected input. The gain setting for each input is separately saved in
the application initialization file.

Gain adjustment should never cause the red bars of the level indicator to be lit.

Gain &J‘

U

o 20 40 &0 80 100

Gain adjustment for soundcard.

Favorites Menu

oo |
The Favorites menu lets the user save and reload a mode and its corresponding settings, i.e., mode, al-
phabet, center frequency, baud rate etc. The settings are saved in a *.WFV file.
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Open...
rW Cpen ﬁ-‘

ONE

\:j\:j | . v Computer » O5(C:) » Transfer »

Organize » Mew folder

4 Downloads -

=1 Recent Places

Bl Desktop
4 Libraries W-CODEVZ00
3 Read Update .
a_\. Rolf Haenggi 12.11;010 il No preview
1% Computer available.
& o5 () L
4 DVD RW Drive (E}) =
5 rolf.haenggi (\wcUserShares) (M:)
5# company (\owe) (M)
® audio (\we) (0:) - BAUDOT2 wiv B

m

File name: BAUDOT2.wfv - [WAVECOM Favorite Files (*.wfv v]

[ open |v] [ canca |

L 4

Select Open to reload the settings.

Save As...
Save As ﬂ-‘

—~—r
uu | » Computer » OS(C:) » Transfer » v|¢’|| Search Transfer }3'

4
i3

Organize « Mew folder = - (2]
.l -
0 Favorites B

Bl Desktop
= W-CODEV7.00
Download =
& Downloads Read Update

= Recent Places 1211.2010

»

Bl Desktop i
- Libraries
A Rolf Haenggi
1% Computer
& os(ca
File name: -

Save as type: [WAVECOM Favorite Files (*.wfv) V]

m

- BAUDOTZ wiv -

~ Hide Folders save | | Concel |

b

Select Save to save the settings.

Configuration Menu

[Configuration] View Window Help
W-CODE Device...
Font...

Temp Files...

Settings...

Receiver and Satellite Settings...
License...

Custom Inputs...

Custom Alphabets...

5R Fine Tuning...
SR Calibration

In the Configuration menu all general setup functions are available.
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W-CODE Device...

The first time the decoder application is started with the decoder card installed, the location of the decoder
devices must be set.

- T —
Server
Loca Host address or name Port Speed limit (Baud) w
Remate  |127.00.1 33243 No CODE
Disconnect |
Server Devices
|:| Mo device
Mame Connections Device Serial number
soundcard 1 Line In {Realtek High Definitio V1.1 1927840122
G3S5ddc Line 1 {WiNRADIO Virtual Sound V1.1 1527840222
@ DevicaC 1 W-CLOUD G33DDC (Wavecom) V2.0 0343973651
DeviceD No Device
DeviceE No Device
DeviceF No Device
DeviceG No Device
DeviceH Mo Device
W-CLOUD Networking
Index Remote host Port Auto connect Encryption Sound Status
1 weloud73651 52001 v| o (&)
Add || Delete | Restart |
Close |

% —|

In the example above, the W-CODE software is looking for devices in a local computer and remote W-
CLOUD devices as defined in the "W-CLOUD Networking” section. The process should only take a few sec-
onds.

A Virtual Audio Cable and a soundcard are detected on the local computer. The entry shows the type of
product found as well as the serial number (generated from part of the active MAC address of the comput-
er network interface and a counter).

Important: If you see Error in the device field, there is a problem with the soundcard driver or hard-
ware. Try to reinstall the correct driver.

Windows Vista or Windows 7: Sound card inputs are only detected when a cable or microphone is
plugged in. If you connect a cable, restart the WAVECOM server, otherwise the devices will not be listed in
the WAVECOM software.

Each device is identified by a unique serial number. Thus the application is able to search for devices au-
tomatically; this functionality is available for local as well as remote computers - pressing the Connect
button will start the process.

The selected entry is stored in the initialization file (*.INI file) for the card or device and no further entry
is necessary, when the application is restarted. The settings may be changed at any time.

The system can be used in a network configuration. This allows the system to be remotely controlled.
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Font...

Clicking Font opens a configuration window.

Font: Font style:
| -
Webdings obIigu
VesTwnd LET Pl & Beld
Wingdings [)| |Beid obliig
Wingdings 2 - -

Sample

RaBbYyEE
Seript

S

Important: Please, note that changing the font and changing the alphabet are two different actions. If
you change the alphabet, then you select a table in a Unicode Font. If you change the font, then you
change the graphical representation (Arial, Courier etc.) of the characters of an alphabet. You may run in-
to problems if you select a nhon-Unicode font and change the alphabet.

For some types of transmission it will make sense to change the font - this depends on the software that
was used for the transmission.

Temp Files...

Clicking Temp Files opens a configuration window.

Set the number of lines to be kept in temporary files during this session. The oldest
lines will be deleted automatically when the number of lines exceeds this number.
Enter 0 to allow an unlimited number of lines.

Text modes

Maximum number of text lines: [1000-10000000)

Fax modes

Maximum number of pixel lines: 10000000 (1000-10000000)

F3K analysis

Maximum number of lines: 10000000 (1000-10000000}

Sonagram analysis

Maximum number of lines: 100000 {1000-2000000)

You can set the number of lines to be saved to temporary files during a session. These limits allow a user
to leave his computer on for days, while not exhausting hard drive space.

If the temporary files are larger than 50% of free disk space, it will not be possible to save your recording
as a new copy of the temporary file(s) is made when you perform a save operation.

You can select different values for:
» Text modes
» Fax modes
» FSK analysis
» Sonagram analysis

Selecting high values allows the user to scroll back over a longer time, but requires more memory and
hard disk space.
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Settings...

Clicking Setttings... opens a configuration window.

Settings

s

Global Settings

Jwihen selecting "Fiint” include hont page containing all mode: settings:

J|'When selecting "Clear Screen' thow warning before deleting all data.

| 'When selecting "Exit" save last used made.
‘When selecting "FFT" and "PSE Symbol Rate" pause graphics while cursors are active.
Enable the Backspace support.
Enable reconnect ta cards on remate computer.

Enable relative frequency display.

Restore defaults oK | Cancel |

You can enable or disable different options, to control the behavior of the application:

>

When selecting "Print"” include front page containing all mode settings. Enable or disable
the printing of a status page with all mode settings if you use the Print command.

When selecting "Clear Screen" show warning before deleting all data. Enable or disable
the display of a warning window before the screen is cleared when you use the Clear Screen
command.

When selecting "Exit" save last mode. Enable or disable storing of settings from the last
mode. If enabled, the decoder will start again in the latest mode used.

When selecting "FFT" and "PSK Symbol Rate" pause graphics while cursors are active.
Enable or disable the automatic freezing of the graphic as long as the cursors are displayed.

Enable the Backspace support. Sometimes in modes like PSK-31, the operator is sending back-
space characters. If backspace support is enabled, backspace will work as for an ordinary terminal
program.

Enable reconnect to cards on remote computer. Enable or disable the GUI to reconnect to a
card on a remote computer. If enabled, the decoder will reconnect to the card on the remote com-
puter.

Enable relative frequency display. You can select if, in the FFT, sonagram etc displays, the “re-
al frequency” (center frequency+offset) or the “relative frequency” is displayed.

Receiver and Satellite Settings...

These settings are used for satellite modes and analysis, and give the operator the possibility to configure
receiver or down-converter frequencies, and to select a satellite and receiver type. The receiver or down-
converter control interface to be controlled is connected to a serial port of the computer. Receiver center
frequency is preconfigured to 1542 MHz for the L-Band settings and 3544.5 MHz for the C-Band settings.
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Satellite Settings

Downconverter DDC

“x =P s

L-Band center frequency = 70MHz

C-Band center frequency = 70MHz

Satellite/receiver type

Settings in use: © ) C-Band
L-Band settings
Center frequency: Oscillator frequency: DDC frequency offset:
1'542'000'000 Hz 1'472'000'000 Hz 0 Hz
C-Band settings
Center frequency: Oscillator frequency: DDC frequency offset:
3'614'500°000 Hz 3'544'500°'000 Hz 0 Hz

Ocean region

Inmarsat Ocean Region NCSC: Atlantic-East, 16 west v
Default Settings l oK ] [ Cancel ] [ Apply

The GUI displays a number of input fields:
» Ocean Region. Select the ocean region satellite pointed to by the monitoring antenna.

> Oscillator Frequency. Set this parameter to the frequency of the local oscillator used, or set it to
0 if an external converter or mixer is not used.

> Frequency Offset. Find out how accurately the receiver sets its frequency. Use the real-time FFT
item in the Analysis DIRECT menu and select a bandwidth of 24 kHz to find out the frequency
offset of the receiver. Adjust the receiver to the NCSC frequency of the appropriate ocean region.
Following this, the NCSC signal should be centered exactly in the FFT display. The adjustment ap-
plied to centre the NCSC signal is the offset (make it accurate to 500 Hz or less).

> L Band and C-Band Center Frequency. Exact value of the L or C-band frequency that is con-
verted to 70.000 MHz.

License...
When License... is clicked, W-CODE displays the CodeMeter Webadmin page.

CodeMeter WebAdmin C\d

ﬁ]nhalt Server FEinstellungen Diagnose  Info Hilfe
CmContainer Lizenzen Benutzerdaten Datensicherung

CmContainer:[1-114637  [v]
100003 | Bundling Articles
e e mae o
SecuriKey Lite n/a n/a n/a 1
100787 | WAVECOM ELEKTRONIK AG
Pproduct Code Name Nutzungs- Verfalls- Aktivierungs- Lizenz-
einheiten datum datum anzahl
1 WCODE n/a nfa n/a 10
2 W-SPECTRA n/a n/a n/a 8
E W-SPEED n/a n/a n/a 2
30 W-CL n/a n/a n/a 10
100 WCODE Server n/a nfa n/a 10
120 W-CLOUD n/a n/a n/a 10
200 W-SPECTRA Server n/a n/a n/a 2
201 0-W-CLNB n/a nfa n/a 1
101440 | Phoenix COMINT Appli
EE @ e Nutzungs- Verfalls- Aktivierungs- Lizenz-
einheiten datum datum anzah!
201 WCLNB {DEMO) n/a n/a n/a 1
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User can choose the tab “"Content -> License” to view the license available on the PC.

For Wavecom hardware decoders W-PCI, W-PCIe and W74PC a dialog window opens for the user to input
a 25 alpha-numeric key. The key will be checked with the card serial no. and the software version.

r© N
License @

License key:

UFGE | - sovws - CEAOC - MIFWH - HHGED

License details
Update Through:  12/2017

Version: 0o
Yalidation: oK
Card Serial #: 0343937400

Enabled options
Classifier

W-BitWiew

Ok ]I Cancel J'J

L

An example of the 25-alphanumeric-digit license key.

The license key is permanent, i.e., a valid key can run the software without time limit.

The “Update Through” in the “License details” shows the license key can run software released before a
certain date.

Custom Inputs...

To add a customer defined Input, all other decoder windows must be closed. The number of custom inputs
is limited to 16.

Streaming and custom inputs belong together. A new custom input has to be defined before streaming can
be used to acquire a specific data stream for decoding. At the moment, streaming can be defined for
TCP/IP data, sound card devices (real or virtual) and for .WAV-files. If a custom input is selected as the
input source, the data stream is read from the specific input.

For defining, editing and deleting a custom input, the dialog Custom Inputs is used. The properties of
the custom input are stored in a XML file. The defined custom inputs are selectable like any other input
sources.
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In the screen shot below two user-defined inputs appear.
Custom Inputs o wewe Ld ﬁ

Available custom inputs: Selected custom input parameters:

prgfl 2004 Parameter Walue

Mame pxofl2004

Device Metwork

Port 12004

Format IP-PuGF

Channel Maonao [Single Channel)

baudot

Add ok |[ canci

> In the left table, the user defined custom inputs are listed.

» In the right table, the parameters of the currently selected custom input are displayed. The Pa-
rameter column contains the names of the parameters, and the Value column shows the related
parameter values.

» The Add button is used to create a new custom input. The Apply button saves the parameter set-
tings of a newly created or an edited custom input. Pressing the Delete button removes a selected
custom input.

The following picture shows the Custom Inputs dialog after pressing the Add button.

Custom Inputs e weww Ld - M
I e

Available custom inputs: Selected custom input parameters:

prgfl2004 Parameter Value
baudot

Mame MewlInput3
S Deviee Select Value

[ o< [ concet ][ avpw ]

The Input Name can be edited in the right table by typing a new name into the Value field if desired.

Next, the device type has to be specified. File, Network or Soundcard (for W-PCI, W-PCle, W74PC and
W61PC hardware decoders) can be chosen from the list box that appears by clicking on the Choose a de-
vice type.
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i -
Custom Inputs - w ;’ v -' . - M

Available custom inputs: Selected custom input parameters:

pgfl2004 Parameter Value
baudot
MewInput 3

Mame MewInput 3
Device File

Metwark

ok || cancet ][ appy

Add a new WAV-File Custom Input

Select the Configuration | Custom Inputs... menu entry to open the configuration dialog for the custom
inputs.

To use a WAV-File as signal input source, the following parameters have to be set via the Custom Inputs
dialog:

Custom Inputs LEJ -J' v - . . u

Available custom inputs: Selected custom input parameters:

pigfl12004 Parameter Value

baudet MName baudot

Device File

File Path [»t\Continuous\BAUDOT 75 BD, EX. vWO, ]
Repeat Yes

Channel Manao (Single Channel)

o5 _conen ) [_oomn
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File Input Parameter %

Input Name The name of the custom input

Device Select File in the list

File Path The path to the specific WAV-file has to be specified

Channel In the list box the channel(s) to be used are displayed: Mono, Left, Right, Left + Right

(PCM) and Left & Right (IQ)

If you start by entering the filename, then the file is analyzed and the correct settings are
automatically selected

Play Continuous Indicates if the files are played in repeat mode. Select On to switch on the repeat mode or
Off to switch off the repeat mode

The file can be selected from any available directory on the LAN. The specified WAV-file is copied to the
Data-Input directory (on the computer hosting the decoder) and stored under the name
<SerialNumberOfW[xx]Card>_<InputName>.wav.

Note: The WAV-file is reloaded each time the Apply button is pressed. The Apply button must also be
used to save the configuration of a new custom input. Pressing the OK button only closes the dialog. The
XML file CustomInputs.xml, located in the Config directory, is updated by pressing the Apply button.

Add a New Sound Card (Real or Virtual) Custom Input

Select the Configuration | Custom Inputs... menu entry to open the configuration dialog for the custom
inputs.

To use a sound card as the signal input source, the following parameters have to be set via the Custom
Inputs dialog:

[ w
Custom Inputs .; e =l - o g

Available custom inputs: Selected custom input parameters:

soundcard Parameter Value

Mame soundcard

Device Soundcard

Soundcard Mame Line In [Realtek High Definitio
Channel Left [Dual Channel)

Add | [ Delete [ ok [ cance ||

Soundcard Input Parameter ‘ Value ‘

Input Name The name of the custom input
Device Select Soundcard in the list
Name The names of all soundcards installed on the computer are displayed in a list box.

Select one soundcard

Channel In the list box the channel(s) to be used are displayed: Mono, Left, Right, Left +
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Right (PCM) or Left & Right (IQ)

Sampling Rate [Hz] The sampling rate is fixed at 48 kHz

Note: If the GUI is running in remote mode, the names of the sound cards installed on the remote com-
puter which hosts the WAVECOM decoder are listed.

Add a new TCP/IP Custom Input

Select the Configuration | Custom Inputs... menu entry to open the configuration dialog for the custom
inputs.

To use a TCP/IP stream as signal input source, the following parameters have to be set via the Custom
Inputs dialog:

TWS O wmewe [

Custom Inputs

Available custom inputs:
pxgfl2004

baudot

pocsag

Selected custom input parameters:

Value

pgfl2004

Metwark

12004

IP-PxGF

Maonao (Single Channel)

Parameter
Mame
Device
Port
Format
Channel

:

ok |[ cancar ][ apowy

Input Parameter ’Value—‘

Input Name The name of the custom input

Device

Select Network in the list

Port number

Enter the a port number. The data source must be configured with the same port num-
ber

Format

IP-CONF, IP-PXGF or VITA-49 (for more information, see *“WAVECOM Data Formats”
on page 343)

Sampling Rate (Hz)

The sampling rate used by the data source

Number of channels

Number of channels

Channel

In the list box the channel(s) to be used are displayed: Mono, Left, Right, Left +
Right (PCM) and Left & Right (IQ)

Add a new VITA-49 Custom Input
VITA-49 is a standardized stream format which is specified in ANSI/VITA-49.

To use a TCP/IP stream with VITA-49 format as signal input source, the following parameters have to be
set via the Custom Inputs dialog:
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Custom Inputs

Available custom inputs:

"W  weww

Selected custom input parameters:

pxgfl2004
baudot
pocsag
vital2000

Parameter

MName

Device

Part

Format

Sampling Rate (Hz)

Channel

VITA-49 Event Tag Size (bits) [0]
VITA-49 Channel Tag Size (bits) [0]

VITA-49 Ttem Packing Field Size [bits) [16]

VITA-49 Data Item Size [bits) [16]
VITA-49 Repeat Count [1]
VITA-49 Vector Size [1]

VITA-49 Data Sample Format

VITA-49 Data Item Format [Signed Int]
VITA-49 Sample Component Repeating [Ma]

VITA-49 Link Efficient Packing [Na]
VITA-49 Stream ID [0]
VITA-49 Radio Link Packets [Na]

Value

vital2000
Metwark

12000

VITA-49

43000

Left & Right (1Q)
0

0

16

1

1

Real
Signed Int
Mo

Mo

0

Mo

” Cancel “ Apply
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Input Parameter \Value—l

Input Name

The name of the custom input.

Device

Select Network in the list.

Port number

Enter the a port number. The data source must be configured with the same port num-
ber.

Format

Select VITA-49.

Sampling Rate (Hz)

The sampling rate used by the data source

Channel

In the list box the channel(s) to be used are displayed: Mono, Left, Right, Left +
Right (PCM) and Left & Right (IQ).

VITA-49 Event Tag Size

The size (in bits) of the VITA-49 event tag. This parameter is ignored by W-CODE.

VITA-49 Channel Tag
Size

The size (in bits) of the VITA-49 channel tag. This parameter is ignored by W-CODE.

VITA-49 Item Packing
Field Size

The size of the item packing field. This field contains the event tag, the channel tag and
the data item, so the size must be at least (Event Tag Size) + (Channel Tag Size) +
(Data Item Size).

VITA-49 Data Item Size

The size of a data item. The data item contains the actual sample data.

VITA-49 Repeat Count

The repeat count. It is not supported by W-CODE and should be set to 1 as default.

VITA-49 Vector Size

The vector size. W-CODE does not support vectors, so this value should be set to 1 as
default.

VITA-49 Data Sample
Format

VITA-49 supports the following data sample formats:
¢ Real: Real samples. Each sample consists of 1 data item.

e Complex Cartesian: Each sample consists of 2 data items, which are the real
and imaginary parts of a complex number.

e Complex Polar: Each sample consists of 2 data items, which are the vector
length and the angle of a complex number.

VITA-49 Data Sample
Format

The format of a data item. VITA-49 supports the following data item formats:
e Signed Integer.
e Signed VRT (1-6 bits).
e Unsigned Integer.
e Unsigned VRT (1-6 bits).
e IEEE 754 Float (32 bits).
o IEEE 754 Double (64 bits).

VRT is a special floating-poiint format of VITA-49, using 1 to 6 bits for the exponent and
the rest for the mantissa. Using VRT instead of one of the IEEE formats can reduce the
amount of TCP/IP data stream, and save streaming bandwidth.

VITA-49 Sample Com-
ponent Repeating

Sample Component Repeating. Not supported by W-CODE.

VITA-49 Link Efficient
Packing

This flag decides if data items should be packed to reduce the data size in some cases.

VITA-49 Stream ID

The VITA-49 stream id. Stream IDs are accepted but ignored. No filtering is done.

VITA-49 Radio Link
Packets

Enables the use of VITA-49.1 packets. Those packets, in addition to normal packets,
contain a unique identifier at the beginning and also support a CRC. This makes a VITA-
49 link much more robust.

Note: The VITA-49 parameters are default values. If a matching context packet is received that contains a
data stream format description, those values are overwritten by that context packet.
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Edit a Custom Input

Select the custom input from the input list on the left in the Custom Inputs dialog. For instance, select
the baudot entry, which is a file input.

e ~
Custom Inputs - - e ww v @
e
Available custom inputs: Selected custom input parameters:
pigfl2004 Parameter Value
Baudol Mame baudot
p.ocsag Device File
vital2000 File Path [1ous\BAUDOT 75 BD, EX. VWD, Lw.Wav |[]
Repeat Yes
Channel Monao (Single Channel)
[ ada  |[ Detete | [ ok || cance |[ appy |

Now it is possible to modify the parameter values in the parameter table on the right.
For instance, the Input Name or the Channel parameter value can be modified.

Even the Device value can be changed from File to Network. By changing the device the new device-
related parameters will appear in the parameter list and the parameters of the old device will disappear.

By pressing the Apply button, the changes will be saved for the specific custom input.

The XML file CustomInputs.xml, located in the Config directory, is updated by pressing the Apply but-
ton.

Important: After modifying custom input parameters, press the Apply button; otherwise the changes will
be lost.

Delete a Custom Input

Select the custom input to delete in the Input list (left table) and press the Delete button. This will re-
move the custom input from the XML file CustomInputs.xml, located in the Config directory.

Selecting a Custom Input

The user defined custom inputs can be selected via the Signal Input dialog. The dialog can be opened via
the Demodulator menu’s entry Input... or by double-clicking the Input status bar field at the right bot-
tom of the GUI.

The screen shot below shows the Signal Input dialog including four user defined custom inputs at the
end of the list.

Signal Input ﬁ

AF (LEFT) ~
AF [RIGHT]

AF (LEFT=RIGHT)
1Q (LEFTERIGHT)

pocsag
vital 2000 2 Cancel

m
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Custom Alphabets...

Custom defined alphabets are also available. This feature allows the user to add alphabets of his own cre-
ation that have not been defined by WAVECOM, and to add variants of existing alphabets.

Only 5-bit alphabets are accommodated, and the number of custom alphabets is limited to 16.

A Alphabet Translation Table ==
Saveds | Save | Dokt | Undo |
Alphabst  [1T8_2 LATIN ~|  Update List
Font  |'wavecom Unicode ~| ‘Wiiting Direction & | eftToRight
¢ RightToLstt
System |5 kit ™ Transparent
Control Characters
o Letters " Figures " Third Letters Shift -
Curent Hew - -

1 63 A 65 A 5 o

2 66 B 66 B 7 fu

3 €7 ¢ 87  C |z 32

4 68 D 68 D |7 33 !

5 62 E 69 B 34 "

3 70 F 70 F 35 i

7 71 & 71 G « 36 s

8 72 H 72 H 37 %

9 73 I 73 I 38 &

10 74 J 74 J 38 '

11 75 X 75 K 40 (

12 716 L 76 L 41 )

13 77 M 77 M 12 *

14 78 N 78 B 43 +

15 79 o 79 o7 44 . i
0 Find I HexView 0 Find

I Showal
Reset Refresh

The Custom Alphabets... dialog box displays a number of input fields:

» Clicking Save As... opens a dialog box, in which to enter a name for the newly created translation
table. Press OK to close the dialog box and save the new translation table. The translation table
contains the actual values set in the Alphabet Translation Table dialog. The name of the new
table appears in the Alphabet combo box and a new .xml file with the name of the table is creat-
ed containing the table data.

» Pressing Save stores the current dialog settings to the translation table that is active as shown in
the Alphabet combo box. The data is stored in the related .xml file.

Clicking Delete deletes the active translation table.

Pressing Undo will replace the new, user selected values in the dialog box with the values stored
for the current alphabet.

» The Update List is used to add the user created alphabets to the list of alphabets. By pressing the
Update List button, the Alphabet directory is searched for .xml files related to new alphabet. If a
new one is found the list and the Alphabet combo box are updated.

» The Alphabet combo box shows the names of all translation tables. By selecting an entry the
stored data for the specific translation table are displayed. Note that the most recent changes to
the current alphabet are not saved until Save is pressed.

Select the font that is used to display the translation tables by pressing Font.

The Alphabet list control (left list) displays the characters defined for the current alphabet. The
first column shows the position index in the alphabet for the characters. The second column (Cur-
rent) shows the currently defined value of the character at the selected position. The third column
(New) shows the user defined character value. By pressing the Save button, the Current value
becomes the New value.

» The Font list control (right list) displays all the characters defined in the selected font. The first
column shows the decimal or hex character value. The second column (Symbol) shows the char-
acter. Selected characters are copied to the selected rows in the Alphabet list by pressing the Ar-
row (€) button.

» Using the Writing Direction radio buttons, a LeftToRight or RightToLeft output direction of the
decoded text may be selected.
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» The System combo list is used to set the length of the codeword for a user defined alphabet. The
present version allows only 5-bit alphabets.

Click Transparent to select if control characters are to be displayed in the decoded text.

Depending on which radio button, i.e., Letters, Figures or Third, is selected, the letters, figures
or third shift control characters of the current 5-bit custom alphabet are displayed in the list con-
trol.

» The Control Characters combo box contains the control characters that can be added to an al-
phabet, i.e., the Letters Shift, Figures Shift, Third Shift, Unperforated Tape, Space,
Linefeed and Carriage Return characters. Select a character, then press the Arrow (&) button
to copy the selected character to the selected row in the custom Alphabet list.

» The Arrow (&) button is used to move characters to the translation table. Press this button to
copy the selected character in the Font table, or the selected entry in the Control Characters
combo box to the selected position in the Alphabet table.

» The Find button and the edit box to the left of the button are used to find a character (decimal or
hex value) in the Alphabet or Font table.

Press Reset to replace all character values in the custom Alphabet list with *0’.

Press Refresh to reload all characters of the current font and update the display. This feature is
useful when the font has been changed.

Pressing Hex View to display the hex value for all characters; otherwise, decimal values are used.

When Show All is enabled, the positions of undefined characters are displayed in the Font char-
acter table.

» Press the OK button to close the window. Recent changes are not saved - if the latest changes
have to be saved, press the Save button before pressing OK.

SR Fine Tuning

Sound card sampling frequency accuracy is much more critical for sophisticated digital modes compared to
the simple BAUDOT or SITOR modes. The built-in SR Fine Tuning feature can be used to correct errors
that are introduced by an inaccurate soundcard sampling frequency (the tolerance of soundcards can be a
few hundred parts per million).

Sample Rate Fine Tuning l&,l
Fine Tuning ¥alue  1.000000 =
Step  0.000007 -
h

SR Calibration

To check the error of you soundcard, use analysis software that is able to calculate the deviation of the
sample rate in ppm. Try to avoid sound cards that are completely out of tolerance.

When W-CODE uses low-cost sound cards as a signal source, sampling frequency errors will most likely
occur. For commonly available sound cards, the sampling frequency may vary up to one percent of the
nominal value. This behavior prevents decoding or introduces additional errors. Complex signals like the
MIL-Standard and STANAG waveforms are heavily affected.

In previous versions of W-CODE the “SR Fine Tuning” feature was used to correct the sampling rate, but
adjusting the rate was very difficult due to a substantial time lag between the adjustment taking place and
the display being updated. To remedy this problem, a new feature has been introduced under “Configura-
tion | SR Calibration”. The new feature utilizes an AM demodulator, which demodulates the pulses of a
reference signal - the output, which resembles a fax image, is displayed in a calibration window. The de-
gree and the direction of slanting of vertical lines are a measure of the amount and the sign of the devia-
tion between the sound card sampling frequency and the reference signal. The values are stored and used
for all future decoding.

Signal thresholds can be set with a tunable band pass filter, which may be placed anywhere in the spec-
trum with the desired bandwidth. The settings affect the blurring of pulse edges.
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Reference signals which may be used include weather fax transmissions and time signals, e.g., CHU,
DCF77, MSF, HBG etc. For instance, CHU transmits a short tone pulse every second. If the band pass filter
is tuned to the frequency of this tone, a straight, vertical line will be visible if the sampling rate of the
sound card is correct. If the line is slanted to either side the sampling rate is offset. To adjust the sam-
pling rate, use “Options | Fine Tune” until the vertical line representing the reference signal is straight.

Example: CHU signal

WAVECOM W-CODE - W-CODE Calibration - Card 1
Ele HF-Modes VHE[UHF-DIR VHF/UHF-SUB Solelte Modems Cptions Cemodubdor Favorites Conhiguraton Yew Widow bel
Traffic 15:35:31

D81 @| 5| #]5i] B|| Wode| anaysis| |- || #it~| 5| BIMEIE 2| o @] ox oz | mmmm

jcaLERATION

Card 1

W-CODE Calibration

414 Bz al

746 953 1160

o 250 soo 780 1000 1250 1500 1750 2000 2250 2500 2950 3000 3250 3500 3750 4000 [Hz]

Irput: 4F (LEFT)

oemodetoe: AM P Barwidh: 500 He Center: 953He offseti DiHe
1)

First adjust the center frequency and the bandpass filter settings. You will notice that the vertical lines are

skewed.

Press “Options | Fine Tune...” and use the slider to adjust the vertical lines so they become perpendicular

to the time axis of the calibration window.

~ WAVECOM W-CODE - W-CODE Calibration - Card 1

Traffi

D @| @[ | ]| 2| Mode| Analysis| |- || x|~ | 2 @ImIEEE| 2| L) ekl

Sy S

=% : s e :

eSS S LTSS LT LS L TT LTS LS SLS LSS AL ST S S ST S s

ERLS S AL LIS SIS PSS LIS LS EL LSS SS TS LSS S ST o7 P
= Z £

) 240 son 750 1dbo 1250 1800 1750 2000 2250 2500 2750 3000 3250 3500 3750 4000 [He]

Demodator: AM PB Barchwidth: S00Hz Center: 953 He Offset: 0 e Ingas: 4F (LEFT)
)

Note: The full range of the “Fine Tune” process is 0.1% deviation. For deviations larger than this use “Fine

Tune” repeatedly until the desired effect has been achieved.

If you succeeded in correcting the sampling rate, i.e., the vertical lines have been straightened and are

perpendicular to the time axis, press “"OK” to save the measured value.
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WAVECOM W-CODE - W-CODF Calibration - Card 1 PEX
e WF-Modes VHFJUNFDIR VHEILWF-SUB Setelte Modems Cptions Dewodulator Favortes Configwaton Wew Widow Heb
CALIBRATION Traffc 15:35:45

D@ 18| 5| 45| B| Mode| Analysis| |- || &lit]~| 5| WMEIR o] Lc|re) 2k 0x ox -+ mmmm

,WJWUL/JWUM”M WMMAMA Pt

° 250  sio 750 1000 1250 1500 1750 2000 2250 2500 2950 3000 3250 3500 3750 4000 (Hz]

IDemcd fator: AM PB Bandwidth: S0 H: Center: 953z Offset: Oz Trout: AF (LEFT)

T

As the sampling rate calibration feature utilizes an AM demodulator, input level should be as high as pos-
sible, resulting in a high level of contrast which facilitates the adjustments. If necessary use the “"Demodu-
lator” menu to adjust the AM gain and offset.

These two functionalities ("SR Fine Tuning” and "SR Calibration”) are not available when W-PCI or W-PCle
is used.

View Menu
Window Help

Mode Back

Mode Forward

WAVECOM Alarm Monitor
WAVECOM Serial Link

Toolbar
Status Bar

WAVECOM Toolbar

Level Indicator

Spectrum Indicator

Decoder Status Bar

Demodulator Status Bar

RSN NE SRS E SN SRS

FFT/5onagram QON/OFF

In the View menu the visibility of each individual status and indicator element may be enabled or disa-
bled. A checkmark indicates that the element is enabled. A disabled element is not deleted, but may be
made visible at any time.

Window Menu

| Window | Help
New Window

Cascade
Tile

Arrange Icons

v 1W-CODEText - Card1

Using the Window menu new output windows may be opened and organized.

Help Menu

For context sensitive help on a menu item, use F1 on the item.
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Contents
Selecting Contents opens the online help system.

Help on clicked buttons, menus and windows are then available.

WAVECOM on the Web

Contents |

www.wavecom.ch \

About W-CODE... |

Contents access the decoder help file.

www.wavecom.ch links to website of WAVECOM.

About W-CODE

About W-CODE ==

‘w-CODE

“ersion 14.0.0

Build 5543, 10.Jul 2024

Copyright € 1995-2025 WAYECOM ELEKTRONIK AG.
Al rights reserved.

CODE

Displays information on software version, build number, and release date for the installed application.

Other GUI Elements

Toolbar

‘DD“’E 55 Mg ‘@\

Allows access to file, print and search operations. Most functions on this toolbar are also available from the
File menu.

If the mouse is resting for more than approximately half a second on a button, a label with the name of
the function is displayed (tool tip). In addition a short help text is displayed on the system status bar.

Depending on the active mode, buttons for which the corresponding function is not available are grayed.

WAVECOM Toolbar

(Mode] [nayss] = v = & BMEE 2 %1 o

The selection of the most important decoder functions is facilitated by toolbar buttons. Operation is identi-
cal to the use of the menu bar.

If the mouse is resting for more than approximately half a second on a button, a label with the name of
the function is displayed (tool tip). In addition a short help text is displayed on the system status bar.

Depending on the active mode, buttons for which the corresponding function is not available are grayed.

Mode Mode Selector

Analysis Analysis Selector

=] Back - go to last decoding or analysis mode

- History - select one of the last decoding or analysis modes from this drop down menu.
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& - nn_na aQ

EFR o 8
ARQ-E

T FFT HF I

Clear

Go Forward in the history list after going back in the history list

nn Classifier
CL
N Classifier Code Check
CLC
Start/Stop Classifer
FSK Auto Tunin
2 °
FSK Analysis
FFT Analysis

*

Sonagram Analysis

Waterfall Analysis

Resync Mode
:, Y
u Toggle Letter/Figure
wF
FE Maximize Passband
4
(1 Media Player/Recorder
REC
Live Voice
o W-CLOUD Device Settings, to show traffic statistics of a W-CLOUD device and to enable / disable the

L | output of signal from a remote W-CLOUD station to the local speaker

Level Indicator

+ [T

Click on the Gain icon to adjust the input to the correct level. Gain adjustment must never turn on the
red bars of the level indicator.

Spectrum Indicator

50 Hz a 50 Hz

The Spectrum Indicator is a tuning tool consisting of a bar graph, increasing frequency from the left to
the right, which displays the frequencies of the incoming signal. For FSK signals the mark and space fre-
quencies are displayed. For PSK signals the carrier is displayed.

Decoder Status Bar

‘EAUDOT Baudrate: 250.00 Alphabet: [TA2-Latin MNOR Traffic Bit Inv Mask: 00000 18:40:54

The Status Bar displays decoder status information.
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Double-Clicking on Status Bar Fields

Double-clicking the status bar fields will open the corresponding dialog box. This facilitates the use of the
decoder software.

A double-click on the shift field, baud rate field, frequency shift field, etc. of the demodulator status bar
opens the corresponding dialog box.

Selecting a field will not terminate the active mode. As far as possible, value changes will be implemented
immediately, without the interruption of data acquisition.

Demodulator Status Bar

Demeodulator: DXPSK PB Bandwidth: 400 Hz Center: 1859 Hz Offset: 0 Hz Input: AF (LEFT)
The Demodulator Status Bar displays information about the status of the DSP demodulator.
Double-Clicking on Status Bar Fields

Double-clicking various status bar fields will activate the corresponding dialog boxes. This facilitates the
use of the decoder software.

A double-click on the shift field, baud rate field, frequency shift field etc. of the demodulator status bar
opens the corresponding dialog boxes.

Selecting a field will not terminate the active mode. As far as possible changed values will be immediately
used without interrupting data acquisition.

SAT Frequency Tuning Bar

The SAT Frequency Tuning Bar simplifies frequency selection for the satellite modes. In Receiver and
Satellite Settings the user has the ability to store the center frequency of the down converter.

The SAT Frequency Tuning Bar box displays a number of inputs and controls:

Freauency K] (EN0) ZZX0) BXOXE)] += ster[@ 5000 ~| wemory [e=|[=b[[DEL[Edi]| 3609280000 - tdma1 - |44

Frequency =154 1§450§000] User entry field for the real frequency.

In modes with automatic frequency setting the automatically set
frequency is shown.

Step % 5000 - Spinner to increase or decrease the frequency.

List box to select the frequency step for the spinner.

Memory Retrieve a frequency from the selected memory entry.
- Store the current frequency to memory. You will be prompted for
a name. The current frequency will be replaced by the new fre-
quency.
Delete the contents of the selected memory position.
Edit the name of the memory entry.
| 1541480000 - Provider B j List box containing memory entries.
1541450000 - Provider A
41 L Sort buttons for numerical or alphabetical sort of the list box en-
% % tries.
NCSC-Auto Only available in SAT-C-TDM mode. Please, refer to the manual

[# NCSC-Auto section on SAT-C-TDM.
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The SAT Frequency Tuning Bar display elements are mode dependent.
There are three different variations of the frequency bar:
SAT-B, SAT-M, SAT-mM

R 55512200 008

Display of the real frequency. Direct tuning is disabled.
SAT-B-C-TFC, SAT-AERO-P, SAT-C-TDM-EGC, SAT-C-TDMA

ereauency () RN PIERR) GIRRR) - Si=e (@ /5000 =] wemory [«=]= [oi[Edie] 1541450000 - SAT-C-TDM-EGC =] %]%”
Display of the real frequency, frequency memory and step. Direct tuning is enabled.
SAT-C-TDM
| rreauency ] Y] CIE (OIoJ0] #: steo |8 [5000 =] wiemory [e=]=b [oer]Eaid| 1539995000 - TOM-TRAF =] B4l = nescaute

Display of the real frequency, frequency memory and step. Direct tuning is enabled. NCSC-Auto tuning
can be selected.

Waterfall SAT, FFT SAT, Sonagram SAT

| Frequencym Hz Step% |5|]|]|] -

Display of the real frequency and step. Direct tuning is enabled.

The C-band or L-band frequency range depends on the system context set up in the Receiver and Satellite
Settings.

XML Frequency Memories File

All frequencies are stored in XML files c:\Users\Public\Documents\WAVECOM\ <Product>\. Each mode has
a XML file containing its corresponding settings. In addition to frequency entries, the watch list, desired
services, NCSC-Auto status (only for SAT-C-TDM) and demodulators used (only for SAT-AERO-P) are
stored in these files.

The illustration below shows an example of a XML file for the SAT-C-TDM mode, including watch list and
memory positions.

<?xml version="1.0" encoding="UTF-8" ?>
- =SATSettingsList>
- <SATSettings CardSerialNo="0704078620" NCSCAuto="0n"=
=Service sDATA</Service >
- <FreqList>
<Entry Name="test" Value="1539544000" />
<Entry Name="TDM-TRAF" Value="1539995000" />
<Entry Name="aorencsc" Value="1541450000" /=
<Entry Name="SAT-C-TDM-EGC" Value="1541450000" />
</FregList=
- «<MesIDWatchlist All="no">
- <MesIDList Active="yes"=
<MesID>12345</MeslD =
=<MesID=>212121</MesID=
<MesID >6789</MesID =
</MesIDList>
- «MesIDRangeList>
<MesIDRange Active="no" Begin="0" End="0" />
<MesIDRange Active="no" Begin="0" End="0" /=
<MesIDRange Active="no" Begin="0" End="0" /=
<MesIDRange Active="no" Begin="0" End="0" /=
<MesIDRange Active="no" Begin="0" End="0D" />

For SAT-AERO-P a frequency entry contains the demodulator used on a particular frequency.

<Entry Name="aero5" Value="1541450000" Demod="DPSK" Baud="1200.00" /=
<Entry Name="aero?" Value="1545030000" Demod="DPSK" Baud="600.00" />
<Entry Name="aero6" Value="1545045000" Demod="DPSK" Baud="1200.00" /=
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In multi-card systems, each card has its own section in the XML file.

The user may edit these files by hand, however it is recommended to use the SAT Frequency Tuning Bar.
The installation package contains example XML files for each mode.

FFT/Sonagram Context Menu

Pause Graphics

Tuning Cursor

Bandwidth...
Average Factor...
Window Type...
Period...

Peak Hold...
Display Settings ...

v | Grey
Hot
Coal
Copper
RGB

Pause Graphic

Freeze the FFT or Sonagram Window.

Tuning Cursor

Show the 8 green cursor-group in the FFT or Sonagram Window for tuning (multi-carrier) signals.
Bandwidth...

To select a display bandwidth use Bandwidth from the context menu or double-click on the Bandwidth:
field on the demodulator status bar. For the Tuning Sonagram / FFT bandwidths of 0.5, 1.0, 2.0, and
4.0 kHz are available. For the Analysis FFT/Sonagram bandwidths of 0.5, 1.0, 2.0, 4.0, 24, 48 and 96 kHz
are available.

Bandwidth (Hz) [

Cancel

1000
2000
4000

24000
48000
56000

_ __

500

Average Factor

After choosing an Average Factor from the context menu, the average of up to 64 measurements may
be displayed at each step. A value of "1" turns averaging off. The averaged display of several measure-
ments is very helpful when monitoring MFSK and FDM transmissions or during heavy fading. The averag-
ing function may also be selected by double-clicking the Avg: field in the upper status bar.

Window Type...

Four window functions Rectangle, Hamming, Hanning and Blackman may be selected. The selection of
a window type influences the accuracy of the signal spectrum measurement. Good frequency resolution is
obtained using the rectangular window, however the rectangular window also causes heavy distortion due
to its poor side-lobe suppression characteristics. A window should be chosen according to the user’s re-
quirements; each window type has its own characteristics as listed below.

The user should be aware that changes in the received signal can cause the display of spurious spectral
lines or aliasing ("false" frequency display) in FFT measurements. Depending on the keying frequency and
the magnitude of the frequency shift, the aliased frequencies may even be stronger than the desired sig-
nal.
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Window Type Signal Type Frequency Resolution Spectral Leakage Amplitude Accuracy
Blackman Random Poor Best Poor
Hamming Random Good Fair Fair
Hanning Random Good Good Fair
Rectangular Transient Best Poor Poor

Period...

From the Period menu the time unit per measurement may be selected. The lowest value is 50 ms corre-
sponding to 20 FFT's/s. For the highest value of 10,000 ms a measurement is done once every 10 sec-
onds.

Peak Hold...

For easy tuning, switch on Peak Hold in the Options menu on. The tone spectrum appears in the FFT
window after a short delay and the frequency range can be changed as required using the cursors as
shown below.

Peak Hold =5

Cancel

If you select max Decay, then a decay value can be set. This allows to use the peak hold functions during
thunderstorms or if tuning the receiver.

Max Decay =50

10 dbss

Display Settings...

To configure other parameters of the FFT, select Display Settings.

Display Settings

=)

Base level (dB):

Range (dB):

FFT length (Pt):

240

U

30

-60 dB

60 dB

240

The sliders "Base level" and "Range" control the dynamics of the FFT. "Base level" sets the minimum level
that is visible in the FFT display. "Range" is the difference between the maximum and the minimum level.

With "FFT length", the number of points used to calculate the FFT can be set. A longer FFT length leads to
increased resolution in the frequency domain. This can be useful in analyzing OFDM signals, where it is al-
so recommended to select a bigger average factor to reduce the noise shown in the FFT.

Color Schemes

Select between Grey, Hot, Cool, Cooper and RGB.

Mode Selector

Full-screen menus are available for modes and analysis tools. Click on the Mode Selector Button in the
toolbar to open this menu. Modes are available in alphabetical order. Click on a mode to start it. From the
top row tabs analysis tools may also be selected.
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If a mode is already active it will not be terminated or halted by opening the full-screen menu. Click on
Cancel or the Close button to leave the menu.

The descriptions of the operating modes in another section of this manual are arranged in alphabetical or-
der.

HF Mode Selector

HF Mode Selector E@@
Transmission Type: 7'

F

[ ALIS ] [ ARQ-E I ARQ-E3 ][ ARQ-M2-242 || ARQ-M2342 || ARQ-M4-242 |[ ARQ-M4342 |

[ ARQ-N ][ argeso | argess || AsCl J[[ autospec | [ Baubor || BR-6028 |

[ Buesascn || CHU ][ as-11 ] [ as-14 ][ asaeso | as-s0-50 | [ cODANW-SELCAL |

[ CV-786 ] [ DGPS ][ pbuparg ][ DupArg-2 |[  Dup-FEC2 || EFR ][ FEC-A ]

[ Gmpss/pscHF | [ G-TOR ][ GW-FSK ] HC-ARQ J[[ mwerc || MD-674 ][ Packer3o0 |

[ PACTOR ][ pactor-FEc  |[  PoLarq | [ Rum-FEc || SI-ARQ ] [ SLAUTO ] SL-FEC ]

[ _smor-ARQ | [ smomAuto | [ smomR-FEC | [ sPREAD-11 | [ sPREaD-21 | [ sPREADSL | [ SWED-ARQ |

VISEL

MFSK

[ ALE-400 ] [ ALIS-2 ][ AUM-13 ] [ as3s ][ coqueters | [ coqQuElET-13 | [ coqQUELET80 |
[ F18 ] [ 1caoseicar ]| MF5K-8 ][ mFsk1s ][ mFsk-20 ] [ OLIVIA ] [ Piccoto-mks |
[__Piccoto-mkiz ] | SP-14 ] THROB ][ THROBX J[ Twmeex ]

PSK & OFDM

[ mrrps ][ cHmaza || as-12 ][ cover2 ][ ciover2o00 | [ cLOVER-2500 | [ CODAN-CHIRP |
[ copamsaziz | [ copansoor |[  cw-ofbm | | GW-PSK ][ Pactormt | [ PACTORI-AUTO | [ PACTORILFEC |
[ _pactorm ][ Pactors || PSK-AM ] [ PSK-10 ] PSK-31 ] [ psk31FECc ]| PSK-63 ]
[ PSK-63F ] [ PSK-125 J[L__ _pski2sF ][ psk220F ][ PSK-250 ] [ ROBUST-PACKET |

MIL-STANAG
[ HF-Acars | [ unk11(ClEw) | [ UNK11(SLEW) | [ MIL-188-110A | [MIL-188-110A-MOD | [ MIL-188-1108 | [MIL-188-110-16TONE|

[MiL-188-110-39TONE| [ miL-188-141A | [ MIL188-141B | [ MIL-M-55529A | [ sTANAG4285 | [ STANAG4415 | [ STANAG-4481-FSK |

[ STANAG4481-PSK | [ STANAG-4529 | [ STANAG-5065-FSK |

Graphic
[ owmorse | [  FEDHELL  |[  FM-HEL | [ PRESs-FAx || 55TV ] [ WEATHER-FAX |

o Came )

HF Analysis Selector

r B
HF Analysis Selector ==
Classifier
[ Classifier ] [ Classifier Code Check ]
Frequency,/Time
[ FFT | [ FFT&sonagram |
[ Sonagram ] [ Waterfall ]
FSK
[ FSK Analysis ] [ FSKcCodeCheck |
MFSK

[ MFsKanalysis | [ MFSK Code Check |

PSK
[ PsksymbolRate | [ PskPhasePlane |

PSK Code Check

MIL-STANAG

MIL-STANAG Code Check

Miscellaneous

[ Autocorrelation Bit Correlation |

J [
[ Bit Length Analysis ] [ Demod. Bitstream ]

Close
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VHF/UHF-DIR Mode Selector

VHF/UHF-DIR Mode Selector [ = | & |23
f AI5 ] [ APCO-25 |
[  bpcssecar | DMR |
[ dPMR ] [ ERMES |
[ FLEX ][ Gowarsesc |
[ moBmexso0o | | NXDN |
[ packeToeoo | | POCSAG |
[ TETRA | [ TETRAPOL |

VHF/UHF-DIR Analysis Selector

WVHF/UHF-DIR Analysis Selector 12200

Classifier

[ Classifier | [Ciassifier Code Check|
Frequency/Time I
[ FFT ][ FFT & Sonagram ]
[ Sonagram ] [ Waterfall ]
[ Oscilloscope ]

FSK

[ Fskamalysis | [ FSKCode Check |
PSKE

| PSKSymbolRate | | PSKPhase Plane |
Miscellaneous

[ Autocarrelation ][ Bit Correlation ]
[ Bit Length Analysis ] [ Demod. Bitstream ]
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VHF/UHF-SUB Mode Selector
VHE/UHF-SUB Mm@gu

Digital modes

ACARS ] [ ATIS ] [ BIS

MPT-1327 ] [ NMT-450 NWR-SAME

!
[ FMS-BOS | [ GMDSs/DSCVHF | [ MOBMEX-1200
[
[

PACKET-1200 | | X.25 ] [ zvervoew

SELCAL analog modes
CaR-1 ] [ ] [

cam J [ J [
J [ J [
J [ J [
J [ J [
J [ J [

VHF/UHF-SUB Analysis Selector
rVHFfUHF—SUB Analysis Seledor__l‘glﬂu

Classifier

( Classifier | [Classifier Code Check|

Frequency/Time

[ FFT ][ FFT & Sonagram ]
[ Sonagram ] [ Waterfall ]
FSK
[ Fskénalysis | [ FsKCode Check |
PSK

[ PsKSymbolRate | [ PSKPhase Plane |

Miscellaneous

[ Autocorrelation ][ Bit Correlation ]

[ Bit Length Analysis | [ Demod, Bitstream |

SELCAL Analysis

Satellite Mode Selector

Satellite Mode Selector ol = =4
L-Band
[ satAerop | [ saT-AEROC |
[ SAT-B ][ satBDatA | [ saTBFAX | [  sATBTEL |
[ SAT-BJELEXMM | [ SAT-BJELEX-SM | [ SAT-B-HSD | [ sAT.mM-HSD |
[ satcmom | [ saTcTDM-EGC |
[ SAT-M ][ saTMDATA | [ saTM-Fax | [ saTMTEL |
( SAT-mM | [ SAT-mM-DATA | [ SAT-mM-FAX | [ SAT-mM-TEL |
C-Band
[ sarcioma | [ saTBCIFC | [ SATB-CHSD | [ SAT-mM-C-HSD |
[ saTAEROR | [ SAT-ARROT |
Miscellaneous
[ AmsaTPsD | [ NOAA-GEOSAT | [ ORBCOMM
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Satellite Analysis Selector

-
Satellite Analysis Selector .@ﬂu
Classifier
Frequency/Time
’ FFT ] ’ FFT & Sonagram ]
’ Sanagram ] ’ Waterfall ]
Oscilloscope
F5K
FSK Analysis
PSK
[ PsksymboiRate | [ PskPhase Pane |

Miscellaneous

Autocorrelation H Bit Correlation ]

| Bit Length Analysis | [ Demod. Bitstream |

Close

FAX & Modem Mode Selector
Fax & Modems Mode S_@lﬂu

Half-duplex

E Half-Duplex Auto Mode j
[ Faxeswvaz || Faxesvamter || Faxcsvae |
[ FaxG3vashax | | Bell103 ] [ Bell2124 ]
[ V.21 | [ w22sv2smis | | V.23 ]
Full-duplex

[ Full-Duplex Auto Mode ]
[ wassvaeois | [ wa2svazeis | | V34 ]
[ V.90 ] [ Va2 ]
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FAX & Modem Analysis Selector
Fax & Modems Analysis Selector l"z" S

Classifier

Frequency,/Time

[ FFT ][ FFT & Sonagram ]

[ Sonagram ] [ Waterfall ]

Oscilloscope

FSK

FSK Analysis
PSK
[ PsksymbolRate | [ PSkPhasePlane |
Miscellaneous
[ Autocorrelation ][ Bit Correlation ]
[ Bit Length Analysis ] [ Demaod. Bitstream ]

Close

Passband Filter Support

Perfect signal processing (filtering) is essential for best decoding results, which are achieved by using the
correct filters in the receiver. Doing so prevents blocking effects from strong nearby signals. However cor-
rectly processed signals may be unavailable, e.g., when a receiver does not offer optimum filters or when
using recorded signals. To overcome these obstacles additional passband filters are included in the
WAVECOM decoders to assist the operator in separating signals within the analyzed frequency spectrum.

In the WAVECOM GUI a passband (PB) tuning bar is placed below the tuning FFT window. If tuning FFT is
not available, as is the case for some modes, the parameters can be set in the Demodulator Menu.

For many modes the parameters PB Center, PB Bandwidth and Center can be individually controlled
(see the table below).
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Item PB Conf. Remarks

DSP + Freely configurable

AM + Freely configurable

Ccw + Freely configurable

GFSK + PB center frequency controlled from offset frequency setting

FFSK + PB center frequency controlled from offset frequency setting

MARK-SPACE - PB automatically adjusted depending on center, shift and speed

MFSK - Individual tones are filtered and PB automatically adjusted depend-
ing on tone spacing, center and speed

DTMF - Individual tones are filtered and PB automatically adjusted depend-
ing on tone spacing, center and speed

BR6028 - Preconfigured filters that cannot be changed. The location of the pi-
lot tone can be manually set

BPSK + Freely configurable

QPSK + Freely configurable

OQPSK + Freely configurable

DPSK - PB bandwidth automatically adjusted depending on center, shift and
speed. The center frequency can be manually set

DXPSK - PB bandwidth automatically adjusted depending on center, shift and
speed. The center frequency can be manually set

DBPSK - PB bandwidth automatically adjusted depending on center, shift and
speed. The center frequency can be manually set

DQPSK - PB bandwidth automatically adjusted depending on center, shift and
speed. The center frequency can be manually set

D8PSK - PB bandwidth automatically adjusted depending on center, shift and
speed. The center frequency can be manually set

D16PSK - PB bandwidth automatically adjusted depending on center, shift and
speed. The center frequency can be manually set

IQ + Freely configurable

ANALYSE + Freely configurable

FFT - No filtering implemented

TIME - No filtering implemented

OFDM - No filtering implemented

SUBTONE - No filtering implemented

DISCRIMINATOR - No filtering implemented

EXT-DEM - No filtering implemented

BYPASS - No filtering implemented

The PB parameters can be set to maximum bandwidth (switched off) with the Maximize Passband but-

ton.
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Analysis Tools

FFT

The real-time FFT analysis is a powerful spectrum analysis tool based on Fast Fourier Analysis (FFT), oper-
ating in real time with a 4096-point resolution. The signal is digitized, saved and its frequency spectrum
calculated and displayed.

The measurement is started by selecting a bandwidth. The display of the frequency spectrum has a linear
scale and covers a dynamic range of 60 dB. (The internal dynamic range is considerably higher due to the
16 bit A/D converter used, but the configured display resolution performs better in practical use.)

The frame refresh rate averages 10 to 20 pictures per second, allowing even fast signal changes to be dis-
played. The frame refresh rate is however dependent on the speed of the PC and its video card.

FFTHF Window: Hanning Peak Hold: OFf Period S0ms  Auto Avg: 1 143754

D&k B M, @ |[mode| [anaysis] & ~ ® &= BMERE 2 1 @ | -+ mmmmm OHz OHz
4. FFT - Card 4 (W-CLOUD) [E=R[ECR =
1 2585 mz Ty

557 1951 3225

I } ) } |

| | ! | | ! ' ! | | ' | '
o 250 s00 750 1000 1250 isoo 1750 2000 2250 2s00 2750 =000 2250 2s00 2750 4000 Hz]

Demedulator: FFT Bandwidth: 4000 Hz Center: 1951 Hz Offset: 0 Hz Input: AF (LEFT)

NUM

To start the FFT, click on the FFT button or use Analysis | Real-time FFT from one of the menus.

To activate the measurement cursors, click inside the FFT graphics window. The left and right cursors may
be moved around using the mouse. The cursor positions are displayed as absolute frequency values; the
center cursor automatically displays the center value.

To remove the cursors, click on the graphics window again.

When the cursors have been placed in the desired positions they may be moved right or left by moving
the center cursor. By doing this, the measurement of frequency spacing in MFSK and FDM systems is pos-
sible.

A “Spectrum Analysis” tool can be switched on using “Option -> Spectrum Analysis”. This tool will de-
tect available signals in the analysis (display) bandwidth. All signals will be displayed with their important
parameters (Center and Bandwidth).
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As in the above example, 3 signals are detected in the 96 kHz display bandwidth. In every signal certain
sub-signals are detected as well.
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For example, in an FSK signal, 2 sub-signals are detected and marked.

The whole spectrum analysis result (all detected signals with their sub-signals) can be saved in an XML file
(File -> Save As Text) with the time-stamp. All result will be delivered on the XML remote control inter-
face instantaneously for third-party analysis.

Adjustment of the Offset Frequency
An FFT spectrum calculation can be done from 0 Hz, up to the selected maximum frequency (bandwidth).

The offset frequency for decoding of VHF/UHF-DIR transmissions e.g., POCSAG, GOLAY/GSC, or ERMES
must be adjusted to the effective center frequency of the signal, e.g., 455 kHz.

A bandwidth of 24 kHz from 455 kHz to 479 kHz is sufficient for the measurement range of the FFT.
therefore the offset frequency must be offset to half of the bandwidth. The offset frequency adjustment is
calculated as the IF output frequency (455 kHz) minus half of the selected FFT bandwidth (24/2 kHz) =
Offset (443 kHz). The measurement range is now 443 kHz - 467 kHz.
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For the 455 kHz receiver IF output of a shortwave receiver (e.g., HF-1000), the offset frequency is first
adjusted to 453.3 kHz to obtain the standard center frequency of 1,700 Hz. The HF-1000 BFO must now
be adjusted to 1,700 Hz.

FFT (HF, SUB, DIR and SAT)

FFT Type Start Frequency End Freqgeuncy

FFT HF Offset Frequency Bandwidth

FFT SUB Offset Frequency Bandwidth

FFT DIR Offset Frequency - Bandwidth/2 Offset Frequency + Bandwidth/2
FFT SAT Offset Frequency - Bandwidth/2 Offset Frequency + Bandwidth/2

Tuning FFT or Sonagram

In some modes a Tuning FFT or Sonagram is available. The FFT or Sonagram can be used to set the
center frequency, shift, and passband filter.

Tuning FSK Signals

-

Mark and Space are selected with the right and left cursor. The precision of the center frequency is very
important and directly influences the performance of the decoder.

After every change, the center frequency and shift are automatically updated.

Automatic tuning is also available. It works perfectly as long as there is only one input signal present in
the spectrum. To apply a filter, see “Passband Filter Support” on page 81.

Options can be set using the right mouse button or the context menu (see “FFT/Sonagram Context Menu”
on page 75). It is possible to remove the tuning FFT or Sonagram in the View Menu.

Tuning MFSK Signals

B

A

The highest and lowest tone of the signal is selected with the right and left cursor. The precision of the
center frequency is very important and directly influences the performance of the decoder.

After every change, the center frequency and shift are automatically updated.
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Another tuning cursor group with 8 (green) cursors helps to measure the center, bandwidth and the dis-
tance between multiple carriers in a more convenient way. The 8 cursors can be moved freely. This fea-
ture is helpful when measuring signals with non-equal carrier distance (as CHINESE 4+4 signal).
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These options can be set using the right mouse button or the context menu (see “FFT/Sonagram Context
Menu” on page 75). It is possible to remove the tuning FFT or Sonagram in the View Menu.

Tuning PSK Signals

X

A

The upper and lower frequency boundaries of the signal is selected with the right and left cursor. With the
center cursor, the center frequency may be set more precisely. The precision of the center frequency is
very important and directly influences the performance of the decoder.

After every change, the center frequency is automatically updated and the bandwidth of the signal is set
according to the received mode.

Options can be set using the right mouse button or the context menu (see “FFT/Sonagram Context Menu”
on page 75). It is possible to remove the tuning FFT or Sonagram in the View Menu.
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FFT and Sonagram

This analysis tool combines real-time FFT and sonagram analysis modes.

Demodulator
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Detailed information for each of the analysis tools can be found in the corresponding descriptions, see
“FFT” on page 83 and “"Sonagram” on page 88.

Options can be set using the right mouse button or the context menu (see “FFT/Sonagram Context Menu”
on page 75). It is possible to remove the tuning FFT or Sonagram in the View Menu.

The spectrum analysis tool can be used in the FFT and Sonagram display as well. As in the example below
a STANAG-4285 signal is detected with its sub-signals.
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Waterfall

The waterfall analysis produces a three dimensional display of FFT spectra over time, frequency and am-
plitude. The waterfall display aggregates many single measurements to 40 displayed spectra. An updated
measurement in the two-dimensional real-time FFT display only shows a fraction of the data, depending
on the modulation method. In contrast the FFT waterfall display also displays data in the time domain

A time histogram is displayed on the left-hand side of the display.

By clicking on the graph, the display will be paused and measurement cursors appear.
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Options can be set using the right mouse button or the context menu (see “FFT/Sonagram Context Menu”
on page 75). It is possible to remove the tuning FFT or Sonagram in the View Menu.

Waterfall (HF, SUB, DIR and SAT)

FFT Type Start Frequency End Fregeuncy

Waterfall HF Offset Frequency Bandwidth

Waterfall SUB Offset Frequency Bandwidth

Waterfall DIR Offset Frequency - Bandwidth/2 Offset Frequency + Bandwidth/2
Waterfall SAT Offset Frequency - Bandwidth/2 Offset Frequency + Bandwidth/2
Sonagram

A second widespread method for FFT display is the real-time sonagram, which displays the amplitude and
frequency values produced by the FFT over time. In the sonagram, the signal amplitude is displayed by
colour, with different colours representing different amplitudes. Sometimes this display is also called
“Spectrogram”.

This amplitude related spectrum analysis mode offers many hints to the distribution of a signal spectrum.

The operation is numerically identical to the real-time waterfall analysis, and is simply a different method
of visualisation.
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Options can be set using the right mouse button or the context menu (see “FFT/Sonagram Context Menu”
on page 75). It is possible to remove the tuning FFT or Sonagram in the View Menu.

Making measurements

With the four cursors it is possible to make measurements in the frequency and time domain. To enable
the time cursors, click into the sonagram to freeze the screen. Then click with the right mouse button to
get the menu to set the time cursors.

> T1 Add first cursor to the actual mouse position
> T2 Add second cursor to the actual mouse position
» Move Move T1 cursor and T2 cursor simultaneously

It is also possible to drag the cursor to a new location. If the cursor line gets in the upper our lower part of
the window, then the window will scroll automatically.

Sonagram (HF, SUB, DIR and SAT)

FFT Type | Start Frequency End Fregeuncy

Sonagram HF Offset Frequency Bandwidth

Sonagram SUB Offset Frequency Bandwidth

Sonagram DIR Offset Frequency — Bandwidth/2 Offset Frequency + Bandwidth/2
Sonagram SAT Offset Frequency — Bandwidth/2 Offset Frequency + Bandwidth/2
Oscilloscope

In general, an oscilloscope is used to measure voltage over time. However, the oscilloscope displays a rel-
ative and un-calibrated value. After obtaining the measurement time, frequency can be determined.

By clicking on the graph, the display will be paused and measurement cursors appear for both axis.

Several Color schemes are available through the right-click menu.
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FSK Analysis

The FSK analysis mode is an important tool to measure the baud rate and frequency shift of FSK transmis-
sions. The magnitude of these property values may help to identify the transmission being monitored.
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To open the FSK analysis window go to the HF-Modes menu and select Analysis/FSK Analysis, or use
the FSK Analysis button. The baud rate and spectrum window will open, but NOT the waterfall window.
After a few seconds the baud rate and spectrum window are updated.
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The FSK analysis window consists of four panes:
» A spectrum graph pane
» A spectrum waterfall pane
» A baudrate graph pane
» A baudrate waterfall pane
Baudrate and Spectrum Window

The baudrate and spectrum window are two-dimensional displays of the monitored baud rate, measured in
Baud, and the spectrum of the transmission, measured in Hz, on a relative scale from 0 to 100. The dis-
plays are updated around every 5 seconds. The calculated baud rate, center frequency and frequency shift
values of the latest sample are stored to be used whenever a decoding mode is selected.

Two pairs of cursors may be placed in the baudrate and spectrum graph windows, to assist in manual
measurements. The values to which they point, and the difference between the two cursor values, are
shown above the cursors. When a pair of cursors is placed in one of these windows, graph display updat-
ing is halted, but signal sampling continues and is displayed in the waterfall window. The time cursor in
the waterfall window is placed on the selected sample.

Methods exclusively based on bit length measurement are unreliable for baud rate measurements. The
baud rate measuring process employed by the decoder is therefore based on a new method employing au-
to-correlation and subsequent Fast Fourier Transformation (FFT) presentation. Using this method, FSK
transmissions may be analyzed without problems. Be aware that when measuring the baud rate of codes
using code words which have a non-integer number of bits, e.g., asynchronous 7.5-bit ITA-2, the indicat-
ed baud rate will increase by a factor two.

Waterfall Window

To open the waterfall window, move the mouse to the left of the extreme right of the graph window. The
normal cursor will turn into a splitter - two parallel lines with arrows perpendicularly attached. Now, hold
and drag to place the boundary between the windows where you wish, when the mouse button is re-
leased.

The waterfall windows are two-dimensional displays of baud rate and spectrum versus time. The color in-
tensity of the displays represents the energy density of the spectrum, and the value of the relative occur-

WAVECOM Decoder W74PC, W-PCl/e, W-CODE, W-CLOUD Manual V14.0.0 Analysis Tools e 91



rence of a baud rate - for gray scale values, white is the highest intensity and black the lowest. A time
stamp points to the latest sample taken. The latest sample is color inverted to distinguish it from the pre-
vious samples.

If the user wishes to examine a particular sample, it may be selected in the waterfall window. The sample
is marked with the time cursor, cursors are placed in the graph window and updating is halted in that win-
dow.

FSK Analysis Options

To assist in the measurement of noisy signals, a peak measurement function and an averaging function
are available. When one of these options is selected the last five samples will be used for calculations. The
result is displayed in the graph window. The user may also select a larger time span as basis for calcula-
tions from anywhere in the waterfall window.

Measure Peak and Average Values

Select the function you wish to use from the Options menu. A checkmark is shown to the left of the op-
tion selected and five samples are inverted in the waterfall window selected to indicate the number of
samples used for the calculations.

If you wish to use a different number of samples in the calculation, place the mouse on the waterfall sam-
ple from which calculation should start, and hold and drag the mouse over as many samples as you want
to use.

The marked samples will be color inverted, cursors will appear in the graph window and the graph display
will show the average or peak value of the marked samples.

To disable peak or average measurement, uncheck it in the Options menu: the cursors will disappear, on-
ly one sample is marked in the waterfall window, and updating of the graph window will resume.

Examine Sample, Display Cursors

Click on the baudrate or the spectrum graph window to display the cursors, or click on the sample in the
waterfall window that you wish to examine. Graph window updates will stop and a pair of cursors will ap-
pear. You may move the cursors along the x-axis in normal Windows fashion. The matching waterfall
sample is marked with the time cursor.

Click on the graph window again to remove the cursors and resume graph window updates.

Zoom

Right-click with the mouse into the spectrum
or baudrate graph pane (upper panes) and se-
lect if you like to Zoom 2X or or to Zoom 4X.
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To adjust the frequency scale, move the cur-
sor into the range of the frequency scale. If
you see the “Hand”, press the left mouse but-
ton and move the frequency slider.
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FSK Code Check

The purpose of the FSK Code Check is to automatically identify the mode of transmission, baud rate, fre-
quency shift and center frequency.

FSK Code Check HF

FSK code check is started in automatic mode by selecting the Analysis | Code Check button or from HF-
Modes | Analysis | FSK Code Check. This function has a high degree of accuracy when determining
baud rate, frequency shift and center frequency of HF FSK systems.

As an additional aid, FSK code check also offers an option to start the analysis manually after user entry of
baud rate, frequency shift and center frequency. To utilize this option the Auto button must be deselect-
ed. The software will then start data acquisition using the pre-selected parameters. If a pre-selected pa-
rameter has been changed data acquisition is atomatically restarted.

The selection of baud rate, frequency shift or center frequency is done by clicking on the status bar fields
or using the Demodulator menu.

If the FSK code check cannot identify a mode, the code check should be repeated. Data acquisition is con-
tinuously performed as a background task. Heavy fading or other disturbances during data acquisition
may prevent the identification of a mode.

You can also restart data acquisition by pressing the Resync button.

The 1.5 stop elements used in many Baudot transmissions will often prevent the correct determination of
the signal baud rate, or the baud rate will be calculated as twice its actual value. Distorted stop elements
may also lead to completely erroneous baud rate calculations. To prevent this malfunction, measurements
of Baudot transmissions take place using the standard speeds of 45.45, 50, 75, 100, 150 and 180 Baud, in
addition to the measured baud rate.
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Steps:

» After starting the FSK code check the frequency shift, center frequency and baud rate are deter-
mined. The values of these parameters are displayed in the appropriate fields after measurement
has finished.

» The software then proceeds with code and system analysis. The incoming bit stream is tested
against known modes. For some modes using a high interleaving depth (e.g., RUM-FEC) large
quantities of input data are required. These modes therefore require longer to test and are tested
last.
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» The name of each identified system is displayed in the output window. An identified system may
be immediately started by double-clicking the system in the output window - for instance double-
clicking BAUDOT ITA-2 in the figure above will interrupt FSK code checking and immediately start
BAUDOT ITA-2.

» The Hits-Checks will show you how often during checking a mode was successfully determined. If
multiple modes are listed this will indicate which mode should be tried.

» Some modes are very difficult to distinguish, especially when the system is in idle mode. The de-
coded text including text representations of the special characters IDLE ALFA, IDLE BETA and RQ
are important additional classification aids in determining the mode under examination.

» If a mode is uniquely identified, the software will switch to the identified mode and decoding is ini-
tiated with the measured values of mode, baud rate, shift, and center frequency.

» If two or more different systems are identified or if too many transmission errors occur, an auto-
matic switch to a mode will not take place.

Fast Scan/Full Scan

The Scan Mode can be selected by Options | Scan Mode... or by double-clicking the Scan Mode field in
the Status Bar.

Scan Mode

S
F n Cancel

The software proceeds to create a list of modes to check, which is displayed in the Code Check window.
The content of this list depends on the selection of the Fast Scan or Full Scan options.

» In Fast Scan mode, the list only contains the modes which are known to use the measured baud
rate, to reduce the evaluation time.

» In Full Scan every mode which is suitable for an FSK code check is listed, and all possible combi-
nations are checked.

FSK Code Check DIR

FSK code check is started in automatic mode by selecting the Analysis | Code Check button or from
VHF/UHF-DIR | Analysis | FSK Code Check. This function has a high degree of accuracy when deter-
mining baud rate, frequency shift and center frequency of HF FSK systems.

As an additional help FSK code check also offers an option to start the analysis manually after user entry
of baud rate, frequency shift and center frequency. To utilize this option the Auto button must be dese-
lected. The software will then start data acquisition using the pre-selected parameters. If a pre-selected
parameter has been changed data acquisition is atomatically restarted.

The selection of baud rate, frequency shift or center frequency is done by clicking on the status bar fields
or using the Demodulator menu.

If the FSK code check cannot identify a mode, the code check should be repeated. Data acquisition is con-
tinuously performed as a background task. Heavy fading or other disturbances during data acquisition
may prevent the identification of a mode.

You can also restart data acquisition by pressing the Resync button.

Because this kind of signal is not continuous, there is a need for a Noise Gate. The status of the noise
gate is displayed in the status bar; it examines the input signal and tries to determine if a valid signal is
available which can be processed, or if the input consists only of noise.
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Steps:

» After starting the FSK code check the frequency shift, center frequency and the baud rate are de-
termined. The values of these parameters are displayed in the appropriate fields after the meas-
urement has completed.

» The software then proceeds with code and system analysis. The incoming bit stream is tested and
compared against known modes.

» The name of each identified system is displayed in the output window. An identified system may
be immediately started by double-clicking the system in the output window - for instance double-
clicking ACARS in the figure above will interrupt FSK code checking and immediately start ACARS.

» The Hits-Checks will show you how often during checking a mode was successfully determined. If
multiple modes are listed this will indicate which mode should be tried.

» If a mode is uniquely identified, the software will switch to the identified mode and decoding is ini-
tiated with the measured values of mode, baud rate, shift, and center frequency.

> If two or more different systems are identified or if too many transmission errors occur, an auto-
matic switch to a mode will not take place.

Noise Gate Mode...

The Noise Gate Mode can be selected by Options | Noise Gate Mode... or by double-clicking the Noise
Gate Mode field in the Status Bar.

Noise Gate Mode @‘

Disabled

> In Enabled mode, a Noise Gate is used. This is necessary as this kind of signal is not continuous.
The noise gate examines the input signal and tries to determine if a valid signal is available which
can be analyzed, or if the input consists only of noise.

> In Disabled mode the Noise Gate is switched off.
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FSK Code Check SUB

FSK code check is started in automatic mode by selecting the Analysis | Code Check button or from
VHF/UHF-SUB | Analysis | FSK Code Check. This function has a high degree of accuracy when deter-
mining baud rate, frequency shift and center frequency of HF FSK systems.

As an additional help FSK code check also offers an option to start the analysis manually after user entry
of baud rate, frequency shift and center frequency. To utilize this option the Auto button must be dese-
lected. The software will then start data acquisition using the pre-selected parameters. If a pre-selected
parameter has been changed data acquisition is atomatically restarted.

The selection of baud rate, frequency shift or center frequency is done by clicking on the status bar fields
or using the Demodulator menu.

If the FSK code check cannot identify a mode, the code check should be repeated. Data acquisition is con-
tinuously performed as a background task. Heavy fading or other disturbances during data acquisition
may prevent the identification of a mode.

You can also start a new data acquisition by pressing the Resync button.

As this kind of signal is not continuous, a Noise Gate is required. The status of it is displayed in the status
bar. The noise gate examines the input signal and tries to find out, if a valid signal is available which can
be processed or if the input consists only of noise.
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Steps:

» After starting the FSK code check, the frequency shift, center frequency and the baud rate are de-
termined. The values of these parameters are displayed in the appropriate fields after the meas-
urement has completed.

» The software then proceeds with code and system analysis. The incoming bit stream is tested and
compared against known modes.

» The name of each identified system is displayed in the output window. An identified system may
be immediately started by double-clicking the system in the output window - for instance double-
clicking ACARS in the figure above will interrupt FSK code checking and immediately start ACARS.

» The Hits-Checks will show you how often during checking a mode was successfully determined. If
multiple modes are listed this will indicate which mode should be tried.

» If a mode is uniquely identified, the software will switch to the identified mode and decoding is ini-
tiated with the measured values of mode, baud rate, shift, and center frequency.

» If two or more different systems are identified or if too many transmission errors occur, an auto-
matic switch to a mode will not take place.
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Noise Gate Mode...

The Noise Gate Mode can be selected by Options | Noise Gate Mode... or by double-clicking the Noise
Gate Mode field in the Status Bar.

Noise Gate Mode

==
[Dizabled
E nabled Cancel

> In Enabled mode, a Noise Gate is used. This is necessary as this kind of signal is not continuous.
The noise gate examines the input signal and determines if a valid signal is available which can be
analyzed, or if the input consists only of noise.

> In Disabled mode the Noise gate is switched off.

PSK Symbol Rate (HF, DIR, SUB and SAT)

When starting PSK signal analysis, one is trying to determine the characteristics of an unknown signal.
The normal starting point for this is the FFT.

The FFT is used to determine an estimate of the signal center frequency and signal bandwidth. This should
be done by adjusting the measurement cursors. The phase analysis tools inherits the information deter-
mined by the measurement cursors, and uses this information to configure the center frequency and
bandwidth. This in turn sets up a pre-filter, allowing the tools to be used for signals disturbed by out-of-
band interference, or when more concurrent channels are present.

To determine the symbol rate, a PSK symbol rate analysis tool is provided. This tool provides a spectrum
display (with three zoom levels) and allows the measurement of the symbol rate using cursors. A PSK sig-
nal will normally produce multiple peaks. Normally (but not always) the symbol rate (or baud rate) will be
a distinct peak at the highest amplitude. The other peaks are normally fractions of the true symbol rate.
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Zoom

For signals with low symbol rates, select a different zoom factor by using the menu which appears when
right-clicking the display. Note that the lower scales have a higher precision, but at the expense of a lower
display rate.
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Pause Graphics
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Zoom 1000 Symbols/s
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Filter

The filter adjusts the smoothing filtering applied to the display. Depending on the signal data content, it

may be found that more filtering is required to clearly observe the peaks.

5]

Filter

o 20 40 60 80 100

oK

PSK Phase Plane (HF, DIR, SUB and SAT)

The phase analysis tool is used for analyzing the characteristics of phase modulated signals, and to a lim-

ited extent, m-ary PAM (Phase Amplitude Modulation) signals.

If the symbol rate is known (for details see "PSK Symbol Rate (HF, DIR, SUB and SAT)"” on page 97), start

the PSK phase plane analysis tool.

The display can be started and stopped by clicking on it. If stopped, a Paused message is displayed.

You can use an existing demodulator (BPSK, QPSK or DPSK) or IQ to decode the signal, and produce a
phase plane display of the output of the demodulator. For BPSK and QPSK, this provides a check of the
quality of the signal. When using DPSK, this provides an indication of the level of phase modulation which
is being used, i.e., 2-PSK to 16-PSK. As the symbol rate is equal to the baud rate of the signal, the baud

rate must be known to configure the demodulator.

u?n/[ 'WAVECOM W-CODE - W-CODE PSK Phase Plane - Card 1
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Center

The Center allows the center frequency for the demodulator to be adjusted. A center frequency error nor-
mally results in a phase plane that is rotating with a speed proportional to the frequency error.

Hold Time

The Hold Time adjusts the number of points displayed on the screen. Increasing the hold time increases
the amount of time a dot will remain in the image before being overwritten by a new value.

Demodulator Mode

Demodulator Mode_A [&J

QPSK | Cancel |

If you select IQ as the demodulator, the signal is not demodulated at all. Instead, the phase of the signal
is visually 'compared' with a reference signal. Providing the correct reference signal is selected, this will
result in a phase display that provides an indication of the type of PSK or PAM signal. The points will trace
the path taken as the signal phase change. At the nominal signal mapping points, there is normally an ac-
cumulation of data points, providing a visual clue to the overall signal mapping.

Multi-channel DPSK signals often have a very narrow channel signal bandwidth. This results in the phase
of the signal never remaining constant, and so the accumulation of signal points in the phase plane is not
visible. To quantify such signals use the IQ demodulator mode.

<¢ Decrease ¢ > Increase 3>

5993.30

The frequency of the reference signal is set using the Center option. Note that if the reference frequency
is incorrect, the display rotates at a rate that is the difference between the reference frequency and the
true carrier frequency of the signal. When adjusting the reference signal, the changes are 'live'. This
means that changes you make immediately take effect, and the resulting change in the phase display is
immediately visible on the display.

Incorrect settings Correct settings

2 WAVICOM W GO0t W-CODE Pk Prare e - Cort

K Pome Pl
D&

Several Color schemes for both tools are available through the right-click menu.
In summary, the basic steps for analyzing a suspected (D)PSK signal are as follows:

» Use the FFT in the PSK Symbol Rate analysis tool to characterize the signal. Use the cursors to
configure the estimate of the center frequency and bandwidth.

> Use the PSK Symbol Rate analysis tool to measure and select the symbol rate of the signal.

WAVECOM Decoder W74PC, W-PCl/e, W-CODE, W-CLOUD Manual V14.0.0 Analysis Tools e 99



» Try and view the phase plane of the signal using the DPSK demodulator. If the signal is a PSK sig-
nal, the phase plane should be visible.

» If the DPSK demodulator failed to produce a meaningful display, try the IQ demodulator. This re-
quires accurate adjustment of the reference signal to produce a meaningful display.

Dedicated Phase Plane for MIL/STANAG Modes

Most MIL and STANAG modes employ high-speed (e.g., 2400 Bd) PSK or QAM modulations. Phase Plane
with traditional demodulators will deliver only unsatisfying visualization result. There is a dedicated “Phase
Plane” in most MIL/STANAG modes to show the phase constellation before (in yellow) and after (in blue)
the equalizer. The phase display in yellow would correspond to the display in the traditional phase plane.
User can display this dedicated phase plane in Options -> Show Phase Plane.

W, Phase Plane (Card 5) =R

¥| Show symbols before equalization 7 Show trace

I:| Before equalization - After equalization

PSK Code Check (HF, DIR and SUB)

PSK code check is started by selecting the PSK Code Check button or from HF-Modes | Analysis | PSK
Code Check.

The PSK code check is initialized with default values. In many cases the user needs to set up the following
values:

> center frequency

» baudrate

» number of channels

» bandwidth (use the pb tuning to enter the correct bandwidth

The center frequency can be set by using the cursors in the FFT Window as shown below, or by selecting
Center in the Demodulator menu. The baud rate can also be configured.

The number of channels is set to one for all single channel modes and to two for two channel modes like
PACTOR II/II-FEC. Modes with more than one channel need the shift settings in addition to the center fre-
qguency.

Note: The accuracy of the center frequency and shift settings is very important and directly influences the
performance of the decoding.

After each configuration change, the PSK code check automatically restarts with the new values. The val-
ues of these parameters are displayed in the appropriate fields after the setting has completed.
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If two or more different systems are identified, or if more than five proven transmission errors occur, an
automatic switch to a mode will not take place.
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The software then proceeds with code and system analysis. The incoming bit stream is tested and com-
pared against known PSK modes.

The name of each identified system is displayed in the output window. An identified system may be imme-
diately started by double-clicking the system in the output window - for instance double-clicking PSK-31
in the figure above will interrupt PSK code checking and immediately start PSK-31.

Hits-Checks shows how many times a mode was successfully identified during the code check. If multiple
modes are listed, the mode with most hits should be tried first.

Some modes are very difficult to distinguish, especially when the system is in idle mode.

MIL-STANAG Code Check

The MIL/STANAG code check analysis tool is used to determine whether a signal is one of the following
MIL/STANAG and related transmission modes:

HF-ACARS

MIL-188-110A
MIL-188-110B
MIL-188-141B
STANAG-4285
» STANAG-4529

STANAG-4415 is a sub-mode of MIL-188-110A and is detected as this mode. STANAG-4481 is a sub-mode
of STANAG-4285 and is detected as this mode.

This analysis feature can be started from the HF-Modes | Analysis | MIL-STANAG Code Check menu,
from the Analysis Selector.

vV V V V

The center frequency can be set by the user. The default value for the code check is 1800 Hz, as shown in
the user interface. The center frequency of HF-ACARS (1440 Hz) can be selected from a list. After the cen-
ter frequency is set, the code check searches for the mode within a range of £ 100 Hz of the center fre-
quency. Although HF-ACARS may have a center frequency of 1440 Hz, it can also be detected when the
code check is set with center 1800 Hz.
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Apart from HF-ACARS, which has a baud rate of 1800, all other MIL and STANAG modes operate at 2400
baud. However, the code check can automatically determine modes with different baud rates.

After the code check has determined a mode, the mode name is displayed in the text window. The confi-
dence parameter shows how good the match is, the highest possible value being 100%. When confidence
is greater than 90%, the code check automatically switches to the corresponding mode decoder using the
corrected center frequency.

MFSK Analysis

The MFSK analysis for the HF signal range employs a graphical display in two dimensions, frequency (y-
axis) and time (x-axis). Both values may be preset. This tool was originally developed for the analysis of
analogue tone call systems, but is equally suitable for evaluation of FSK and MFSK systems. In particular
the frequency and element duration is well displayed.

After starting MFSK Analysis the detected frequency values are displayed as pixels.

A monitored MFSK signal is easily recognized as stable lines. To stop the display from scrolling horizontal-
ly, click on the display. Measurement cursors for both the time axis and the frequency axis appear. The
display may be scrolled backwards, with a maximum range of 15 seconds when tracking rate is set to 1
ms, and 225 seconds when the tracking rate is set to 15ms. The scroll-back range for all tracking rate set-
tings in between varies accordingly.
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Tracking rate determines the sampling rate. The range is 1 - 15 ms; the default is 2 ms.

Double-clicking Filter inserts a low pass filter for filtering the tones. The value of the filter should be ad-
justed to avoid serious tone distortion. A rule-of-thumb value is 1.6 times the baud rate.

The filter range is 1 - 100 ms.

Using the Span menu, the resolution of the frequency axis may be increased. The steps are 3000 Hz (for
analogue selective calling systems), 1500, 600 and 300 Hz.

From the Center menu, the center frequency may be adjusted. It is important to readjust the center fre-
quency whenever the frequency (Span) axis is increased.

Several Color schemes are available through the right-click menu.

MFSK Code Check HF

MFSK code check is started by selecting the Analysis | MFSK Code Check button or from HF-Modes |
Analysis | MFSK Code Check.

The MFSK code check starts with default values.

In many cases the user needs to set the following values:
> center frequency
» baudrate (1/tone length)
» number of channels

» bandwidth (use the PB tuning to enter the correct bandwidth)

The center frequency and bandwidth can be set by using the cursors in the FFT Window, as shown below
or by selecting Center, in the Demodulator menu. The baud rate and the Number of Channels/Tones
can also be configured.

Note: The accuracy of the center frequency and shift settings are critical, and directly influence the quality
of the decoding.

After each configuration change, the MFSK code check automatically restarts with the new values. The
values of these parameters are displayed in the appropriate fields after changes have been made.
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If two or more different systems are identified, or if more than five proven transmission errors occur, an
automatic switch to a mode will not take place.
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The software then proceeds with code and system analysis. The incoming bit stream is tested and com-
pared against known MFSK modes.

The name of each identified system is displayed in the output window. An identified system may be imme-
diately started by double-clicking the mode name in the output window - for instance double-clicking
COQUELET-13 in the figure above will interrupt MFSK code checking and immediately start COQUELET-13.

Hits-Checks shows how many times a mode was successfully identified during the code check. If multiple
modes are listed, the mode with most hits should be tried first.

Some MFSK modes are very difficult to distinguish, especially when the system is in idle mode.

Autocorrelation

Autocorrelation is used for determining the periodicity of bit patterns. Periodicity implies a constant repeti-
tion of a specific bit pattern. If a station transmits the idle pattern 0010011011 0010011011..., the perio-
dicity is said to be 10 bits. HNG-FEC and RUM-FEC have a periodicity of 15 and 16 bits respectively. The
periodicity could also be 11250 bits, i.e., after 11250 bits the same constantly repeated pattern occurs
again. Periodicity becomes very important in the classification of unknown transmissions and the analysis
of unknown modes and systems.

First of all, the Auto option from the Demodulator menu field or the Auto button should be used to de-
termine the exact baud rate and frequency shift. If the exact baud rate is unknown, the IAS measurement
function can be used for this purpose with an accuracy of 0.001 Bd. This is done by activating the IAS set-
ting in the Demodulator menu field. Autocorrelation is then initiated by selecting and programming the
baud rate menu field. If the baud rate deviates by more than 0.5 Baud, a bit slip may occur and therefore
the autocorrelation must be restarted with the exact baud rate.
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To start the sampling process, press the Start button. The number of sampled bits is continuously dis-
played. Autocorrelation can currently process up to 200,000 bits.

By pressing the Correlate button, the actual computation of the autocorrelation is started. Results are
displayed graphically. If a large number of bits have been sampled and the graph indicates a low periodici-
ty, the computation may be stopped by pressing the Stop button. Periodicity is indicated by distinct peaks
in the graphic display, which may exhibit various characteristics:

» A large number of closely spaced vertical lines indicates a very small period (7 to 15 bits).

» Small and asymmetric peaks indicate that a distinct periodicity is not present. The presence of
such small peaks may however be an indication of a very long period.

» In the case of a very "noisy" graph, periodicity cannot be determined without the zoom function.
Such measurements indicate the fact that the system is transmitting data (traffic state). The user
should then wait for an idle state or for some request (RQ) cycles for closer examination.

» The graphic display only shows approximate wave forms. This peculiarity is often evident in the
case of simplex systems, however an approximate determination is still possible.

» In the case of a horizontal line without any peaks or deviations, no periodicity may be deduced, or
the period is much larger than the total nhumber of sampled data bits.

Each mode and each signal can produce very different displays. Often, it is possible to determine a perio-
dicity with the zoom function.

For FSK signals the polarity is changed from the menu Options | Signal Polarity, and then using the
buttons in the window shown. For more information see “Signal Polarity” on page 46.

For PSK signals the configuration of the symbol definition is in the menu Options | Symbol Definition.
For more information see “"Symbol Definition” on page 46.

By selecting Zoom In, the mouse cursor changes its shape. By clicking and dragging, a field can be en-
larged or reduced horizontally and vertically. The field should be sized in such a way that the peaks fill out
the zoom field optimally.
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After the zoom field has been sized, release the mouse button. An enlarged section of the autocorrelation
trace is displayed.

The distance between recurring, equidistant peaks gives the periodicity of the signal under investigation.
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By selecting Zoom 100% the full screen display will reappear.

Several Color schemes are available through the right-click menu.

Bit Correlation

The bit correlation and bit length analysis tools allow the measurement of bit length. Bit length analysis
relies on a statistical evaluation of many individual measurements, whereas the bit correlation function
displays the data of the V1 channel graphically.

The data for bit correlation is sampled and displayed with respect to time. Thus pulse and tone duration
lengths as well as bit bias may be measured. The bit correlation analysis also allows the accurate determi-
nation of baud rates in the case of asynchronous systems with bit errors and propagation dependent dis-
tortions.
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The time duration of a video line, and thus the display resolution, is set with the sliders in Time per Line.
The range is 20,000 ps (0.02 s) to 10,000,000 ps (10 s) per graphical line and sampling takes place in
steps of 14 us. One graphical display line corresponds to the preset time.

Selecting the Start/Stop button controls the effective data sampling.

By moving the mouse cursor a text field is displayed. The value of the positioned segment is continuously
displayed in microseconds (us) and in Baud (Bd) with the graphical cursor. The graphical representation of
V1 channel polarity (mark or space) corresponds to the value of the displayed time and the converted
baud rate.

Also the correlation can be determined by using bit correlation. The number of time units per line set in
Time per Line in addition to the baud rate, constitute the preset values for the correlation.

The following example shows a correlation of 111 bits. The baud rate is 228.66 Bd. Hence the calculation
of the total system cycle length is (1 / 228.66) x 111 = 0.4854369 s.

By right-clicking on the display a menu appears. By selecting Zoom In, the mouse cursor changes its
shape. By clicking and dragging a field can be enlarged or reduced horizontally and vertically. After the
zoom field has been sized, release the mouse button. An enlarged section of the bit correlation is now dis-
played.
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Additionally, several Color schemes are available through the right-click menu.

Bit Length Analysis

Bit length analysis serves to determine baud rate distributions, tone duration or bit length distributions.

The resolution offered by the sampler option is 14 us (72,000 samples per second). After the demodulator
has been correctly set up either manually or by using the auto function, sampling is initiated by pressing
the Start button. To stop sampling, the Stop button is pressed. Captured data may then be further ana-

lyzed.

A screen with two graphs is displayed. The following example shows a typical bit length display screen.
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The bit length analysis screen consists of a window for graphs of the two bit length distribution functions
for binary 0 and 1, as well as a window containing a graph of the raw, binary data.

By right-clicking on one of the two displays a menu appears. By selecting Zoom In the mouse cursor
changes its shape. By clicking and dragging, a field can be resized. After the zoom field has been sized,
release the mouse button. An enlarged section of the raw data or the bit distribution is displayed. By se-
lecting Zoom 100%, the full screen display will reappear.
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Several color schemes are available through the right-click menu.

By clicking on the displays graphic cursors may be used to move over the graph to allow measurement of
data.

The bottom window shows the distribution of bit lengths, as computed from the sampled data.

It should be noted that reception in the HF band may be subject to distortions. In such cases the distribu-
tions for the "0" and "1" values should be averaged.

In the top window a graphical representation of the binary data "0" and "1" is provided. The resolution
may be set using the zoom function. Practical values are between 1000 us and 10000 ps. In general, the
resolution is controlled by the smallest parameter to be measured. For MFSK, this corresponds to tone
changes and RTTY to data transitions (bits).

Using the scroll bar the binary bit pattern may be continuously moved left or right. This allows easy loca-
tion of the bit/tone duration to be measured.

The example shows the lower section of the screen display after using the zoom function. The cursors may
be moved across the bit pattern. The individual positions of the cursors, as well as the difference between
the two cursors, are continuously displayed in ps and Bd.

When measuring binary 0s or 1s (mark or space) it should be noted that the two levels may be subject to
severe distortions, depending on the quality of the received signal. Using the average value over a number
of measurements improves the accuracy of results. Some transmission modes are modulated in terms of
bit length or bit position (Pulse Width and Pulse Position Modulation).

SELCAL Analysis

The SELCAL analysis for the VHF/UHF range employs a graphical display in two dimensions, frequency (y-
axis) and time (x-axis). Both values may be preset. This tool was developed for the analysis of analogue
sequential single tone call systems.

After starting SELCAL Analysis the detected frequency values are displayed as pixels.

A SELCAL signal is easily recognized as stable lines. To stop the horizontally scrolling display, click on the
display. Measurement cursors for both the time axis and the frequency axis appear. The display may be
scrolled backwards, with a maximum range of 15 seconds when tracking rate is set to 1 ms, and 225 sec-
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onds when the tracking rate is set to 15ms. The scroll-back range for all tracking rate settings in between
varies accordingly.

%4 WAVECOM W-CODE - W-CODE SELCAL - Card 1 = | B ||
File HF-Modes VHF/UHF-DIR VHF/UHF-SUB Satellite FAX & Modems Options Demodulator Favorites Configuration View Window Help
SELCAL Analysis SUB Tracking Rate: 2 ms Filter: 10.00 ms 2:7:47
0 = ?  [Mode & - S BARE 2 v WD | gy, AL 1500 Hz
2 W-CODE SELCAL - Card1 =R <=
808 us
[Hz]
1358 954 550
3000
2500
2000 p— — - 2186
1500 : ; 1431 | 1510
—_— —_— =
1000
s 676
‘ W
Detect Data o
4234023
4012340123
#012340123
#4589
#234023
£459
#348
#348 -
[dE] Y
0
_20-
—20-] MMWM
0 " '
o 250 500 750 1000 1250 1500 1750 2000 2250 2600 2750 3000 3250 3500 3750 4000 [Hz]
Demodulator: DSP Span: 3000 Hz Center: 1700 Hz Offset: 0 Hz Input: AF (LEFT)

Tracking rate determines the sampling rate. The range is 1 - 15 ms, default is 2 ms.

Double-clicking Filter inserts a low pass filter for filtering the SELCAL system tones. The value of the filter
should be adjusted to avoid serious tone distortion. A rule-of-thumb value is 1.6 times the baud rate.

The filter range is 1 - 100 ms.

Using the Span menu the resolution of the frequency axis may be increased. The steps are 3000 Hz (for
analogue SELCAL systems), 1500, 600 and 300 Hz.

From the Center menu the center frequency may be adjusted. It is important to readjust the center fre-
quency whenever the frequency (Span) axis is increased.

Pressing the Detect button starts the SELCAL analysis mode. The monitored signal buffer is searched for
valid tone data. Testing is sequential, and the name of the system under test is displayed. Recognized
systems are identified below the graphics window. Decoding of an identified system may be immediately
started by double-clicking the system in the output window.

When evaluating analogue tone call systems, be aware that some systems are almost technically identical
or only differ in the allocation of tones (e.g., ZVEI-1 and ZVEI-2), and thus a certain degree of tolerance
must be shown when testing analogue SELCAL systems. Be prepared for double or multiple identifications.

Several color schemes are available through the right-click menu.
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Fundamentals of Radio Data
Transmission

The drawing illustrates the various processing operations applied to digital information from source to
sink. The box labeled “Channel” represents the media through which data must pass (adapted from Ber-
nard Sklar, “Digital Communications - Fundamentals and Applications”, Prentice Hall, 2001).
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A basic understanding of how digital information is transferred by land line or radio links is necessary to
fully exploit all of the features of the WAVECOM decoder. It is assumed that the user is familiar with the
general working of telecommunication systems, in particular radio systems. The overview below deliber-
ately avoids the mathematical descriptions and proofs which underly modern communication theory and
practice, for the sake of brevity.

We define digital information as information which is represented by discrete states of the transmission
medium. In contrast, analogue information is represented by an infinite continuum of states. For exam-
ple, live music is analogue information, whereas the same music recorded on a CD has been transformed
into digital information imprinted on the surface of the disc. Digital information or data is not only text, it
can also represent speech, music or images.

A land line, short wave link, satellite link or any other way of connecting two points for communications is
called a channel.

The tremendous development within electronics and computer science in the last few decades has led to
enormous improvements in the reliability and robustness of the wireless transmission of digital data,
which has especially benefited the HF spectrum users. The HF frequency range is an especially hostile en-
vironment to communications, as it is prone to both natural and manmade disturbances of a time-varying
nature, e.g., heavy industrial noise, fierce solar storms, interference from other spectrum users and se-
vere fading. The ever increasing powers of CPUs has been harnessed via digital signal processing (DSP)
techniques and has resulted in improved coding and modulation methods such as turbo codes, adaptive
equalization, m-ary modulation and powerful and innovative demodulation and decoding methods. Further
improvements have been made in the field of automation of operations and in the size, power consump-
tion and features of modern integrated circuits.
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Basic digital communication transformations (from B. Sklar, “A Structured Overview of Digital Communica-
tions”, IEEE Commun. Mag, August 1983).

Telegraph Speed, Bit Rate, Baud Rate and Symbol Rate

The basic building block of data and telegraph signalling is the bit, a word derived from “binary digit”, so
called because it can assume only two states, “Current” (logical “1”, Mark or lower frequency, positive
voltage) or “No Current” (logical “0”, Space or high frequency, negative voltage).

The bit rate is the number of bits transmitted per second, measured in bps.
One or more bits can be merged into a single signaling unit called a symbol.

The symbol rate formerly known as the telegraph speed or the baud rate is the inverse of the duration
of one single signaling unit and is measured in symbols/sec or Baud (Bd). So if one channel signaling
unit has a duration of 10 ms, then the telegraph speed is equal to 1/0.01 = 100 Bd. If the channel has on-
ly two signaling states, e.g., 0 V and +5 V, bit rate is equal to baud rate, i.e., 100 bps. If four levels were
used, the baud rate would still be 100 Bd, but now the bit rate would be doubled to 200 bps, each baud
representing two bits.

Signaling states identify the different values a signaling unit may assume. In case of binary signaling there
are two states, but many systems utilize more. For radio transmission, the levels may be represented by
frequency, phase, amplitude levels or a combination thereof (see the sections on channel coding and
modulation).

Power

N

Signal at baseband

frequency

Signal at RF (radio frequency)

A baseband channel or low pass channel (or system, or network) is a channel (e.g., a telecommunications
system) that covers a frequency range from close to or even zero Hz, i.e., DC, up to the highest signal
frequency. Examples are serial cables and local area networks (LANs). Baseband signals may be used to
modulate carrier frequencies.
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Formatting and Source Coding

Formatting is the process whereby source data is prepared for the ensuing digital processing. Sometimes
this process is included in the functionality of source coding. The purpose of source coding is to reduce the
amount of redundant or unnecessary information from the raw data.

Bits are assembled into patterns or code words with a certain length which is expressed in number of
bits. The code words represent all or a part of the entire alphabet including letters, numbers, special char-
acters and control codes, or represent the pixels of a fax or samples of digitized speech.

Code words are assembled into alphabets or codes. In some codes the code words are of unequal
length. A distinction should be made between source coding, which is the coding used to communicate
between a data source or sink (a teleprinter, a PC) and data communication equipment, e.g., a modem or
a decoder, and channel coding, which is the coding used on the channel between the transmitting and
receiving data communication equipment. Sometimes the source code is also used as the channel code.

The Morse code is an unequal-length code. Code words are composed of dots - the smallest unit -,
dashes and spaces, one dash being equal to three dots. The character "E" is represented by the shortest
code word “dot” equal to one dot or '1' in binary notation. The character Zero (0) is represented by the
longest code word, "dash-dash-dash-dash-dash" equal to 19 dots or '1110111011101110111" in binary
notation. The reason for the unequal length of the code words was the desire to reduce the amount of
work for the operator when transmitting many messages. Samuel Morse found by visiting a Philadelphia
printing office, that the compositors had sorted the lead types in such a way that the types most frequent-
ly used were the ones most easily accessible.

An example of an equal-length, but non-integral code is the Baudot or ITA-2 alphabet, which was formerly
in use on the majority of the world's land lines and radio links. It is still the base for many codes con-
structed later, as compatibility to existing equipment and networks was essential.

In the ITA-2 code a character is represented by five bits. For instance, the letter "D" is represented by the
codeword '10110'. As we have five bits which can assume one of two possible states we are able to repre-
sent 25 = 32 characters. However, the number of all letters, figures, and special characters add up to
more than 32. Therefore a trick is employed: ITA-2 makes a distinction between two cases, lower (letters)
case and upper (figures) case. Shifting between these cases is accomplished by special shift characters. In
this manner it is possible to transfer (2 x 32) - 6 = 58 characters (the last six are subtracted because they
have same functions in either case). Shift characters are also used to toggle between Latin and non-Latin
alphabets in the same transmission, e.g., Latin-Cyrillic and Latin-Arab alphabets.

The alphabet most widely used in modern data communication is the ASCII code (American Standard
Code for Information Interchange) which is internationalized as ITU ITA-5. The alphabet is originally
based on 7-bit words, but normally 8 bits are used either to expand the alphabet or to include a parity bit.
Because of the number of bits available for each codeword, it is unnecessary to use special case shift
characters as for ITA-2. Also both capital and miniscule letters can be accommodated as well as non-
printing commands, and if 8-bit words are used completely transparent binary data.
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7-bit ASCII code. Normally eight bits are transmitted with the 8th bit either set to 1 or 0, used for odd or
even parity or to expand the alphabet.
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An example of source coding for analogue input is the process of transforming analogue voice to digital
bits by way of sampling the input signal, quantizing it into discrete amplitude levels, and finally converting
the quantized signal into 8-bit data words. This process is used for the conversion of ordinary analogue
telephone speech into standard PCM (Pulse Coded Modulation) digital signals used globally in the Public
Switched Telephone Network. Other examples for voice coding are the coding used for GSM mobile tele-
phones, or LPC (Linear Predictive Coding) used for narrow band digital voice.

To reduce redundancy, i.e., to use the transmission medium more efficiently, the formatted data is further
processed through compression. As we saw above some codes, e.g., the Morse code inherently has the
ability by statistical observation of the source data to reduce redundancy. Statistical reduction is also the
basis for Huffman coding used in fax communication where the most frequently occurring bit combinations
are transformed into symbols having the lowest number of bits. Huffman coding is thus an example of
variable-length coding.

The degree of compression achievable, the compression ratio, is related to the properties of the data to
be compressed.

Other examples of compression codes are ARJ, Lempel-Ziv, JPEG and MPEG, the later ones used for video,
voice and music compression.

PACTOR and G-TOR are examples of the use of redundancy removal source coding for radio communica-
tion.
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Baseband waveforms can be formatted in various ways. The most common method is called Non-Return-
To-Zero (NRZ-L) meaning that the bits will have one of two voltage levels. NRZ-M also called differen-
tial encoding, uses a change in level for a logical one and no change for a logical 0. NRZ-S is comple-
mentary to NRZ-M. Unipolar-RZ represents a logical 1 with a positive half-bit wide pulse and a logical 0
with no pulse, i.e., at 0 level. Bipolar-RZ has opposite half-bit wide pulses for 1 and 0. The Manchester
code or Biphase-@-L is a subtype of NRZ coding and has a level transition at mid pulse, negative going
for 1s and positive going for O0s. Differential Manchester omits the level transition for 1s and Os respec-
tively.

The exact waveform to be used depends on the application. For instance systems needing self-clocking
would use Manchester coding because of transitions are always available even if the transmission consists
of long rows of succeeding 1s or 0s. The BBC radio data system used on long wave utilizes Manchester
coding as does Ethernet LANs. The AIS system used on VHF uses differential encoding to resolve polarity
ambiguity and this encoding form is also commonly used in satellite transmission systems.

The illustration below depicts spectral density, i.e., efficiency, as a function of pulse bandwidth.
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Encryption

To protect data transmissions against interception, various methods are in use.

The encryption process basically processes clear text with a key, with the transformed message then
transmitted over the insecure media. At the receiving end, deciphering is achieved using the same key
and the clear text message is recovered.

Encryption may be on-line or off-line. On-line or stream encryption takes place at transmission time,
whereas off-line or block encryption often is done before transmission, usually in the form of coding the
clear text message into five letter or five figures groups. This is done by a key sequence.

Bit inversion inverts logical zeroes of a codeword with logical ones and vice versa either in a static pat-
tern, e.g., bit 3 and bit 5 or in a dynamic pattern depending on the value of the codeword. The result of
bit inversion is character substitution - the original clear text character is substituted with another char-
acter.

Character transposition or permutation replaces characters in one position in the clear text with char-
acters in another position. One of the most famous implementation of permutation transformations is the
German Enigma cryptographic machine in use before and during the World War II.

Substitution and permutation of clear text messages is relatively easily broken using statistical methods
and a knowledge of the frequency of characters in various languages.

Shift-register encryption, a stream encryption method, uses one or more shift-registers into which the
clear language message is shifted and EXORed with a key or part of itself. Taps in various positions of the
registers may feed bits back to the input to complicate decryption by interceptors. The shift-registers of
the transmitting and receiving equipment must be initialized to the same value - the seed.

System security in conventional cryptographic systems depends on the safeguard of the key and on the
length of the key. Generally speaking, the longer the key, the more difficult the work of the cryptanalyst
will be. Unbreakable systems like the one-time pad will only use its key once and its key length is as long
as the clear text message. Cryptographic messages are constructed by byte wise EXORing of the clear text
message and the key. Kerckhoffs principle is the design criteria for modern cryptographic systems: “The
security of a cryptographic system must not depend on keeping the algorithm secret. The security is only
dependent on keeping the key secret.”

Modern cryptographic systems use the principles of public keys. Traditional systems use the same key
for encryption and decryption, and safeguard this key. Public key systems use two different keys, one for
encryption and the other for decryption. Public keys and their encryption algorithms are publicly available,
but the decryption keys are secret and private; the transmitting party encrypts his message with the pub-
lic key, and the recipient decrypts the message using his private key.
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Channel Coding

Due to the unstable nature of the radio media, especially in case of HF links a number of techniques have
been designed to protect data and ensure a high degree of error free transmission. This is especially im-
portant for the transmission of encrypted information.

Channel coding is about improving performance by providing techniques which can be used to combat fad-
ing, jitter, noise and other perturbations which are properties of time-varying channels as radio channels.

To protect the data extra (redundant) information must be added to the (source encoded) data to be pro-
tected. Bits are either added to existing source code, or the source alphabet is converted into a completely
new alphabet before channel transmission. In addition certain procedures, protocols, are used for the ex-
change of information.

Depending on the nature of the radio link - simplex, half-duplex or duplex - channel coding and protocols
have been devised to detect and/or correct transmission errors.

Traffic between users may be handled in a nhumber of ways depending on requirements and equipment
available.

Terminal »| Terminal
A B
Terminal |~ | Terminal
A f— B
Terminal >  Terminal
A P B

Top - Simplex (one-way), transmission in only one direction
Middle - Half-duplex, transmission in either direction, not simultaneously
Down - Full-duplex, simultaneous transmission in both directions

ARQ is a technique by which the Information Sending Station (ISS) transmits information in such a
way that the Information Receiving Station (IRS) is able to detect transmission errors and then ask
for repetition of the character or block of characters in error. This technique is used in half-duplex and du-
plex channels.

Several methods are used for error detection and possible error correction. One method is the use of pari-
ty-check codes. One such code in international use for ARQ is the balanced ITA-3 code, consisting of
seven bits with a constant mark-space ratio of 3:4. A ratio different from 3:4 in a received codeword will
be an error and a RQ (Request for Repetition) is issued. This code has no correcting capability.

ASCII is also a parity checking code. The Russian CIS-36 mode combines m-ary modulation with parity
checking. In this case, the data to be sent is formed into blocks and parity is calculated for both rows and
columns - horizontal and vertical parity check.

Another ARQ code is the ARQ-1A parity code. The code words of this code also consist of seven bits; 6
data bits and 1 parity bit. The parity bit is set to 1 or 0 depending on the number of logical '1's in the six
data bits of the codeword.

The Bulgarian ASCII system uses yet another form of parity check called block coding. A checksum is
calculated for a data block and appended to the transmitted block. The IRS calculates the checksum once
again and compares the result with the checksum received. If the checksums are not equal a RQ is issued.
The checksum calculation is often done using a method called a Cyclic Redundancy Check (CRC).
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In simplex systems there is of course no return channel, so the IRS cannot request repetitions. Therefore
the codes used must be very robust and be able to correct errors at the receiving end - Forward Error
Correction (FEC) is used.

Intensive research has led to the development of a large humber of block codes with superior error detec-
tion and correction features, e.g., Hamming, BCH, Golay and Reed-Solomon codes.

One of the worst enemies of simplex links is burst noise, which may corrupt many successive bits. To
combat this type of noise, bit spreading or bit interleaving is used. The bits of successive code words
are spread in time. In this way burst errors will only influence a few bits of each codeword, and the error
correcting code may have a decent chance to correct the errors. The HNG-FEC and RUM-FEC channel
codes use this method.

Another method is codeword repetition, in which a code word is repeated several characters later in the
transmission. To improve error detection and correction, the repeated character may be bit-inverted. The
original character and the repeated character are then compared at the IRS. SI-FEC and SITOR-B are ex-
amples of this type of code.

One code type has been successful in particular; that is the convolutional code, in which the value of
the parity bits depends of the values of a number of preceding data bits. The data bits are shifted through
a shift-register with taps. The output of the taps is EXORed to form the value of the parity bits. After con-
volution the bits are interleaved to further improve noise immunity. FEC-A uses this method. Convolution-
al coding and the related Viterbi decoding have found widespread use in satellite communication.

Modern communication systems often utilize a combination of coding schemes to obtain higher invulnera-
bility against errors at a lower complexity level. Thus in satellite communication, codes are concatenat-
ed; that is to say, a convolutional inner code towards the modulator is concatenated with a Reed-
Solomon outer code, with an interleaver inserted in between. Recent research has refined the concate-
nated coding and added an iterative decoding algorithm to achieve what is called turbo coding. Further
research has led to the discovery of so called Low Density Parity Codes (LDPC), the use of which has ena-
bled communicators to come very close to the theoretical bandwidth limit of a communication channel.

Modern technology has enabled more sophisticated approaches to combat the challenges of radio commu-
nication. Inter-symbol interference is one such challenge. Due to the time-varying nature of fading chan-
nels one symbol may be delayed in such a way that it interferes with the next symbol at the receiving end.
By shaping the digital pulses in certain patterns, the level of ISI may be reduced. The raised cosine pulse
shape is the shape most frequently used in conjunction with equalization.

Equalization

To combat the perturbations introduced during the transmission via time-varying communication chan-
nels, modern digital communication systems employ a technique called equalization. Preset equaliza-
tion transmits a training sequence which is compared to a similar sequence at the receiving end. The
difference between the received and local sequences is used to adjust a special filter. Adaptive equaliza-
tion continually measures the characteristics of the channel from the data received and dynamically ad-
justs the filter. To take advantage of the powerful features of equalization, good channel error perfor-
mance is necessary.

The equalizer sits between the demodulator and the detector.

Synchronization

To enable the receiving end of a data or telegraph link to interpret the received code words in a meaning-
ful way, the receiver must first be synchronized to the incoming bit stream by finding the bit level transi-
tions, and next achieve code word phase. Basically the receiver will search for a certain bit pattern in the
bit stream and when found transmitter and receiver are synchronized.

Before the widespread use of electronic circuits, all telegraph devices were of electro-mechanical nature
and therefore prone to mechanical wear and tear. This in turn necessitated comparatively large tolerances
and made stable synchronization over even short periods difficult. To overcome this serious problem, the
ITA-2 alphabet adopted what is known as start-stop or asynchronous operation, which achieves syn-
chronism for each codeword.

In start-stop systems a codeword is wrapped into an "envelope" consisting of a leading start bit (logical
'0") and one or more trailing stop bits (logical '1') - for ITA-2 the code words are 1 + 5 + 1.5 = 7.5 bits
long. Bit synchronization is then achieved by detection of the start element. The stop element(s) serve(s)
the purpose of telling the receiver to reset its detection mechanisms and wait for the next start bit. To en-
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sure proper operation of the mechanical devices the stop bit was extended to have 1.5 times the length of
a data bit, which accounts for the term "non-integral" earlier in this section.

In synchronous systems there is continuous synchronization between the sending and receiving devices
either by special non-printing control characters being inserted into the messages at regular intervals, or
the code words themselves being constructed to facilitate synchronism. To maintain synchronism, special
idle or sync characters are transmitted when no traffic is transmitted. In contrast to start-stop systems,
only elements having a duration of an integer multiple of the duration of the minimum signal element are
used - isochronous sequence.

For burst mode or packet transmissions a leading preamble of either a sequence of alternating zeros and
ones and a repeated fixed pattern - in satellite transmission called a Unique Word - is often used for
synchronization purposes. A very common way of combined synchronization and packet delimiting is to
pre-cede and terminate the data packet with so called flags, i.e., unique bit patterns, not being a part of
the data proper. Flags are characteristics of HDLC (High-level Data Link Control), which is used in amateur
radio packet communication and in AIS.

Multiplexing and Multiple Access

Another method is to transmit more than one channel on a radio link. This may be achieved either in the
frequency or time domain, or a combination of the two. When the aggregation of channels is done before
the modulation process, it is known as multiplexing. When several independent stations access a medium,
is the term “multiple access” is applied. A well known example of multiple access is Ethernet LANs where
all nodes have access to the same medium.

With frequency division multiplexing (FDM) or frequency division multiple access (FDMA) a carri-
er frequency is modulated with a number of sub-carriers. Each sub-carrier carries a data signal. The sub-
carriers may be amplitude, frequency or phase modulated. The more common is narrow shift frequency
modulation. Each channel is independent of the otherones, and may transmit with a different speed or use
a different alphabet or system. One such system used in HF communications is the CODAN 16 carrier
QPSK system.

With time division multiplexing (TDM) or time division multiple access (TDMA) each data source is
allowed access to the aggregate channel (line or radio link) in well-defined time slots. To keep pace with
the incoming bit stream, the aggregate channel speed must be the sum of the speed of the individual
channels. All channels must have identical speeds. However, a channel subdivision scheme has been
standardized so that up to four sub-channels may share one channel. An example is the ARQ-M2 and M4
modes.

In satellite systems a combination of FDMA and TDMA is often used to optimize channel usage. DAMA
(Demand Assigned Multiple Access) satellite systems are an example of this type of multiple access.

Polarization division multiplexing is used in satellite communications, whereby differently polarized signals
use the same frequency leading to frequency reuse. Inmarsat earth station - satellite links in C-band use
this type of multiplexing.

The overwhelming majority of radio data systems will transmit the individual bits of a codeword one after
the other in serial transmission. However real-time or high volume data systems, like digitized secure
voice, computer network access and image or file transfer often uses parallel transmission. The serial
code words are fed to a serial-to-parallel converter and then to the sub-carrier modulators of a FDM.

Modulation

Modulation is the process whereby the digital baseband signal or waveform is superimposed onto a carrier.
The carrier may be manipulated in amplitude, frequency and phase.

The most frequently used modulation techniques are 2FSK using two frequencies, MFSK with four or more
tones, and differential phase modulation methods such as 2DPSK, 4DPSK, 8DPSK or 16DPSK. On satellite
links phase modulation methods such as BPSK or QPSK are used. Other modulation types include AM, FM
or phase sub-carrier modulation of an FM, AM or phase shift main carrier.

Modulation methods which directly manipulate the carrier may be decoded using the receiver IF output, or
for smaller shifts in the case of FSK, also the AF output. In addition many VHF/UHF receivers also have a
direct discriminator output which may be used.

In contrast, modulation methods using sub-carrier modulation must be decoded using the receiver AF out-
put. Decoding indirect modes can only take place using the receiver AF output. The receiver serves as a
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demodulator for the FM or AM carrier, while the decoder demodulator processes the sub-carrier modula-
tion.

ASK (Amplitude Shift Keying)

The simplest way to impress the digital information on a carrier is to key the carrier on and off represent-
ing the two levels of binary information. This was the earliest keying method and is still used for Morse
links. As most noise encountered at radio frequencies is amplitude noise, this modulation method is very
susceptible to noise.

FSK (Frequency Shift Keying)

As electronic equipment became more refined (with improved frequency stability) and the demands for er-
ror free communication increased, frequency shift keying (FSK) was introduced. In this mode the trans-
mitter is continuously on, but transmits alternately on two different frequencies, one representing Mark
level and the other one Space level. As amplitude noise is additive, it can be eliminated by clipping all
spikes above the carrier level. The difference between the two frequencies (the frequency deviation) is
called the shift, and may be for example 170, 425 or 850 Hz.

For many years FSK was the mainstay of digital radio communication.

PSK (Phase Shift Keying)

PSK manipulates the carrier phase information in conformance with the digital information to be transmit-
ted, by advancing or delaying the phase of the carrier.

As equipment sophistication increased, phase keying became more common and is now in use on modern
high-speed HF radio links, e.g., in MIL or STANAG based systems. In satellite communication PSK is the
main modulation method; for instance Inmarsat C uses BPSK (2PSK), and other Inmarsat systems use
QPSK (4PSK).

M-ary-FSK (MFSK), M-ary-PSK (MPSK)

Modes on the HF bands utilize frequency or phase modulation of a sub-carrier, which then in turn modu-
lates a carrier using suppressed carrier SSB keying, or by directly modulating a carrier. Decoding can be
done from the receiver AF or IF output (USB, LSB, CW or FAX demodulator). Examples of this type of
modulation are ordinary two-frequency FSK, four-frequency FSK (Twinplex) and the STANAG PSK modes.
M-ary designhates the number of modulation levels. FSK designates common two-frequency FSK.

MFSK systems deviate from the classical binary transmission of '0' (Mark) and '1' (Space), as a single tone
carries more information. This is the reason for a higher element period in MFSK, compared with binary
transmissions having the same bit rate. This produces a substantial increase in the insensitivity to multi-
path propagation and noise. Examples of MFSK systems are PICCOLO, COQUELET and CIS-36.

Due to intensive research and the availability of highly efficient hardware and software, the waveforms
originally developed within the STANAG specifications of NATO have gained considerable influence in radio
data communications. This has resulted in very efficient modems utilizing multi-phase modulated single-
tones, combined with the use of adaptive equalization and sophisticated coding and demodulation and de-
coding.

Satellite TV broadcasting utilizes QPSK or even 8PSK.

A special instance of m-ary modulation is QAM (Quadrature Amplitude Modulation) in which phase and
amplitude modulation are combined. An example of QAM is digital broadcasting in the MF and HF bands
(DRM).

OFDM (Orthogonal Frequency Division Modulation)

OFDM is a combination of multiplexing and modulation. The signal to be transmitted is first split into a
number of separate channels modulated by the data and then re-multiplexed to create an OFDM carrier.
HF modem research is ongoing, to investigate whether this type of modulation is well-suited to combat se-
lective fading, which is a major problem in HF data communication. OFDM is used for Wireless LANs and
ADSL. When OFDM is combined with coding it is known as Coded OFDM (COFDM), which is used in DAB-
broadcasting to combat multi-path.
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Bandwidth-efficient Modulation

Among newer modulations methods employed to make better use of the spectrum available are Offset
QPSK (OQPSK), Minimum Shift Keying (MSK) and Gaussian FSK (GFSK). MSK is used in DGPS and in GSM
systems. OQPSK is used in satellite communications and GFSK is used in various data modes.

INDIRECT FM

A frequency modulated carrier is modulated with an AF FSK sub-carrier. For decoding, the receiver FM
demodulator output is required. Examples of INDIRECT modulation are PACKET-1200, ATIS, and analogue
and digital tone call systems. Decoding is only possible from the receiver AF output.

INDIRECT AM

This modulation method uses AM carrier modulation, which is in turn modulated by an AF FSK sub-carrier.
For decoding the receiver AM demodulator output is required. At the time of writing, ACARS is the only
known mode using this modulation method. Decoding is only possible from the receiver AF output.

FAX

Weather charts to be transmitted are fastened to a revolving drum and illuminated by a light source. The
drum is then scanned by a light sensor moving along the axis of the drum. The voltage output from this
sensor is converted into tone frequencies modulating the transmitter.

The number of revolutions per minute (RPM) is a measure of the speed of the drum on the transmitting
side. The index of cooperation (IOC) is a measure of the speed with which the sensor moves along the ax-
is of the drum.

A fax transmission begins with a tone of 300 or 675 Hz. The start tone has duration of 5-10 seconds and is
very well suited for precise tuning. The frequency of the tone determines the IOC value. Then 30 seconds
of alternations between the frequencies representing black and white levels are transmitted, the switching
frequency being 1-4 Hz. This sequence carries the RPM information, and the receiver is now synchronized
so that the picture will start in the right position. Subsequently the transmission of the picture proper be-
gins.

At the end of transmission the stop signal is sent; this consists of a switch-off signal of 450 Hz having du-
ration of 5 seconds followed by 10 seconds of the frequency representing black level.

FAX Transmission Sequence

5% white
95% hilack

1 white:

[yt

! pause ‘ 10C-TONE I Synchronization T Dats ) T Break sigrat | I pause
5-10 seconds 10-30 seconds 10 - 40 minutes 5.20 seC
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Transmission Modes

ACARS

Aircraft Communications Addressing and Reporting System (ACARS) is a carrier sensing, multiple access
packet radio system for aircraft communications. ACARS operates in the VHF band, mainly around 130
MHz, using 2400 bps NRZI coded coherent audio frequency MSK (Minimum Shift Keying - a particular form
of FSK) on AM to make use of standard aircraft AM communications equipment.

Parameter ‘ Value ‘

Frequency range VHF

Operation modes CSMA/CD packet ARQ system

Modulation AM, SUB FSK

Symbol rate 2400 Bd

Center frequency 1800 Hz

Shift 1200 Hz

Receiver settings AM, BW = 3 kHz

Input format(s) AF, IF

Additional Info ITA-5 with parity and block coding
Frequencies Europe: 131.725, 131.525, 131.825 MHz
Frequencies USA: 131.550, 130.025, 129.125, 131.475, 130.450,
131.125, 136.700, 136.750, 136.800 MHz
Frequency Japan: 131.450 MHz

To receive ACARS an omni-directional 108-136 MHz antenna, a VHF AM receiver (scanner) with 13 kHz
channel bandwidth and a corresponding AF output is necessary. As the ACARS packets are very short, turn
the squelch of the receiver OFF.

Speed selection is not available for ACARS as only one speed is in use (2400 Baud).
Processing of ACARS Messages

It is possible to do some interpretation of ACARS messages. The following options are available:
Reassemble multipart messages

This setting enables the reassembling of bigger messages which are sent in several parts. Instead of
showing each part separately, the message is shown as one single message when the last part has been
received. The message header is still shown separately for each part.

Parse ADS-C messages

This setting enables the parsing of ADS-C messages (Automatic Dependent Surveillance - Contract). When
an ADS-C message is received, it is decoded and the additional information is shown in the output win-
dow.
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ACARS Frame

Parameter Value

Pre-key

16 characters All binary “ones”

Bit Sync

2 characters “+"” , “*”

Character Sync

2 characters SYN, SYN (0x16)

Start of Heading

1 character SOH (0x01)

Mode

1 character

Address

7 characters

Technical Acknowledgement

1 character

Label

2 characters

Block Identifier

1 character

Start of Text

1 character

STX (0x02) - if no text ETX (0x03)

Text

220 characters maximum, printable characters only

Suffix

1 character, if single or terminal block ETX, else ETB (0x17)

Block Check Sequence 16 bits

BCS Suffix 1 character DEL (0x7f)

Messages may be single or multi-block. The pre-key sequence and the BCS have no parity bits.
ACARS communications are divided in Category A and Category B.

Using Category A, an aircraft may broadcast its messages to all ground stations. This is denoted by an
ASCII "2" in the Mode field of the downlink message. The WAVECOM software translates this character to
||All.

Using Category B an aircraft transmits its message to a single ground station. This is denoted by an ASCII
character in the range "@" to "]" in the Mode field of the downlink message.

mun

The ground station may use either "2" or the range
Category A, but may uplink ™" to "}" in the Mode field.

to "}" in the Mode field. All ground stations support

The WAVECOM software translates the ground station address (also called the Logical Channel Number)
into a number in the range 0...29.

A station will transmit after having monitored the HF channel for traffic, otherwise it waits until the chan-
nel is clear. If a collision occurs between the packets of two stations transmitting at the same time, they
will back-off and new transmission intervals will be set by random interval timers in the radio equipment.

At the receiving end, a block check calculation is made and compared to the calculation appended to the
packet by the transmitting station. If the downlink messages contain errors, no response will be given and
the transmitting station will retransmit the packet a number of times, until a positive acknowledgement is
received and the message can be deleted from storage, or the aircrew be alerted to its non-transmission.

If an uplink message is found in error, the airborne equipment will generate a negative acknowledgement
(NAK), which triggers an uplink retransmission. Retransmission is also triggered by timeout.

Positive acknowledgement from the aircraft consists of the transmission of the Uplink Block Identifier of
the correctly received block. Positive acknowledgement from the ground station consists of a similar
transmission of the Downlink Block Identifier.

Acknowledgements are placed in the Technical Acknowledgement field.

The general response message label is "_DEL" (0x5f 0x7f). Messages with this label contain no information
except acknowledgements and are used for link maintenance.

The traffic exchanged can be requests for voice communication, weather reports, access to airline com-
puter systems, reading of aircraft automatic sensors, flight plans, messages to be routed to destinations in

WAVECOM Decoder W74PC, W-PCl/e, W-CODE, W-CLOUD Manual V14.0.0 Transmission Modes e 123



the international airline data network - in fact much traffic previously carried by voice, has been trans-
ferred to ACARS.

The text field of the ACARS packet is used for messages with a fixed format, free text, or a mixture of
formatted and free text. Standard 7-bit ASCII is used; bit 8 is an odd parity bit and LSB (bit 1) is trans-
mitted first.

ACARS Downlink Message Example
(#8) 06-11-1996 18:43:32 M=06 ADDR= HB-INR TA=Q ML=Q0 B=6 MSN=0635 FID=SR6767

(Bold typeface indicates decoder generated characters)

Decoded ‘ Interpretation ‘
(#8) Decoder generated message number

06-11-1996 18:43:32 Decoder generated timestamp (optional)

M= Mode Category A = A,

Category B = 0..29

ADDR= Aircraft address

(aircraft registration or flight identifier)

TA= Technical acknowledgement

(downlink 0...9, uplink A...Z, a...z, NUL (0x00))

ML= Message Label (message type)

B= Uplink/Downlink Block Identifier

(downlink 0...9, uplink A...Z, a...z, NUL (0x00))

MSN= Message Sequence Number

FID= Flight Identifier

In this case record #8 decoded at 18:43:32 contains a message from a Swiss aircraft with registration
HB-INR using logical channel 06 to transmit and acknowledgement of uplink block Q and a link test (QO)
with block identifier 6 and message sequence number 0635 (here the time in minutes and seconds after
the hour is used - other formats are also in use). The flight is Swissair SR6767.

A few examples of the more important or frequently seen ACARS messages:
M=06 ADDR= HB-IND TA=NAK ML=_[1 B=3 MSN=2810 FID=0S005

Using logical channel 06 an unsolicited (TA=NAK) general response _[ without information is transmitted
as block 3 from aircraft HB-IND on flight 0S005 with sequence number 2810. General responses are
mainly used for block acknowledgement purposes.

M=06 ADDR= O0OOO0OO0OO0OO0 TA=NAK ML=SQ B= 00XSZRH

This is a "squitter" - an ID and uplink test message transmitted at regular intervals from ground stations.
This one is a squitter (SQ) version 0 (00) from a SITA (XS) ground station in Zurich, Switzerland (ZRH).
The O denotes the ASCII NUL character (0x00) used for broadcast. A block identifier is not used.

M=06 ADDR= OY-MDS TA=5 ML=:; B=131125

This is a data transceiver auto tune message (:;) from ground station 06 commanding the ACARS trans-
ceiver of aircraft OY-MDS to change its frequency to 131.125 MHz. At the same time acknowledgement is
given for the aircraft's downlink block 5.

AlS

AIS also known as (Universal) Automatic Identification System (UAIS) is a worldwide radio system for ship
collision avoidance and navigational advice. AIS-equipped ships continuously transmit short messages
containing information like position, course over ground, speed over ground, and so on. All information
may be sent from ship to ship, as well as well as from ship to shore. This is very useful for Vessel Traffic
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Systems (VTS) in congested areas such as harbors, rivers and archipelagos. Tranmissions may be in
broadcast mode or individually addressed. The messages may contain a fixed content in binary format,
free text or binary information defined by international, regional or national authorities (see table below).

Parameter Value

Frequency range VHF
Operation modes SOTDMA FEC
Modulation GMSK
Symbol rate 9600 Bd
Receiver settings BW = 15 kHz
Signal source(s) IF

Transmission is 9600 Baud GMSK modulation over 25 or 12.5 kHz channels using the HDLC packet proto-
col. Each station transmits and receives over two radio channels to avoid interference problems. Self-
Organizing Time Division Multiple Access (SOTDMA) is used. One Time Division Multiple Access (TDMA)
frame corresponds to one minute and contains 2250 slots.

Each frame contains an 8-bit ramp up and a 24-bit synchronization sequence. At the beginning and end of
each frame, a HDLC flag (01111110) is sent. After the 8-bit preamble, 168 bits of data and a 16-bit CRC
checksum are sent in a default packet (one slot). Long transmission packets may occupy two to five con-
tinuous slots. Bit stuffing and NRZI encoding is used.

Traffic can be monitored on the AIS1 Channel 87B 161.975 MHz and AIS2 Channel 88B 162.025 MHz
From Options | Display Mode, All frames or Error free frames may be selected.

AIS Binary Messages

Area ‘ Designation ‘ Function H Message ‘
Global International 0,2,3,4,5,11, 12, 13, 14, 15, 16, 17
St.Lawrence Seaway SLS 1 (Metro/Hydro) 1,2,3,6

2 (Vessel/Lock) 1,2

32 (Special) 11
USA/Canada PAWSS 1 (Metro/Hydro) 4,5

2 (Vessel/Lock) 3
Rhine/Danube Inland 10, 21, 22, 23, 24, 40, 55

ALE-400

Amateur version of MIL-188-141A.
For more details see "MIL-188-141A" on page 205.
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Parameter Value

Frequency range

HF

Operation modes

ALE, Broadcast/Simplex FEC

Modulation MFSK-8
Symbol rate 50 Bd
Center frequency 1625 Hz

Receiver settings

DATA, CW, LSB or USB

Input format(s)

AF, IF

ALF-RDS

ALF-RDS (Accurate positioning by Low Frequencies) is a German system for the transmission of DGPS in-
formation on low frequencies (in this case 123, 7 kHz). Data is transmitted in RDS format. RDS (Radio Da-
ta System) is a one-way data transmission system used by FM broadcasters worldwide to broadcast pro-
gram, time and traffic information on a 57 kHz BPSK DSB sub carrier with suppressed carrier and a bit
rate of 1187.5 bps. In the case of ALF-RDS, the transmission is made in SSB with a decreased level pilot
carrier to reduce bandwidth.

Parameter Value ‘
Frequency range HF

Operation modes Broadcast FEC

Modulation BPSK

Symbol rate 1187.5 Bd

Receiver settings DATA, CW, LSB or USB

Input format(s) AF, IF

The basic RDS data unit is a group which consists of four blocks, each having 16 data bits and 10 error
detection and correction bits. Groups are divided into type A and B, each containing 16 different groups.

In the upper window, a Display Mode can be selected. The default display mode is All Blocks, which dis-
plays the information of each block. Binary will display the contents of a group in binary format.

In the lower window, other information like flags, time, program information and transmitted text is dis-
played.

ALIS

ALIS (Automatic Link Set-up) is a simplex ARQ system and operates at a Symbol rate of 228.66 Baud on
the radio link.

ALIS is described in report 551-2 of the ITU "Reports of the CCIR 1990 - Fixed Services at Frequencies be-
low about 30 MHz".
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Parameter Value

Frequency range HF

Operation modes FSK, Simplex ARQ

Modulation FSK

Symbol rate 228.66 Bd, variable 30-650 Bd
Receiver settings DATA, CW, LSB or USB

Input format(s) AF, IF

Additional Info ITA-2 with block coding

The transmission block of the standard ARQ system consists of 2 identification bits, 30 data bits and 16
CRC bits. Data transmission is transparent for ALIS. Known systems are however structured around six
ITA-2 characters.

The two identification bits indicate one of four possible system states. The CRC checksum enables detec-
tion and correction of transmission errors.

The acknowledgement block is 16 bits in length. The total transmit-receive cycle for ALIS is 111 bits,
which corresponds to a duration of 485.4 ms. An error free transmission is equivalent to a terminal baud
rate of 100 Baud.

The ALIS system automatically determines the optimal operating frequency after having received a CALL
command. The station then sends a synchronization word, address, block counter and a status word. The
receiving station correlates this bit sequence and synchronizes itself. If the data transmission link fails,
ALIS will search for a new frequency to re-establish the link.

ALIS-2

ALIS-2 (Automatic Link Set-up) is a simplex system operating with a baud rate of 240.82 baud. ALIS-2 is
described in the "Report of the CCIR 1990, Fixed Service at Frequencies below about 30 MHz" of the ITU.

Parameter ‘ Value ‘
Frequency range HF

Operation modes Simplex ARQ

Modulation MFSK-8

Symbol rate 240.82 Bdd

Receiver settings DATA, CW, LSB or USB

Input format(s) AF, IF

Additional Info ITA-5

ALIS-2 is 8-FSK modulated. The tone spacing is 240 Hz, and the tone duration is 4.15254 ms. The trans-
mission block consists of 55 tri-bits, resulting in 165 bits per frame. In addition to the preamble of 21 bits,
each block contains 126 data bits. The preamble includes an identification code, allowing different systems
to be identified.

Two identification bits signal four operational states: traffic, idle, RQ and binary data transfer. The 16-bit
CRC-checksum serves the detection of transmission errors and error correction purposes.

The overall transmission and receive cycle of ALIS-2 is 354 bits, which is equivalent to 490 ms. In case of
an error-free data transmission, the terminal bit rate is 720 bit/s.

ALIS-2 almost always uses the ITA-5 ASCII alphabet.

The ALIS-2 system automatically determines the optimum operating frequency after having received a
CALL command. The station then sends a synchronization word, address, block counter and a status word.
The receiving station correlates this bit sequence and synchronizes itself. If the transmission link is inter-
rupted, ALIS-2 will search for a new frequency to re-establish the link.
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If an ALIS-2 system is identified the status line will display System: “"XXXXXXXXh", where XXXXXXXXh
denotes an eight digit hex id string.

AMSAT-P3D

AMSAT (Radio Amateur Satellite Corporation) OSCAR-40 (AMSAT Phase 3D) is the latest satellite in the
Phase 3 series of high altitude radio amateur satellites.

The satellite telemetry system may be monitored.

Parameter Value

Frequency range VHF/UHF

Operation modes FEC telemetry

Modulation BPSK

Symbol rate 800 Bd (with Manchester coding)
Receiver settings FM, BW = 5 kHz

Input format(s) AF, IF

Additional Info ITA-5

A complete telemetry frame consists of a 4 byte preamble, a 512 byte data set and a 2 byte CRC check-
sum. The 400 bps information is differentially encoded then EXORed with a 400 bps clock signal to create
a Manchester coded PSK signal.

The P3 flight computer of AMSAT OSCAR-40 uses a radiation hardened Cosmac CDP-1802 microprocessor
running at 100K instructions/sec. The operating system is called IPS, an acronym that translates as "In-
terpreter for Process Structures".

A small part of the computer’s 64 kBit memory is used by IPS as workspace. 256 bytes of data collected
via a 128 channel ADC, and 128 bytes of digital data is stored in this area called the IPS "SysPage".

The "SysPage" covers a lot of measurement functions: Status, navigation, power and temperature.

The decoder is able to demodulate, decode, verify (CRC) and display the data content in binary or as text.
The so called "A" or "E" packets are processed further and the information is displayed in four sections:
Main status, temperatures, power and sensors.

From Options | Display Mode, All frames or Error free frames may be selected.

Selecting Options | Display offers the option of an ASCII or RAW bits display.

APCO-25

Project 25 (P25) or APCO-25 is a set of standards for digital radio communications for public safety, secu-
rity, public service and commercial applications. It is standardized by Telecommunications Industry Asso-
ciation (TIA) and supports both voice and data tran